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1 Introduction 
The Radiometer Calibration and Characterization (RCC) software is a data acquisition and data 
archival system for performing Broadband Outdoor Radiometer Calibrations (BORCAL). RCC 
provides a unique method of calibrating broadband atmospheric longwave (LW) and solar 
shortwave (SW) radiometers using techniques that reduce measurement uncertainty and better 
characterize a radiometer’s response profile. RCC automatically monitors and controls many of 
the components that contribute to uncertainty in an instrument’s responsivity.  

The word characterization in RCC refers in part to the generation of multiple responsivities for 
an instrument based on solar position, atmospheric conditions, and/or environmental conditions. 
The characterization is not exhaustive, and other factors can affect an instrument’s responsivity. 
Additionally, RCC maintains a database that holds historical information about each instrument 
and its calibration profile. A long-term calibration history can be used to analyze an instrument’s 
response characteristics by comparing current results to previous results. 

1.1 Database 
RCC is built around a Microsoft Access database that serves not only as an archive of historical 
instrument calibration information but also forms the basis of the BORCAL event configuration. 

RCC treats the BORCAL process in a hierarchical fashion, and the storage of the information for 
a BORCAL follows in much the same manner: 

• For a given calibration center, there may be multiple BORCALs. 

• For a given BORCAL, there may be multiple data acquisition sessions. 

• For a given session, there may be multiple scan groups with a variety of configurations. 

• For a given scan group, there may be multiple instruments. 

• For a given instrument, there will be multiple data points and associated reference, 
measurement equation, and/or environmental data. 

In addition, a BORCAL can be either LW or SW. Both types possess the same hierarchy 
mentioned above. 

The RCC database maintains information about all levels of this hierarchy, and it can yield 
information relating to any level. For example, for any data acquisition session, information 
would be available for scan groups, their configuration, the instruments within the group, and 
even for the data collected. Other information at the same level may be extracted (for example, 
from other sessions) or from different levels in the hierarchy. 

Although instruments appear at the bottom of this hierarchy, the database was designed around 
the need for information about instruments. To meet this need, the database contains information 
about all instruments ever calibrated by RCC, starting with the most fundamental information: 

• Manufacturer and model 

• Customer 
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• General comments about the instrument. 

In addition, information specific to an instrument’s calibration history is available: 

• Raw data from the instrument 

• All previous responsivities 

• Associated statistics for the responsivities (number of data points, uncertainty, etc.) 

• The RCC configuration for every data point used to determine any responsivity 
including: 

o Reference instruments 

o Sample interval 

o Physical location of each instrument and its signal-cabling details 

o Other instruments in the same scan group 

o Operator(s) on duty during the calibration event. 

The database also allows inspection of data from the perspective of a BORCAL: 

• Site location 

• Average temperature, humidity, and other atmospheric conditions. 

The database is designed as a documentation tool for instrument calibration. To this end, the 
database includes open-ended comment fields that allow operators to enter detailed documentary 
information about an instrument, a BORCAL, or even comments unique to a particular 
instrument’s performance in a specific BORCAL. The comments are permanently stored in the 
database, and they are included in the printed calibration reports. 

1.2 Shortwave Data Acquisition 
The RCC data acquisition module controls the scanning of instruments by the data logger and 
does real-time analysis of incoming instrument data for anomalous or undesirable conditions. 

Information in the database specified by the BORCAL-SW operators is used to configure a data 
acquisition session. This configuration information includes the identification of reference 
instruments, control instruments, all test instruments, instrument tilt, specified scan intervals, and 
instrument cabling. Test instruments may be configured independently from one another (for 
example, at different tilts). The data acquisition sessions range in time from a few minutes to 
perhaps several hours. During a session, the configuration of the instruments remains static: no 
instruments may be added, moved, or deleted, and no other parameters may be changed.  

Prior to the first BORCAL-SW data acquisition session, RCC automatically segregates 
instruments into scan groups by instrument type (manufacturer and model), tilt configuration, 
and associated pyrgeometer (if used) for the best data acquisition uniformity. A scan group is a 
collection of instruments that are sampled one immediately after the other by the data logger 
during a period of 1 to 2 seconds. Scanning is the fastest way to obtain measurement data by the 
logger, yet scans still require a finite amount of time to measure each instrument. To minimize 
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the amount of time between the scan of the reference instruments and that of the test instruments, 
RCC scan groups are limited in size to 10 instruments. To further minimize the time differential 
between the reference instruments and the test instruments, the system initiates the reference 
absolute cavity radiometer (ACR) reading at the same time it initiates a scan of the test 
instrument group, and the two diffuse reference instruments are included in the scan group of the 
test instruments. 

Atmospheric stability plays a significant role in the calibration of solar radiometers. Because of 
variations in the response times of different instrument types to changes in the solar irradiance, a 
stable atmosphere is critical for valid comparisons between test and reference instruments. A 
fast-responding, silicon-based radiometer along with the cavity and diffuse radiometers are 
sampled by RCC up to 60 times per minute to provide information on the stability of the solar 
radiation intensity being sensed by all instruments in a BORCAL. The output from this 
atmospheric stability radiometer (ASR) group is analyzed and scored for variability. The ASR 
score for each measurement is stored with the data record and used to filter undesirable data from 
that used to determine an instrument’s responsivities. It is also part of the uncertainty estimate 
for the measurement. 

As revealed by the hierarchy described above, the smallest unit of data acquisition is a 
measurement from a test instrument coupled with the associated data from the reference and 
ASR instruments. At this level, RCC examines the data for its suitability for inclusion in the final 
data set used to determine responsivities. The purpose of this examination is twofold: first, when 
the signal from an instrument strays from expected values, the data will be flagged as 
questionable, and, second, the BORCAL-SW operator will be alerted to a potential problem. 
Typical situations that should be detected include tracker misalignment (for both the direct 
normal and the shaded disk reference instruments), foreign matter or objects obstructing an 
instrument’s field of view (such as airborne material, birds, or insects), and signal cable 
problems. This system of alarms and flagging helps prevent bad data from being included in the 
computation of a calibration factor and speed rectification of the problem that caused the alarm 
and thus prevent further data loss. 

To aid in identifying data acquisition problems, RCC provides real-time graphing of the 
incoming data. This capability allows the operators to monitor the output of any instrument and 
compare it to similar instruments that should show a corresponding measurement profile. In 
addition, the system provides information about error conditions, such as the instruments 
involved, time of the error, and the associated data. This helps the operators troubleshoot the 
error and speed resolution of the problem. 

During a period of 1 hour or more, the responsivity of the ACR tends to shift (particularly with 
ambient temperature and irradiance level), adding error to the responsivities derived for the test 
instruments. To minimize these errors, data acquisition sessions must be periodically stopped for 
a short time to recalibrate the ACR. This calibration is scheduled at specified intervals, and it is 
performed automatically by RCC. The operator has the option of overriding the scheduled 
calibration to perform an ACR calibration at any time; however, the system schedules the 
calibrations to maximize the quantity of data available for the responsivity calculations. 
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The software mandates an electrical calibration of the ACR at the beginning and end of each data 
acquisition session. To minimize the effect of any drift, the calibration factors for the ACR are 
interpolated between session beginning and end. RCC accomplishes the electrical calibration 
process by directly controlling the ACR’s operating mode and making direct readings from the 
radiometer’s digital voltmeter. The voltages are rapidly sampled during a short period of time for 
an average value, and all of the readings are stored with the session data for archival purposes. 

1.3 Longwave Data Acquisition 
The RCC data acquisition module controls the scanning of instruments by the data logger and 
does real-time analysis of incoming instrument data for anomalous or undesirable conditions. 

Information in the database specified by the BORCAL-LW operators is used to configure a data 
acquisition session. This configuration information includes the identification of reference 
instruments, control instruments, all test instruments, specified scan intervals, and instrument 
cabling. One data acquisition session consists of an entire night (or less if the data collection is 
stopped). During a session, the configuration of the instruments remains static: no instruments 
may be added, moved, or deleted, and no other parameters may be changed.  

For BORCAL-LW, all instruments are scanned in one group; they are not segregated into groups 
like BORCAL-SW because the LW radiation does not change as rapidly as the SW radiation. 
Also, RCC conducts a scan of the reference prior to and after scanning the instruments. If the 
change in reference conditions exceeds the configured threshold, the data will be rejected during 
final processing. For data that is accepted, the average of the two reference scans is taken. 

As revealed by the hierarchy described above, the smallest unit of data acquisition is a 
measurement from a test instrument coupled with the associated data from the reference and 
ambient temperature. At this level, RCC examines the data for potential problems, but it does not 
flag or reject test instrument data (unless there are stability problems with one or more reference 
instruments during the duration of the scan). RCC will only produce alarms for stability issues of 
test instruments and large deviations of test case temperature (and dome temperature if available) 
compared to ambient temperature. Because the LW events are at night, these alarm conditions 
are also recorded to disk for review the next day for potential problems.  

To aid in identifying data acquisition problems, RCC provides real-time graphing of the 
incoming data. This capability allows the operators to monitor the output of any instrument and 
compare it to similar instruments that should show a corresponding measurement profile. In 
addition, RCC provides information about error conditions, such as the instruments involved, 
time of the error, and the associated data. This helps the operators troubleshoot the error and 
speed the resolution of the problem. 

1.4 Shortwave Instrument Responsivities 
An instrument’s responsivity is defined as the signal generated by the radiometer (microvolts) 
per unit of input stimulus (solar irradiance in W/m2). Conventional calibration procedures 
produce a single responsivity for an instrument, and RCC produces this conventional number for 
both pyranometers and pyrheliometers. In addition, RCC makes a significant impact on reducing 
measurement uncertainty by characterizing the instrument’s sensitivity to variations in the 
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position of the sun relative to the instrument. Solar radiometers typically exhibit a characteristic 
response profile that varies with solar azimuth and zenith angles. By deriving responsivities for 
multiple azimuth and zenith combinations, the opportunity is provided to reduce the uncertainty 
of subsequent measurements of solar radiation. 

RCC provides several responsivities for instruments; each are derived using a different method, 
and each characterizes the instruments in different ways. (Each characterization is duplicated for 
instruments configured for the Effective Net Infrared Corrected Responsivity, or ENICR.) 

• Single-number responsivities 

o Forty-five-degree responsivity: the instrument’s responsivity at a zenith angle of 
45° ± 0.3°. This narrowly characterized number minimizes the variables that can 
affect responsivity, and it is useful for illuminating a shift in sensitivity over time. 
This number may not be representative of the instrument’s responsivity at other 
zenith angles. 

• Multidimensional responsivities 

o Two-degree responsivities: a set of responsivities derived at ±0.3° from even 
zenith angles in the BORCAL event’s zenith angle range (e.g., 0°, 2°, 4° … 90°). 
There are two sets of two-degree responsivities: one for a.m. and one for p.m. 

o Two-degree a.m./p.m. averaged responsivities: provided to the user as a 
convenience and do not appear in the calibration certificate (only in the 
Atmospheric Radiation Measurement Program Instrument Management System 
(AIM database) or as requested) 

̶ Missing bins within the range of valid zenith angle bins are interpolated 
between existing values (for both a.m. and p.m.). 

̶ Missing bins beyond the range of valid zenith angle bins are extrapolated 
by repeating the same value that is available at the beginning and end of 
each available range for both a.m. and p.m. 

̶ Finally, the a.m. and p.m. values for the same bin are averaged together to 
produce the final result for every bin between 0 and 90.  

o Spline fit for the a.m. and p.m. two-degree responsivities in the traceable valid 
zenith angle range. 

• Multidimensional responsivities for pyranometers (obsolete) 

o Responsivity function: a 49-degree polynomial in cosine (z) fitted to all available 
two-degree responsivities plus three extrapolated values at –2°, 92°, and 94°.1  

̶ Missing bins within the range of valid zenith angle bins are interpolated 
between existing values.  

̶ Missing bins beyond the range toward –2 degrees are extrapolated along a 
cosine curve for both a.m. and p.m. bins, then the a.m. and p.m. values for 

                                                 
1 These are obsolete results, and they are not included in the calibration certificate; however, they are posted in the 
AIM database. In a future release of RCC, these results will be removed. 
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each bin are averaged, and that average is used for both the a.m. and p.m. 
bin values. 

̶ Missing a.m. and p.m. bins beyond the range toward 94° are extrapolated 
independently along a cosine curve. The curves are prevented from going 
negative or from continuing with a positive slope beyond 86°. In such 
cases, the curve is “mirrored” or reversed. 

o Latitude-optimized: a set of weighted numbers by latitude derived by including 
only the solar geometry characteristics encountered at a given latitude. (These are 
derived from the responsivity function.)2  

1.5 Longwave Instrument Coefficients 
RCC uses multivariate linear regression to calculate three coefficients (four for instruments with 
dome temperature) to produce results with higher accuracy. In addition, RCC uses a unique 
method for data rejection. After rejecting data when reference conditions are unstable, the post-
processing routine will iteratively compute the residual (i.e., reference irradiance minus test 
irradiance) using computed coefficients then reject data points that fall outside the configured 
standard deviations (typically three times standard deviation). The final data set will be used for 
the regression to calculate the final reported coefficients. This assumes that a higher percentage 
of the data is acceptable when rejected data could have occurred because the sensors were not 
clean or because the atmospheric conditions were not stable.  

RCC provides two sets of coefficients: one with the K0 coefficients forced to zero and the other 
with a value. Although the K0-forced to-zero method may not be as accurate, some end users 
prefer this option.  

1.6 Reporting 
The RCC system provides several reporting functions: 

• Calibration certificates: documents that conform to International Organization for 
Standardization (ISO) 17025 standards for reporting calibration results, calibration 
environment, and ancillary data. These include a plot of the calibration data and a table of 
two-degree responsivities for BORCAL-SW. 

• Suggested deployment methods: data sheets that describe the various responsivity 
characteristics noted above (optional, for BORCAL-SW only) 

• Full report: a document that compiles the certificates and suggested deployment methods 
for all instruments in a BORCAL along with the BORCAL operator logs (for BORCAL-
SW only) and instrument comments 

• Customer report: a document similar to the full report but containing only information for 
a customer’s particular instruments. 

In addition to the above hard-copy reports, RCC allows an analyst to examine instrument data 
on-screen. 

                                                 
2 These are obsolete results, and they are not included in the calibration certificate; however, they are posted in the 
AIM database. In a future release of RCC, these results will be removed. 
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2 Hardware and System Requirements 
The RCC system runs under Microsoft Windows XP 32-bit, 7 32-bit, and 7 64-bit (XP 64-bit, 
Vista, 8, and 10 have not been tested). 

• Required 

o Dual-core central processing unit with speed as required by the operating system 
(Four-core or more is recommended.) 

o Minimum 1 gigabyte memory for 32-bit operating system and 2 gigabyte memory 
for 64-bit operating system (Four gigabyte or more is recommended.) 

o Compact disk read-only memory (CD-ROM), universal serial bus (USB), or 
network connectivity for initial installation 

o Disk drive with several hundred free megabytes  

o Monitor with minimum resolution of 1,024 x 768  

o General purpose interface bus (GPIB) or RS-232 communications ports as 
required 

o Data logger with low voltage measurement capability (resistance also required for 
BORCAL-LW) 

 Fluke Helios Plus 2287A (obsolete) 

 National Renewable Energy Laboratory’s Reda-Afshin-Pete Data 
Acquisition model RAP-DAQ (contact NREL for more details) 

o Eppley HF ACR with one of the following: 

 Eppley Model 406 control unit with HP34401A or DP100 voltmeter 
(obsolete) 

 Eppley 408M control unit 
 National Renewable Energy Laboratory’s model Reda control unit 

(contact NREL for more details). 
o National Instruments LabWindows/CVI SQL Database Driver Run-Time License 

(777151-011) 

• Optional 

o Global Positioning System (GPS) unit for maintaining computer clock time 

 Hewlett-Packard or Symmetricom 58533A (obsolete) 

 Symmetricom XLi Time and Frequency System with GPS timing engine 
and lightning arrestor (1510-602, 87-8028-2, 150-709). 

o Temperature, humidity, and barometric pressure sensors (BORCAL-LW requires 
the temperature sensor.) 

o Microsoft Word for viewing this document online 
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o BullZip Portable Document Format (PDF) printer driver for generating PDF 
versions of reports 

o Adobe Acrobat Reader (or compatible viewer) for viewing PDF reports  

o Uninterruptible power supply for maintaining computer operations and data 
integrity in the event of a power failure 

o Fast printer (color laser preferred) for printing reports. 
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3 Program Installation 
RCC is provided on a CD-ROM. To install the program, insert the CD into the drive. If the 
install screen does not appear within a few seconds, navigate from the Start→Run menu to the 
setup.exe program in the CD root directory, and run the program by double-clicking on the setup 
icon. 

3.1 Standard Setup 
When the install wizard appears after running the setup program, you may change the default 
installation directory by entering a new name in the field for the Installation Directory.  

Click on Finish to install the RCC. When the installation is complete, a pop-up message will 
appear stating that the installation was successful. In some cases, the program may indicate that 
you need to reboot your computer. Click on Okay, and if necessary reboot your computer. 

The setup program creates a shortcut in the start menu, but it does not install a shortcut on the 
desktop. If desired, you may create a desktop icon for RCC:  

• Navigate to the Start→RCC→RCC icon. 

• Right-click on the icon, drag it to the desktop, and release. 

3.2 Custom Setup 
If you want to install multiple copies of RCC (for instance, when maintaining more than one 
calibration facility, each with its own database and data files), you will need to install the 
program for each facility.  

You must first create a temporary installation directory to run the setup program: 

• Insert the CD in the drive. If the installation program self-starts, cancel the installation. 

• Using Windows Explorer, create a temporary installation directory (this directory cannot 
have a space character in its name), and copy all files from the CD root directory to the 
temporary installation directory. 

• Using Windows Explorer, navigate to the CD. Right-click on Open the CD to open a 
browser window from its root directory. 

• Using Windows Explorer, change the read-only attribute of the rcc_db.ini file (on the file 
name or icon, right-click on Properties, and uncheck the Read-Only attribute). 

For each installation, follow these steps using the temporary installation directory created above: 

• Open the rcc_db.ini file by double-clicking on the file name. 

• Look for the line DSN=RCC, and change RCC to a unique name related to the facility 
(such as RCC_Site_A). Make a note of this name for use in a following step. 

• Change the description line if desired. 

• Save the edited rcc_db.ini file. 
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• Run the setup program from the same temporary directory. 

• In the Setup screen, change the default directory to a unique name related to the facility, 
and click on Finish. 

• After the installation is complete, click on Okay. 

• Navigate to the Start→RCC→RCC icon. Right-click on the icon, and drag it to the 
desktop to create a shortcut. 

• From the desktop, right-click on the RCC shortcut icon, and select Properties. In the 
Target field, append a space and a command-line argument to the existing program name 
(right after RCC.exe) using the same unique name entered on the DSN line in the 
rcc_db.ini file edited above. Click on Okay. 

• From the desktop, right-click on the RCC shortcut icon, and select Rename. Enter a 
unique name for the shortcut. 

Note that each installation will overwrite the RCC icon in the start menu so it is necessary to 
copy each installed icon to the desktop before starting another installation. 

3.3 Initial Configuration  
When RCC is first installed, most data tables are empty. When RCC is run under these 
conditions, some database error messages may appear until the first BORCAL is established. 
These messages can be ignored. 

Follow these steps to properly initialize the data tables: 

• In Edit→Database→Facility, configure your calibration site. 

• In File→New Borcal, create a new BORCAL without using the template. 

• In the resulting Session Configuration screen, select the newly established calibration 
facility in the Facility Name field. 

The session configuration screen can be closed at this point, and the start-up error messages 
should no longer appear. 

3.4 Uninstalling RCC 
• Select Start→RCC→Uninstall (or if multiple copies are installed, navigate to the 

directory containing the version to be uninstalled and double-click on the Uninstall icon). 

• When asked about removing the LabWindows Runtime Engine, click on No if other 
versions of RCC or other LabWindows programs are installed. 

The uninstaller will not remove data files. You must remove those using Windows Explorer. 
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4 Program Start-Up 
To start RCC, double-click on its program icon on the desktop or navigate from the conventional 
Windows program start menu to the RCC program. This brings up the RCC main window, 
shown below. All menu items are described later in this manual. 

 
Figure 4-1. RCC’s main window  
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5 BORCAL Event Types 
There are two BORCAL event types: BORCAL-SW and BORCAL-LW. BORCAL-SW and 
BORCAL-LW events can occur simultaneously, and they can start and stop independently. 
BORCAL-SW and BORCAL-LW events are configured separately. These events will have the 
same event numbers, but the SW and LW nomenclature is used to distinguish between them. 
However, data collection does not occur simultaneously: SW data collection occurs during the 
daytime, and LW data collection occurs during the nighttime. 

An automatic feature will start and stop the events at the proper zenith angle as configured in the 
system configuration. If the user wants to manually start the collection, configure an event, or 
perform data processing, the user must first select the proper mode by using the switch on the left 
of the main window for either LW or SW. The menu structure will change appropriately when 
the user changes this switch. 
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6 BORCAL Configuration 
A BORCAL event consists of multiple data acquisition sessions. Each session is configured prior 
to starting with all information necessary to correctly record measurements from the BORCAL 
instruments. The session configuration is stored as a permanent record in the database. 

A BORCAL-SW session, typically approximately 1 hour in length, is usually terminated for one 
of three reasons: (1) the need for an ACR calibration, (2) increasing clouds or other unfavorable 
conditions, or (3) the end of the day. A BORCAL-LW session, typically approximately 1 night in 
length, is usually terminated for only one reason (although rare): unfavorable conditions. During 
a session, no changes may be made to the instrument’s configuration or any other data 
acquisition parameters. If such a need arises, the session must be terminated before the changes 
can be made. 

6.1 Session Configuration Overview 
Prior to running a session, the operator must establish a session configuration. The session 
configuration is a procedure by which the operator identifies the reference, ASR (for BORCAL-
SW only), test, control, and meteorological instruments as well as the conditions under which the 
data acquisition proceeds.  

The session configuration includes the following information: 

• Reference and test instruments’ serial numbers 

• Cabling and data logger channel configuration  

• Instruments’ locations 

• Instruments’ scan intervals. 

During an ongoing BORCAL, a new session is typically configured exactly as the previous 
session, and no additional information is required; the operator needs only to start a session, and 
the previous configuration is used. Additionally, for BORCAL-SW, a scheduled ACR calibration 
will automatically end a session and start a new session without operator intervention. 

However, the first session of the BORCAL must be completely configured using the session 
configuration editor. The configuration can be started, saved, and later reopened for additional 
work. If changes are made in instrumentation during a BORCAL (such as the addition or 
removal of a test instrument), the changes must be reflected by editing the session configuration. 

6.2 Minimum RCC Configuration for BORCAL-SW 
A minimum RCC session configuration for BORCAL-SW requires the following instruments: 

• An ACR and its associated control unit 

• A diffuse pyranometer (mounted under a tracking disk) 

• A silicon detector ASR (e.g., LI-COR LI-200) 
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• Two test instruments (at a minimum, these would be configured as the two control 
instruments listed below; typically, other test instruments would be included.) 

• One control pyranometer (See Section 6.4 on Shortwave BORCAL-SW Control 
Instruments.) 

• One control pyrheliometer (See Section 6.4 on Shortwave BORCAL-SW Control 
Instruments.) 

• A data logger 

• One or more pyrgeometers if any test instruments are configured for ENICR. 

If the configuration does not contain the required instruments listed above, RCC will not 
commence a session.  

The following instruments are optional: 

• Temperature sensor  

• Humidity sensor 

• Barometric pressure sensor 

• GPS receiver. 

Although the meteorological instruments are optional, temperature and humidity should be 
omitted only because of extraordinary circumstances. RCC derives aerosol optical depth (AOD) 
estimates from these measurements, which contain valuable calibration environmental data. 

The figure below shows a schematic of the hardware components of RCC. 

 
Figure 6-1. Schematic of RCC’S BORCAL-SW hardware components  

 
6.3 Minimum RCC Configuration for BORCAL-LW 
A minimum RCC session configuration for BORCAL-LW requires the following instruments: 

• At least one reference pyrgeometer 
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• At least one test pyrgeometer 

• A data logger 

• A temperature sensor. 

If the configuration does not contain the required instruments listed above, RCC will not 
commence a session.  

The following instruments are optional: 

• Humidity sensor 

• Barometric pressure sensor 

• GPS receiver 

• A test pyrgeometer designated as a control. (See Section 6.5 on BORCAL-LW Control 
Instruments.) 

Although some meteorological instruments are optional, humidity should be omitted only 
because of extraordinary circumstances. RCC derives precipitable water vapor (PWV) estimates 
from this measurement, which contain valuable calibration environmental data. 

The figure below shows a schematic of the hardware components of RCC. 

 
Figure 6-2. Schematic of RCC’s BORCAL-LW hardware components  

 
6.4 BORCAL-SW Control Instruments 
BORCAL-SW control instruments are configured in the BORCAL as test instruments except that 
they have the additional designation as control instruments. These instruments, which are used 
only for calibration control, have a known and trusted calibration history and are included in 
every BORCAL. This allows you to check the validity of the BORCAL results based on the 
consistency of the control instrument calibration results. Although any instrument previously 
calibrated by RCC can be designated as a control instrument, control instruments should be 
selected based on a consistent and well-characterized calibration history that indicates stability 
among calibration events. 
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Because control instruments are used to demonstrate consistency from one calibration event to 
the next, no provision in RCC is made to enter responsivity information for control instruments. 
This restriction is enforced by mandating that a control instrument be included in a previous 
calibration event. This restriction brings up the question of how to run the first BORCAL at a 
calibration facility. Because the first-time start-up is a rare event, no formal provision has been 
made for such an initial BORCAL. However, a special start-up BORCAL can be performed with 
the assistance of the National Renewable Energy Laboratory that allows a site to create a set of 
qualifying control instruments. The special start-up BORCAL includes: 

• Importing temporary calibration records for the control instruments using nominal but 
inaccurate responsivity values 

• Running data acquisition under carefully monitored conditions. The resulting data set will 
have many flags because the control instrument’s responsivities will create a mismatch 
when used to compare a control instrument’s measured irradiance to the reference 
irradiance. 

• Forcing the inclusion of flagged data during processing and reporting. 

This process creates a valid calibration record for each control instrument and allows a 
conventional BORCAL to commence. 

This restriction also underscores the need to designate spare control instruments that have 
a current and representative calibration in the database. If a control instrument fails, the 
backup could be placed into service without the need for the special start-up BORCAL 
procedure. 
 
BORCAL-SW control instruments are treated identically to test instruments with two exceptions: 
(1) they are used for real-time quality checks of the reference instruments during data 
acquisition, and (2) their current responsivity in the database is not updated (with this exception: 
current responsivities for test instruments are made known by updating the Current BORCAL 
field in the Radiometer Inventory table). However, the control instrument’s responsivities for the 
calibration event are included in reports along with other test instruments. This approach 
prevents an errant or flawed calibration event from corrupting the control instrument’s 
responsivities and adversely affecting the real-time quality checks of future events.3  

If the need arises to update a control instrument’s responsivity, this is easily accomplished 
by editing the Current BORCAL field for that instrument in the Radiometer Inventory 
table. 
 
6.5 BORCAL-LW Control Instruments 
BORCAL-LW control instruments are configured in the BORCAL as test instruments except 
that they have the additional designation as control instruments. These instruments, which are 
used only for calibration control, have a known and trusted calibration history and are included 
in every BORCAL. This allows for checking the validity of the BORCAL results based on the 
                                                 
3 The calibration history of all control reports are shown on all customer reports and on the full report in the section 
on “Control Instrument History Plots,” which starts on page 4 of these reports. 
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consistency of the control instrument’s calibration results. Although any instrument can be 
designated as a control instrument, control instruments should be selected based on a consistent 
and well-characterized calibration history that indicates stability among calibration events. 
BORCAL-LW control instruments are treated identically to test instruments with no exceptions.4  

6.6 Preliminary Information 
Prior to configuring a BORCAL-SW session (particularly the first session of a BORCAL), locate 
all of the SW instruments involved. The test instruments, reference and control instruments, ASR 
instrument, and pyrgeometer if required should be mounted on the calibration platform or 
trackers; the diffuse pyranometer(s) should be mounted under the tracking disk; and the 
meteorological instruments should be installed. The pyrgeometer(s) should be mounted unshaded 
as close as possible to the instruments using ENICR, and it should be ventilated if the ENICR 
instruments are ventilated. Cable all instruments, and make data logger channel assignments. 
Note all of the instruments locations, cable numbers (if applicable), and channel assignments. 
The reference ACR should not be mounted until right before the data acquisition starts, but its 
control unit configuration should be determined, and connections should be made to the RCC 
computer. In a BORCAL-LW, all test and reference instruments should be collocated and 
unshaded. 

All configuration data are entered into the database using the database maintenance functions. 
These functions are available by navigating from the Edit→Data Base menu or the 
Edit→Borcal/Session menu. See Section 10.2 on Database Maintenance for a description of 
entering or modifying database information. 

Use the following guidelines to prepare the preliminary information. 

6.6.1 Customers 
These are the people or agencies who delivered the instruments for calibration. Provide each 
customer’s name, contact person, address, and phone number. It is possible that the customer for 
a particular instrument may change from one BORCAL to another. No specific provision is 
made to track changes of the customer for each instrument; however, the customer history is 
maintained in a field in the session configuration records for each BORCAL. Only the latest 
information entered is retained in the instrument inventory table, and each instrument’s customer 
defaults to this information when subsequently configured. 

6.6.2 Location 
This is the calibration facility at which the BORCAL is conducted. You must include the site’s 
latitude and longitude in decimal degrees (to two decimal places), contact person, time zone, 
elevation in meters, temperature in degrees Celsius, and station barometric pressure in millibars. 
Latitude is entered as a positive number in the northern hemisphere and as a negative number in 
the southern hemisphere. Longitude is negative west of the prime meridian and positive east of 
the prime meridian. The time zone is the difference in hours between Greenwich Time and the 
site’s local standard time, and by convention it is negative west of Greenwich and positive east 

                                                 
4 The calibration history of all control reports are shown on all customer reports and on the full report in the section 
on “Control Instrument History Plots,” which starts on page 4 of these reports. 
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of Greenwich. Average temperature and barometric pressure are the nominal long-term average 
values for the site. 

6.6.3 Operators 
These are the people who will be running the BORCAL data acquisition sessions. Include their 
names. 

6.6.4 Instrument Types 
RCC requires an entry for each type of instrument included in a BORCAL including reference 
instruments, cavity control units, and meteorological instruments. An instrument’s type is 
defined by its manufacturer and model. In addition, enter a descriptive name for the instrument. 
This is usually based on the manufacturer’s descriptive name—for example, precision spectral 
pyranometer. For each type of radiometer, specify a maximum output voltage in millivolts for 
the thermopile and the maximum resistance for the case and dome thermistors in kilo-ohms. This 
is used for data logger scaling. It should be set so that the output voltage or resistance will never 
exceed this value (which will cause data acquisition errors), and it should not be set too high and 
force the logger to measure at a scale that is too high (causing an increase in measurement 
uncertainty). If an instrument type can be configured for ENICR, then its infrared (IR) correction 
should be enabled and the Generic Rnet  value must be entered. The field for the estimated 
thermal offset error is optional and used only for reporting purposes. Finally, determine how the 
instrument will be used in the system. The table below lists and describes the available uses. 

Table 6-1. Instrument Types 

Use Code Description 

TOT Total global (hemispherical) pyranometer 

DIR Direct normal (beam) pyrheliometer 

SHD Test pyranometer mounted under a shading disk (different from diffuse reference 
instruments) 

MCO Manual ACR control unit 

ACO Automatic ACR control unit 

ACM Combo automatic ACR control unit and digital voltmeter 

CAV ACR 

PYG Pyrgeometer 

LGR Data logger (combo multimeter and relay system) 

RLY Data logger (relays only) 

TEM Thermometer 

HUM Hygrometer 

BAR Barometer 

DVM Digital multimeter for cavity or data logger relays 

GPS GPS receiver 
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6.6.5 Data Logger 
In addition to the data logger’s serial number, RCC requires the following information: 

• Unit number: For relay (RLY) data loggers (that have a separate digital multimeter, or 
DMM), this indicates the unit number, which is a number based on the physical wiring of 
the relay/DMM to the available channels at the calibration facility. Multiple RLY-type 
loggers are supported, and the unit numbers must be sequential starting with zero (the 
highest unit number must be less than the total number of units). Combo loggers (LGR) 
must be assigned unit number zero, and only one LGR-type logger is supported. 

• System Offsets 

o Volts DC: volt direct-current (DC) offset of the data logger system as a whole 
(including meters, relays, and signal cabling) as determined during system short 
testing 

o Two-wire resistance: two-wire resistance offset of the data logger system as a 
whole (including meters, relays, and signal cabling) as determined during system 
short testing 

o Four-wire resistance: four-wire resistance offset of the data logger system as a 
whole (including meters, relays, and signal cabling) as determined during system 
short testing 

• Calibration dates: date and due date of the instrument’s calibrations (including calibration 
of multimeter and short tests if applicable) 

• Communications parameters: parameters for the RS-232 communications port or GPIB 
protocol for both the multimeter and relays (if equipped). 

6.6.6 Reference Absolute Cavity Radiometer (BORCAL-SW Only) 
In addition to the ACR’s serial number, RCC also requires specific information about the ACR: 

• Unwindowed WRR reduction factor: World Radiometric Reference (WRR) or 
intercomparison factor  

• Unwindowed WRR uncertainty: uncertainty of the unwindowed WRR factor 

• Windowed WRR factor: If the ACR is supplied with a window, enter the WRR factor 
determined with the window mounted. If a window is not supplied with the ACR, use 1.0 
for the correction factor. 

• Windowed WRR uncertainty: uncertainty of the windowed WRR factor 

• Manufacturer's correction factor: supplied by the manufacturer 

• Heater resistance: resistance of the cavity heater (supplied by the manufacturer) 

• Heater lead resistance: resistance of the heater leads (supplied by the manufacturer) 

• Default sensitivity: ACR’s nominal sensitivity in mV/mW/cm2 (supplied by the 
manufacturer) 

• Maximum voltmeter scale: lowest possible scale without risking overvoltage readings 
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• Calibration dates: date and due date of the instrument’s calibration (calibration of 
electrical components or comparison to WRR). 

6.6.7 Cavity Control Unit (BORCAL-SW Only) 
In addition to the control unit’s serial number, RCC requires the following information: 

• Current shunt: resistance of the current sensing resistor used in the calculation to 
determine the power (current multiplied by resistance) dissipated by the cavity heater. 
The Eppley Laboratory normally supplies cavity radiometer systems with this resistance 
specified as a nominal value; however, some systems are supplied with a value 
determined by an accurate measurement. Regardless of the value specified by the 
manufacturer, the correct resistance value for RCC is the exact value used when the ACR 
WRR factor or windowed WRR factor (described above) was determined. 

• Circuit resistance: overall resistance of the cavity heater circuit excluding the heater and 
heater lead resistances 

• Communications parameters: parameters for the RS-232 communications port or GPIB 
protocol for both the cavity control unit and the voltmeter. 

6.6.8 Reference Diffuse Pyranometer (BORCAL-SW Only) 
For the shaded disk pyranometer, RCC requires: 

• Serial number: instrument’s serial number 

• Responsivity: instrument’s most recent calibration responsivity 

• Shading disk size: diameter of the shading disk in centimeters 

• Arm length: length of the shading disk arm in centimeters 

• Uncertainty: instrument’s calibration uncertainty expressed in percent and thermal offset 
in W/m2 (two numbers) 

• Calibration date: date and due date of the instrument’s calibration 

• Location: position of the instrument and its tracker in the outdoor instrument setup 

• Cable/signal box: cable number and junction box connector number (optional) 

• Channel: data logger channel assignment 

6.6.9 Atmospheric Stability Radiometers (BORCAL-SW Only) 
Two parameters are set for the ASR functions: 

• Scan interval: number of seconds between scans of the ASR instruments (typically 1 
second) 

• Stability number: number of measurement samples in the stability analysis (typically 60). 

In addition, information about the two ASR radiometers is required. (Global refers to a silicon 
pyranometer, and direct refers to a silicon pyrheliometer or reference ACR.) 

• Serial number: instrument’s serial number 



 

21 

This report is available at no cost from the National Renewable Energy Laboratory (NREL) at www.nrel.gov/publications. 

• Location: instrument’s outdoor location on the radiometer table or tracker 

• Cable/signal box: cable number and junction box connection (optional) 

• Channel: data logger channel assignment. 

The ASR instruments must have been previously calibrated by the RCC system. 

6.6.10 Test Instruments 
Each test instrument must be described with the following information. (Items marked with an 
asterisk may already be stored in the database if the instrument was entered at an earlier time and 
does not need to be entered again.) 

• Serial number: instrument’s serial number 

• Location: location on the instrument’s table or tracker 

• Cable/signal box: cable number and junction box connector (optional) 

• Channel: data logger channel assignment(s) for thermopile and (if used) case and dome 
thermistors 

• Rnet: instrument’s ENICR. This is required only if the instrument is configured for 
ENICR. If it is not specified, this value defaults to a generic Rnet for the instrument type. 
ENICR does not apply to BORCAL-LW, and it will not appear in configuration screens. 

• Rnet uncertainty: uncertainty of the Rnet value (percent) 

• Calibration date (Rnet): date the instrument’s Rnet value was determined 

• Pyrgeometer: instrument’s identification (serial number and manufacture/model) of the 
IR correcting pyrgeometer. This is required only if the instrument is configured for an 
ENICR. 

• Control: indicator if the instrument is included in the BORCAL as a control (See Section 
6.2 on Minimum RCC Configuration for BORCAL-SW.) 

• *Customer: customer supplying the instrument for calibration 

• *Factory Calibration: instrument’s factory responsivity 

• Scan: scan interval in seconds for this instrument (typically 30 seconds). 

6.6.11 Reference Pyrgeometers 
These are required for BORCAL-LW, but they are required for BORCAL-SW only if the test 
instruments are configured for an ENICR. More than one pyrgeometer may be required if 
multiple instrument types are configured for the corrected responsivity. 

• Serial number: pyrgeometer’s serial number 

• Location: physical location of the instrument 

• Calibration coefficients: K0, K1, K2, K3 and Kr coefficients with traceability to the 
World Infrared Standard Group. 
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• Calibration dates: date and due date of the pyrgeometer’s calibration 

• Channel: data logger channel assignment for thermopile, case, and (if used) dome 
thermistors or resistance temperature detectors 

• Cable/signal box: cable and junction box connector for thermopile, case, and (if used) 
dome thermistors (optional). 

6.6.12  Meteorological Instruments 
Three types of meteorological instruments are accepted by RCC: temperature, humidity, and 
barometric pressure. Each requires the following information: 

• Serial number: instrument’s serial number 

• Location: physical location of the instrument 

• Cable/signal box: cable and junction box connector (optional) 

• Channel: data logger channel assignment 

• Offset: additive scaling offset to convert to measurement units (Use zero if not specified.) 

• Scale: scaling slope to convert to measurement units (Use 1.0 if not specified.) 

• Scan: scan interval in seconds for the met instruments (typically 300 seconds). 

6.7 Configuring a New BORCAL-SW 
Use the Session Editor to construct the data acquisition environment (configure the system) so 
that the software is prepared to accept and acquire data from the appropriate instruments. 

Be sure the BORCAL type is set to Shortwave. 

If you are starting a new BORCAL, select File→New BORCAL from RCC’s main window. 

 
Figure 6-3. Selecting a new BORCAL from RCC’s main window 
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Figure 6-4. New BORCAL Configuration window 

 
You have the option of using a previous BORCAL as a template for the new BORCAL, which 
will save time if that BORCAL was similarly configured. When you check the box for Select a 
BORCAL as a Template, double-click on the field below it, and choose a BORCAL from the 
pop-up list. With this option checked, the fundamental configurations are presented under Copy 
These Configurations. For each option selected, the new BORCAL will contain the final 
configuration parameters from the indicated template BORCAL. If the box for Perpetual 
Instruments is checked, all instruments designated as such will be carried forward. Perpetual 
instruments are test instruments that are usually included in each BORCAL and would otherwise 
need to be configured for each BORCAL. If the All Test Instruments box is checked, all test 
instrument configurations carry forward from the template BORCAL. If all boxes are checked, 
the result will be a copy of the template BORCAL.  

After selecting any desired configurations to copy, click on Create to create a new BORCAL. 
This brings up the BORCAL Configuration window shown below, which displays a functional 
summary of the configuration. (The figure below shows blank fields, indicating no carryover 
configurations.) BORCAL configuration is accomplished by completing the required information 
for all instruments and system parameters. 
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Figure 6-5. BORCAL-SW Configuration window 

 
6.7.1 Steps for BORCAL Configuration 
When configuring a new BORCAL, follow this general outline of steps: 

• Calibration facility designation 

• System configuration 

• Reference ACR configuration 

• Reference diffuse configuration 

• ASRs 

• Pyrgeometers (if used for ENICR) 

• Meteorological instruments (optional) 

• GPS configuration (optional) 

• Test instrument configuration 

• Data logger. 
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In most cases, when the database does not have an item (for example, an instrument or 
calibration facility), a new record can be added by clicking on New when viewing the 
database Table Selection window for that item. See Section 10.2 on Database 
Maintenance for additional instructions. 
 
Many fields in the configuration windows are subject to validity checks, which occur 
when you click on Accept on a configuration window. If a field value is out of range, a 
pop-up window displays the name(s) of the field(s) with the invalid value and shows the 
range of acceptable values. You cannot close this window until all fields are within range. 
 
6.7.2 Facility 
Double-click on Facility Name under Calibration Facility on the configuration screen. This 
brings up a list of configured calibration facilities. Select the desired facility, and click on Select.  

6.7.3 System Configuration 
To enter the system parameters, double-click on the System Configuration field. This presents 
the System Configuration window (shown below), which contains several categories of 
parameters. (The figure below shows all fields configured; when starting without a configuration 
template from a previous BORCAL, the fields are filled with zeroes.) 

 
Figure 6-6. BORCAL-SW System Configuration window 
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Each category is described below. (The values shown in the window are the suggested defaults 
except for the site-specific water vapor values noted below.) 

• Delta thresholds: alarm difference threshold for each real-time quality check. These 
values are the absolute difference between the two listed measurements determined as 
|M1 – M2| in the units of the measurement. 

• Percent error thresholds: alarm ratio threshold parameter for each real-time quality check. 
The value entered is the percent difference between the two listed measurements (M1 and 
M2), determined as |M1 – M2| / M1 x 100. In all cases except Test(x), the two parameters 
are simultaneous measurements from different instruments. In the case of Test(x) / 
Test(x-1), the measurements are from adjacent data scans of the same instrument (the 
current scan and the previous scan). 

• ASR setup 

o Scan rate: approximate interval between scans in seconds  

o ASR readings: number of readings used to form the ASR scan set  

o Threshold 1 (Blue): upper threshold (W/m2) in variability among readings for the 
ASR score in the blue category. Likewise for Threshold 2 (Green) and Threshold 
3 (Brown). Variability beyond Threshold 3 is scored as ASR Red. Diffuse Scaling 
Factor is a multiplier that transforms the diffuse variability to the three thresholds 
described above (e.g., if Threshold 2 is 2 and the scaling factor is 0.5, then the 
active threshold for diffuse variability is 1.0 W/m2). Variability in W/m2 is 
determined by the greatest difference among the readings in the ASR scan set for 
each measurement. The thresholds are then applied to the variability to determine 
the ASR score. 

• Automatic mode: parameters that specify the zenith angle thresholds for system start-up 
and shutdown in automatic mode. 

• Intervals: intervals for automatic ACR calibrations and operator logs 

• Uncertainty: parameters for expressing the uncertainty of the results 

o Zenith angle (degrees): uncertainty of the zenith angle calculation of the solar 
position algorithm in use (NRELSPA) 

o Decimal precision: number of digits past the decimal point  45° negative offset 
that determines the low end of the uncertainty zenith angle range by adding the 
value to 45°  

o 45° positive offset: determines the high end of the uncertainty zenith angle range 
by adding the value to 45. For example, values of –15 and +15, respectively, 
would result in an uncertainty range of 30° to 60°.  

o Minimum legal direct: threshold (W/m2) below which no uncertainties are 
reported 

o Maximum legal diffuse: threshold above which a measurement is not included in 
any results 
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o Maximum diffuse/direct: argument used in an equation to calculate a threshold 
ratio (in percent) above which a measurement is not included in any results. The 
actual threshold is calculated as Threshold = Argument · e^(-cos(Zenith)).  

• Scan rate: scan rates for radiometers under test and meteorological instruments  

• Incoming IR thresholds: minimum and maximum values allowable for the measured 
incoming IR values from the pyrgeometer 

• Clock 

o Reset interval: number of minutes between automatic clock-reset operations. A 
value of zero disables the automatic clock-setting function.  

o Warning threshold: magnitude of a clock correction (in seconds) allowed before 
the operator is warned of the impending correction. (Clock setting can be 
accomplished by either the operator or, if configured, a GPS unit.)  

o Delta UT1: positive or negative correction (seconds) to be added to Coordinated 
Universal Time to adjust for an irregular earth rotation rate. 

• Solar position algorithm  

o Delta T: difference in seconds between the earth’s rotation time and terrestrial 
time from the observation  

o Atmospheric refraction: atmospheric refraction in degrees at sunrise and sunset. 

• Tilt: parameters for tilted instrument calibrations in degrees 

o Zenith: amount of tilt from the zenith (horizontal = 0, vertical [pointing toward 
the horizon] = 90) 

o Azimuth: position the tilted instrument faces relative to north. Azimuth is 
undefined for a tilt of zero, but by convention it is set to zero.5  

• Precipitable water: site-specific parameters for estimating precipitable water from vapor 
pressure6 (itself estimated from temperature, humidity, and barometric pressure). 
Precipitable water (pw) in centimeters is calculated using vapor pressure (vp), a slope 
coefficient (m), and a intercept offset (b) as: pw = (vp x m + b) / 10. In the configuration, 
use the table below to determine the site-specific slope and intercept values. Depending 
on location, the slope parameter is either taken directly from the Slope (m) column or 
calculated from the M and B columns using M x site elevation + B. The intercept 
parameter is set to the Intercept (b) column in the table.  

  

                                                 
5 This capability has not been tested for recent program revisions. 
6 For more information, see “Estimation of Precipitable Water over the United States for Application to the Division 
of Solar Radiation into its Direct and Diffuse Components” by J.D. Garrison and G.P. Adler in Solar Energy 44 
(1990): 225–241. 
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Table 6-2. Precipitable Water: Slope and Intercept Values for Site-Specific Locations 

Region Slope (m) M B Intercept (b) 

Alaska 1.45   1.0 

U.S. longitude 
 < 95°W 

1.45   2.0 

U.S. longitude > 95°W 
and latitude < 41°N 

Calculated from 
elev., M, and B 

0.0004 1.1 1.0 

U.S. longitude > 95°W 
and latitude > 41°N 

Calculated from 
elev., M, and B 

0.0004 1.1 2.0 

Saudi Arabia Calculated from 
elev., M, and B 

0.0003 1.3 1.0 

 
The precipitable water value is not directly saved or reported by RCC; rather, it is used as an 
input to the AOD calculation. For the AOD estimates, algorithms from the Bird Clear Sky model 
are used to calculate direct normal transmittances for ozone absorption (TO) (using a nominal 
value of 0.33 cm for column ozone), Rayleigh scattering (TR), absorption of uniformly mixed 
gases (TUM), and water vapor absorption (TW). These are combined to obtain a value for 
molecular transmittance (TM) as: 

 TM = TO TR TUM TW 
 
Aerosol transmittance is then calculated as: 

 TA = IN / I0 TM 
 
where IN is the measured direct normal irradiance, and I0 is the extraterrestrial direct normal 
irradiance. Finally, an inversion of Beer’s Law is used to compute broadband AOD τA as: 

 τA = -ln TA/m 
 
where m is the relative air mass. 

When all system parameters have been entered and you want to close the window, click on 
Accept. Click on Cancel if you want to leave all parameters unchanged.  

6.7.4 Test Instruments 
To enter a test instrument in the BORCAL, double-click on the gray field for the serial number 
below Instruments under Test in the BORCAL Configuration window. This action displays the 
Test Instrument Configuration window, which is shown below. 



 

29 

This report is available at no cost from the National Renewable Energy Laboratory (NREL) at www.nrel.gov/publications. 

 
Figure 6-7. BORCAL-SW Test Instrument Configuration window 

 
In the region labeled Instrument, double-click on the field for Serial Number (or Manufacturer or 
Model). This displays the Radiometer Inventory window, which is shown below. Locate the 
desired instrument by either scrolling through the list or by clicking in the box and typing the 
serial number. (See additional information in Section 10 on Database Editing Tools.) 

When typing the serial number, the active selection tracks each keystroke to the first 
instrument with a serial number that matches the typed characters so far. If typing is 
delayed for more than 1 or 2 seconds, the search resets.  
 
When an instrument is found, you can modify the current customer by double-clicking on the 
customer field. To select the instrument for the configuration, click on Select, or double-click on 
the instrument in the list.  
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Figure 6-8. Radiometer Inventory window 

 
If the instrument is not known to the system, you can enter it by clicking on New in the 
Radiometer Inventory window. Fields for which information is mandatory are highlighted in 
yellow. Fields that require selections from other lists (related fields) are highlighted in blue. 

When entering the serial number, manufacturer, or model, you cannot use these characters: /, \, :, 
*, ?, ", <, >, or |. This is because the Windows operating system does not allow these characters 
in file names, and the system creates file names based in part on these fields. 
 
When the desired instrument is selected or entered, click on Select, and continue to enter the 
remaining information in the Test Instrument Configuration window.  

If the RCC system for your site includes the Location Lookup feature, you can right-click on any 
of the fields labeled Location, Channel, Cable, or Signal Box. This allows you to select a 
predetermined configuration from a pop-up menu, and all of these fields will be automatically 
completed. See Section 6.11 on Location Lookup for more information about this. 
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Six check boxes appear on the Test Instrument Configuration window: Tilt, Active, Control, 
Perpetual, IR Correction, Ventilated, and Comments.  

• Click on the Tilt box to designate that the instrument is deployed at the tilt entered in the 
system configuration tilt and azimuth specifications.  

• The Active box is normally checked (and must be checked to include the instrument in 
data acquisition), but it can be unchecked to temporarily exclude the instrument from the 
data acquisition. This may be valuable if an instrument is included in a period of desired 
data acquisition, but it must be removed for other purposes. If the instrument is deleted 
from the configuration, it may not appear in the calibration reports (depending on the 
final data selection). 

• Click on the Control box to configure the instrument as a control instrument. A control 
instrument must have been previously calibrated by the system. 

• Click on the Perpetual box if the instrument is to be included in the next BORCAL. This 
check box, in conjunction with checking that for Perpetual Instrument when creating a 
new BORCAL, allows the instrument’s configuration to carry forward without needing to 
reconfigure it. 

• Click on the Ventilated box if the instrument is installed in a ventilator. This information 
aids in configuration validation and appears in the report to document that the instrument 
was calibrated with a ventilator. 

• Click on the Comments box to enter or read comments about the instrument’s 
configuration. If comments exist, the box will contain a check mark. 

• Click on the IR Correction box to designate and configure the instrument for an ENICR. 
This is explained further below. 

The Case Thermistor and Dome Thermistor check boxes appear on the right side under Cabling. 
Clicking on these boxes indicates that the instrument is equipped with the specified thermistor(s). 
When indicated, the channel and cabling fields become active to configure the connections for 
the thermistors. 

A check box appears under IR Correction to designate and configure the instrument for an 
ENICR. When this box is checked, the fields below it for Rnet, Rnet Uncertainty, and Cal Date 
become active. These values are pulled from the instrument’s record in the Radiometer Inventory 
database table. You may enter new values in these fields, which will replace the generic values 
for the instrument in its Radiometer Inventory record. (See Section 6.6.4 on ENICR generic 
values.) 

The Pyrgeometer field holds the instrument’s identification of the correcting pyrgeometer as 
configured in the instrument’s record in the Instrument Inventory field. If no pyrgeometer has 
been designated for the instrument, or if the specified pyrgeometer is not in the list of configured 
pyrgeometers, a message will appear instructing you to configure or select an instrument. (See 
Section 6.7.7 on Pyrgeometer Configuration.) 
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When all information is complete, click on Accept. By doing this, you: 

• Enter the instrument in the BORCAL configuration. 

• Clear the fields for the next instrument to be configured.  

When all instruments have been entered, click on Done to return to the BORCAL Configuration 
window.  

Note the distinction between Accept and Done: although using either will allow you to enter and 
save the configuration information, Accept clears all fields and allows you to continue with 
another instrument, and Done exits the test instrument configuration. 
 
6.7.5 Cavity 
Configure ACR instruments by double-clicking on the gray field for the serial number under 
Reference Instruments in the BORCAL Configuration window.  

 

 
Figure 6-9. Cavity Configuration window 
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The Cavity Configuration window groups information into three categories: 

• Cavity: identification, traceability, and calibration parameters for the ACR 

• Control unit: identity and internal electrical parameters for the control unit associated 
with the ACR 

• Communications: the GPIB or RS-232 communications settings for the ACR voltmeter 
and automatic control unit (when appropriate). 

Fields may be accessed in a fashion similar to the test instrument configuration wherein 
information in the blue fields is entered by double-clicking on them and selecting an instrument 
from a list, and the yellow fields hold mandatory information. 

When an ACR is specified in the field for Serial Number, the fields on the lower left of the 
Cavity section are filled in using data in the Cavity Inventory data table. Likewise, when a 
control unit is selected, the fields in the lower part of the Control Unit section will be filled in 
using data from the Control Unit Inventory table. These values may be modified if desired, and 
any changes will be reflected in the corresponding inventory record for that instrument. 

The fields for Calibration Waits are described below. (These values must be the same as those 
used when the ACR WRR is determined.) 

• TP-Solar: number of seconds to wait for thermopile stability after the shutter is opened. 
(This field may be set to zero if the ACR is installed with the shutter open, and it is used 
for routine measurements with the shutter open. Under these conditions, the thermopile 
will always be in a stable state prior to the calibration.) 

• TP-Heated: number of seconds to wait for thermopile stability after the shutter is closed 
and the heater circuit is closed 

• TP-Zero: number of seconds to wait for thermopile stability after the heater circuit is 
opened and the shutter is closed 

• Dwell: number of seconds to wait for operational stability after the cavity is returned to 
its measurement state (heater off, shutter open). This field may be set to zero if the period 
of the ASR cycle (scan rate multiplied by the number of measurements) is greater than 
the time required for ACR stability. 

Two other check boxes appear on the window: 

• Uncheck the Active box if you want to temporarily remove the instrument from the 
configuration for data acquisition. This may be valuable if multiple cavities are 
configured and one of them temporarily cannot be operated (e.g., an unwindowed ACR in 
windy conditions). This allows for a quick connect/disconnect without having to 
reconfigure the ACR parameters. (The check box affects the ACR and the control unit). 

• Use the Comments box to enter or read comments about the instrument’s configuration. If 
comments exist, the box will contain a check mark. 
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Up to two ACRs may be configured for a BORCAL event, and each is entered by clicking on the 
gray field for the serial number in the BORCAL Configuration window. Note that the gray box 
moves to the second position after the first ACR is configured. 

When all information is complete, click on Accept. By doing this, you: 

• Enter the instrument in the BORCAL configuration. 

• Clear the fields for the next instrument to be configured.  

When all instruments have been entered, click on Done to return to the BORCAL Configuration 
window.  

6.7.6 Diffuse Radiometer Configuration 
A diffuse reference instrument is configured by double-clicking on the gray field for the serial 
number under Diffuse Serial Number in the Reference Instrument box in the BORCAL 
Configuration window. This presents the Diffuse Reference Configuration window, as shown 
below. 
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Figure 6-10. Diffuse Reference Configuration window 

As described with other instrument configurations, the blue fields are configured by double-
clicking on them and selecting an instrument from a list. 

When an instrument is selected, the system will fill in the responsivity, calibration dates, and 
uncertainty fields using data from the Diffuse Reference Configuration data table. These fields 
may be modified, and any changes will be reflected in the corresponding record in the Diffuse 
Configuration data table. 

Note that when entering the shading disk information, the value in the field for Subtended Angle 
is computed from the disk diameter and arm radius; it cannot be configured by the user. 
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Cabling information and the Location Lookup feature are described in Section 6.7.4 on Test 
Instruments. 

When all information is complete, click on Accept. By doing this, you: 

• Enter the instrument in the BORCAL configuration. 

• Clear the fields for the next instrument to be configured.  

When all instruments have been entered, click on Done to return to the BORCAL Configuration 
window.  

6.7.7 Pyrgeometer Configuration 
Configure a pyrgeometer by double-clicking on the gray field for the serial number under 
Pyrgeometers. This brings up the Pyrgeometer Configuration window, which is shown below. 

 
Figure 6-11. Pyrgeometer Configuration window 
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As described with other instrument configurations, configure the blue fields by double-clicking 
on them and selecting an instrument from those available in the Pyrgeometer Inventory table. 

When an instrument is selected, the system will fill in the coefficients, calibration dates, and 
uncertainty fields using data from the instrument’s record in the Pyrgeometer Inventory table. 
These fields may be modified, and any changes will be written to the instrument’s record in the 
Pyrgeometer Inventory table. 

The location, channel, and cabling information must be completed. 

All available pyrgeometer thermistors must be configured into RCC. 

6.7.8 Data Logger Configuration 
Configure the data logger(s) by clicking on the gray field for the serial number under Data 
Logger. This presents the Data Logger Configuration window, which is shown below. 

 
Figure 6-12. Data Logger Configuration window 
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As described in previous configurations, double-click on the blue fields to select a data logger 
from the Data Logger Inventory table. This brings forward the instrument make, model, and 
calibration date information. Other fields are described below: 

• Unit number: For Relay (RLY) data loggers (with separate DMM), this indicates the unit 
number, which is a number based on the physical wiring of the Relay/DMM to the 
available channels at the calibration facility. Multiple RLY-type loggers are supported, 
and the unit numbers must be sequential starting with zero (the highest unit number must 
be less than the total number of units). Combo loggers (LGR) must be assigned unit 
number zero, and only one LGR-type logger is supported. 

• DMM: The DMM is physically wired to the Relay data logger and should be left blank 
for combo loggers (LGR). 

• Location: physical location of the logger 

• System offsets (volts DC, 2-wire resistance, and 4-wire resistance): maximum offset of 
the instrument for uncertainty calculations 

• Communications 

o DMM: configuration information for the DMM or combo logger 

o Relay: configuration information for the relay unit. (This column of fields will be 
dimmed for combo loggers.) 

6.7.9 ASR Instruments 
Select the ASR instrument in a manner similar to that used for the diffuse configuration by 
double-clicking on the empty field.  

When all information is complete, click on Accept.  

6.7.10 Other Instrument Configurations 
Complete the BORCAL configuration by entering the configuration information for the 
meteorological instruments and GPS (if available). When all required instruments are entered, 
the BORCAL Configuration windows will look similar to the window shown below.  
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Figure 6-13. BORCAL-SW Configuration window 

 
6.7.11 Editing or Removing Instruments 
To edit information for an instrument already entered, double-click on its serial number in the 
BORCAL Configuration window. This brings up the Instrument Configuration window already 
described. Make the necessary changes to the configuration parameters, and close the Instrument 
Configuration window. 

To remove an instrument from the configuration, right-click on its serial number in the 
BORCAL Configuration window; when prompted, confirm its removal. 

6.8 Configuring a New BORCAL-LW 
Use the Session Editor to construct the data acquisition environment (configure the system) so 
that the software is prepared to accept and acquire data from the appropriate instruments. 

Ensure that the BORCAL type is set to LW. 

If you are starting a new BORCAL, select File→New BORCAL from RCC’s main window. 
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Figure 6-14. Selecting a new BORCAL-LW from RCC’s main window 

 
This action brings up the New BORCAL window, which is shown below.  

 
Figure 6-15. New BORCAL-LW Configuration window 

 
You have the option of using a previous BORCAL as a template for the new BORCAL, which 
will save time if that BORCAL was similarly configured. When you check the box for Select a 
BORCAL as a Template, double-click on the field below it, and choose a BORCAL from the 
pop-up list. With this option checked, the fundamental configurations are presented under Copy 
These Configurations. For each option selected, the new BORCAL will contain the final 
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configuration parameters from the indicated template BORCAL. If the box for All Test 
Instruments is checked, all test instrument configurations will be carried forward from the 
template BORCAL. If all boxes are checked, the result will be a copy of the template BORCAL.  
After selecting any desired configurations to copy, click on Create to create a new BORCAL. 
This brings up the BORCAL Configuration window, shown below, which displays a functional 
summary of the configuration. (The figure below shows blank fields indicating no carryover 
configurations.) BORCAL configuration is accomplished by completing the required information 
for all instruments and system parameters. 

 
Figure 6-16. BORCAL-LW Configuration window  
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6.8.1 Steps for BORCAL Configuration 
When configuring a new BORCAL, follow this general outline of steps: 

• Calibration facility designation 

• System configuration 

• Reference pyrgeometers 

• Meteorological instruments (temperature required, others optional) 

• GPS configuration (optional) 

• Test instrument configuration 

• Data logger. 

In most cases, when the database does not have an item (for example, an instrument or 
calibration facility), a new record can be added by clicking on New when viewing the database 
Table Selection window for that item. See Section 10.2 on Database Maintenance for additional 
instructions. 
 
Many fields in the configuration windows are subject to validity checks, which occur when you 
click on Accept on a configuration window. If a field value is out of range, a pop-up window 
displays the name(s) of the field(s) with the invalid value and shows the range of acceptable 
values. You cannot close this window until all fields are within range. 
 
6.8.2 Facility 
Double-click on the field for the Facility Name under Calibration Facility on the configuration 
screen. This brings up a Table Selection list of configured calibration facilities. Select the desired 
facility, and click on Select.  

6.8.3 System Configuration 
To enter the system parameters, double-click on the field for System Configuration. This presents 
the System Configuration window (shown below), which contains several categories of 
parameters. (The figure below shows all fields configured; when starting without a configuration 
template from a previous BORCAL, the fields are filled with zeroes.) 
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Figure 6-17. BORCAL-LW System Configuration window 

 
Each category is described below. (The values in the window are the suggested defaults except 
for the site-specific water vapor values noted below.) 

• Delta thresholds: alarm difference threshold for each real-time quality check. These 
values are the absolute difference between the two listed measurements, determined as 
|M1 – M2|, in the units of the measurement. 

• Analysis rejection 

o Number of standard deviations: number of standard deviations to allow when 
rejecting test instrument data based on residuals of reference irradiance minus 
calculated test irradiance  

o Threshold 1 (Blue), Threshold 2 (Green), and Threshold 3 (Brown): selectable 
threshold limits (in W/m2) for rejecting data based on the delta of two or more 
reference instruments acquiring data simultaneously. 

• Percent error thresholds: alarm ratio threshold parameter for each real-time quality check. 
The value entered is the percent difference between the two listed measurements (TP(x) 
and TP(x-1)), determined as 100 x Test(x) / Test(x-1). The measurements are from 
adjacent data scans of the same instrument’s thermopile (the current scan and the 
previous scan). 

• Clock 

o Reset interval: number of minutes between automatic clock-reset operations. A 
value of zero disables the automatic clock-setting function.  

o Warning threshold: magnitude of a clock correction (in seconds) allowed before 
the operator is warned of the impending correction. (Clock setting can be 
accomplished by either the operator or, if configured, a GPS unit.)  
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o Delta UT1: positive or negative correction (seconds) to be added to Coordinated 
Universal Time to adjust for an irregular earth rotation rate. 

• Solar position algorithm 

o Delta T: difference in seconds between the earth’s rotation time and terrestrial 
time from the observation 

o  Atmospheric refraction: atmospheric refraction in degrees at sunrise and sunset. 

• Miscellaneous 

o Scan rate: scan rate for radiometers under test and meteorological instruments  

o Uncertain decimal precision: number of digits past the decimal point for reporting 
uncertainties. 

• Automatic mode zenith angle: parameters that specify the zenith angle thresholds for 
system start-up and shutdown in automatic mode. 

When all system parameters have been entered and you want to close the window, click on 
Accept. Click on Cancel if you want to leave all parameters unchanged.  

6.8.4 Test Instruments 
To enter a test instrument in the BORCAL, double-click on the gray field for the serial number 
below Instruments under Test in the BORCAL Configuration window. This action displays the 
Test Instrument Configuration window, which is shown below. 
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Figure 6-18. BORCAL-LW Test Instrument Configuration window 

In the region labeled Instrument, double-click on the field for Serial Number (or Manufacturer or 
Model). This displays the Radiometer Inventory selection window, which is shown below. 
Locate the desired instrument by either scrolling through the list or by clicking in the box and 
typing the serial number. (See additional information in Section 10 on Database Editing Tools.) 

When typing the serial number, the active selection tracks each keystroke to the first instrument 
with a serial number that matches the typed characters so far. If typing is delayed for more than 1 
or 2 seconds, the search resets.  
 
When an instrument is found, you may modify the current customer by double-clicking on the 
customer field. To select the instrument for the configuration, click on Select, or double-click on 
the instrument in the list.  



 

46 

This report is available at no cost from the National Renewable Energy Laboratory (NREL) at www.nrel.gov/publications. 

 
Figure 6-19. Radiometer Inventory window 

 
If the instrument is not known to the system, you may enter it by clicking on New in the 
Radiometer Inventory window. Fields for which information is mandatory are highlighted in 
yellow. Fields that require selections from other lists (related fields) are highlighted in blue. 

When entering the serial number, manufacturer, or model, you cannot use these characters: /, \, :, 
*, ?, ", <, >, or |. This is because the Windows operating system does not allow these characters 
in file names, and the system creates file names based in part on these fields. 
 
When the desired instrument is selected or entered, click on Select, and continue to enter the 
remaining information in the Test Instrument Configuration window.  

If the RCC system for your site includes the Location Lookup feature, you can right-click on any 
of the fields for Location, Channel, Cable, or Signal Box. This allows you to select a 
predetermined configuration from a pop-up menu, and all of these fields will be automatically 
completed. See Section 6.11 on Location Lookup for more information about this. 
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Four check boxes appear on the Test Instrument Configuration window: Active, Control, 
Ventilated, and Comments.  

• The Active box is normally checked (and must be checked to include the instrument in 
data acquisition), but it can be unchecked to temporarily exclude the instrument from the 
data acquisition. This may be valuable if an instrument is included in a period of desired 
data acquisition, but it must be removed for other purposes. If the instrument is deleted 
from the configuration, it may not appear in the calibration reports (depending on the 
final data selection). 

• Click on the Control box to configure the instrument as a control instrument. A control 
instrument must have been previously calibrated by the system. 

• Click on the Ventilated box if the instrument is installed in a ventilator. This information 
aids in configuration validation and appears in the report to document that the instrument 
was calibrated with a ventilator. 

• Click on the Comments box to enter or read comments about the instrument’s 
configuration. If comments exist, the box will contain a check mark. 

The Case Temperature and Dome Temperature check boxes appear on the right side under 
Cabling. Clicking on these boxes indicates that the instrument is equipped with the specified 
temperature sensor(s). When indicated, the channel and cabling fields become active to configure 
the connections for the thermistors. 

When all information is complete, click on Accept. By doing this, you: 

• Enter the instrument in the BORCAL configuration. 

• Clear the fields for the next instrument to be configured. 

When all instruments have been entered, click on Done to return to the BORCAL Configuration 
window.  

Note the distinction between Accept and Done: although using either one will allow you to enter 
and save the configuration information, Accept clears all fields and allows you to continue with 
another instrument, and Done exits the test instrument configuration. 
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6.8.5 Reference Pyrgeometer Configuration 
Configure a pyrgeometer by double-clicking on the gray field for the serial number under 
Pyrgeometers. This brings up the Pyrgeometer Configuration window, which is shown below. 

 
Figure 6-20. Pyrgeometer Configuration window 

 
As described with other instrument configurations, configure the blue fields by double-clicking 
on them and selecting an instrument from those available in the Pyrgeometer Inventory table. 

When an instrument is selected, the system will fill in the coefficients, calibration dates, and 
uncertainty fields using data from the instrument’s record in the Pyrgeometer Inventory table. 
These fields may be modified, and any changes will be written to the instrument’s record in the 
Pyrgeometer Inventory table. 

The location, channel, and cabling information must be completed. 
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All available pyrgeometer thermistors must be configured into RCC.  

6.8.6 Data Logger Configuration 
Configure the data logger(s) by clicking on the gray field for the serial number under Data 
Logger. This presents the Data Logger Configuration window, as shown below. 

 
Figure 6-21. Data Logger Configuration window 

 
As described in previous configurations, double-click on the blue fields to select a data logger 
from the Data Logger Inventory table. This brings forward the instrument make, model, and 
calibration date information. Other fields are described below: 

• Unit number: For Relay (RLY) data loggers (with separate DMM), this indicates the unit 
number, which is a number based on the physical wiring of the Relay/DMM to the 
available channels at the calibration facility. Multiple RLY-type loggers are supported, 
and the unit numbers must be sequential starting with zero (the highest unit number must 
be less than the total number of units). Combo loggers (LGR) must be assigned unit 
number zero, and only one LGR-type logger is supported. 
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• DMM: The DMM is physically wired to the Relay data logger and should be left blank 
for combo loggers (LGR). 

• Location: physical location of the logger 

• System offsets (volts DC, two-wire resistance, and four-wire resistance): maximum offset 
of the instrument for uncertainty calculations 

• Communications 

o DMM: configuration information for the DMM or combo logger  

o Relay: configuration information for the relay unit (this column of fields will be 
dimmed for combo loggers). 

6.8.7 Other Instrument Configuration 
Complete the BORCAL configuration by entering the configuration information for the 
meteorological instruments and GPS (if available). When all required instruments are entered, 
the BORCAL Configuration window will look similar to the window below.  
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Figure 6-22. BORCAL-LW Configuration window 

 
6.8.8 Editing or Removing Instruments 
To edit information for an instrument already entered, double-click on its serial number in the 
BORCAL Configuration window. This brings up the Instrument Configuration window already 
described. Make the necessary changes to the configuration parameters, and close the Instrument 
Configuration window. 

To remove an instrument from the configuration, right-click on its serial number in the 
BORCAL Configuration window, and when prompted, confirm its removal. 

6.9 Editing a BORCAL Configuration 
If you want to edit or extend an existing configuration, select Edit→BORCAL/Session from the 
RCC’s main window. This brings up the BORCAL Configuration window, which is accessed 
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and edited as described in the section above. All previously configured instruments will appear 
as entered and can be modified, and additional instruments can be added.  

When the configuration is opened for editing as described here, all instruments will be sorted by 
serial number. This may differ from the order in which they appeared when originally entered. 
 
6.10 Configuration Audit 
Use Configuration Audit to provide a summary of the event configuration. You can print this 
information to serve as a reference for instrument type, channels, and so on.  

The configuration audit is intended as a tool to assist with validating the BORCAL 
configuration. Although some checks are done for completeness during generation of the report, 
the automated checks are not comprehensive. The operators should use this tool to carefully 
validate the entire BORCAL configuration for correct entries. 
 
In the BORCAL Configuration window (LW or SW), select the Report→Configuration Audit 
pulldown menu.  

 
Figure 6-23. Selecting an audit report from the configuration window 

This performs a check of the system configuration. If any improper or missing configuration 
parameters are found, a pop-up message indicates which parameters require correction. When all 
parameters are correct, the audit automatically generates an onscreen display when complete. A 
partial screen report for SW is shown below. 
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Figure 6-24. Sample BORCAL-SW Session Configuration Audit Report 

 
The report contains multiple pages that can be accessed by clicking on Next Page or Previous 
Page. You can print the entire report by clicking on Print. 
 
6.11 Location Lookup 
This feature allows you to quickly enter data on an instrument’s mounting location, hookup, and 
logger channel during the configuration.  

6.11.1 Accessing the Location Lookup Feature 
During configuration, the Location Lookup feature is accessed from the Instrument 
Configuration screen (for all instruments except ACR, data logger, and GPS) by right-clicking 
on any one of these fields:  

• Location 

• Cable 

• Junction Box 

• Channel 
This action presents a two-tiered pop-up menu from which the user can select a mounting 
location that will then fill in all of the above fields with the preconfigured information. 
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The figure below shows a typically configured pop-up menu hierarchy for the Location Lookup 
feature. 

 
Figure 6-25. Location lookup pop-up menu 

 
6.11.2 Configuring the Location Lookup Feature 
The Location Lookup information is stored in a text file located in the BORCAL\CONFIG 
folder. The operator must initially configure the file with information specific to the calibration 
site according to the instructions below. The file is named: 
 

[ssss]_LOCATION_LOOKUP.TXT 
 
where [ssss] is the facility abbreviated name. The file consists of a header record documenting 
the data structure followed by any number of data lines. A vertical bar delimits fields within the 
record, and blank fields are allowed (designated by no characters in the field). The fields (as 
designated in the file header) are described as follows (in order from left to right): 

• Platform: text used for populating the first-tier pop-up menu; a broad grouping of 
locations, such as an instrument table or a tracker 

• Position: text used for populating the second-tier pop-up menu; designates the position of 
the location within the platform 
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• Location: location name. This text is copied directly to the Location field of the 
Instrument Configuration window. 

• TP cable: cable name for the position. This text is copied directly to the thermopile Cable 
field of the Instrument Configuration window. 

• TP jbox: junction box name for the position. This text is copied directly to the thermopile 
Signal Box field of the Instrument Configuration window. 

• TP chan: thermopile channel number for the position. This text is copied directly to the 
thermopile Channel field of the Instrument Configuration window. 

• Case cable: case thermistor cable name for the position. This text is copied directly to the 
thermistor Cable field of the Instrument Configuration window. 

• Case jbox: case thermistor junction box name for the position. This text is copied directly 
to the thermistor Signal Box field of the Instrument Configuration window. 

• Case chan: case thermistor channel number for the position. This text is copied directly to 
the thermistor Channel field of the Instrument Configuration window. 

• Dome cable: dome thermistor cable name for the position. This text is copied directly to 
the thermistor Cable field of the Instrument Configuration window. 

• Dome jbox: dome thermistor junction box name for the position. This text is copied 
directly to the thermistor Signal Box field of the Instrument Configuration window. 

• Dome chan: dome thermistor channel number for the position. This text is copied directly 
to the thermistor Channel field of the Instrument Configuration window. 

When creating this file, group all identical first-tier Platform designations together, and within 
that group, enter the second-tier Position designations in the order they should appear on the pop-
up menu.  

When creating the pop-up menus, the system will group identical adjacent platform designations 
under a single title on the first-tier menu and create second-tier menu items in the order they 
appear within that group in the file. The next first-tier menu item is created when the designation 
changes. No effort is made to sort items in the file; hence, any first-tier item out of order will 
result in additional menu items. 
 
The figure below shows a sample lookup configuration file with the header line and six first-tier 
items, each with multiple second-tier items. 
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Platform|Position|Location|TP cable|TP Jbox|TP chan|case cable|case jbox|case chan|dome 
cable|dome jbox|dome chan 
Tracker 4|T27|T27|T27||146|||||| 
Tracker 4|T28|T28|T28||157|||||| 
Tracker 4|T29|T29|T29||182|||||| 
Tracker 4|T30|T30|T30||187|||||| 
Tracker 4|T31|T31|T31||188|||||| 
Tracker 4|T32|T32|T32||158|||||| 
Tracker 4|T33|T33|T33||167|||||| 
Tracker 4|T34|T34|T34||185|||||| 
Tracker 4|T35|T35|T35||190|||||| 
Tracker 4|T36|T36|T36||191|||||| 
Tracker 5|T5-1 (LW)|T5-1|1||1|1||0|1||2 
Tracker 5|T5-2 (LW)|T5-2|2||5|2||4|2||6 
Tracker 5|T5-3 (LW)|T5-3|3||9|3||8|3||10 
Tracker 6|T6-1 (LW)|T6-1|1||13|1||12|1||14 
Tracker 6|T6-2 (LW)|T6-2|2||17|2||16|2||18 
Tracker 6|T6-3 (LW)|T6-3|3||21|3||20|3||22 
Tracker 7|T7-1 (LW)|T7-1|1||25|1||24|1||26 
Tracker 7|T7-2 (LW)|T7-2|2||29|2||28|2||30 
Tracker 7|T7-3 (LW)|T7-3|3||33|3||32|3||34 
Tracker 8|T8-1 (LW)|T8-1|1||37|1||36|1||38 
Tracker 8|T8-2 (LW)|T8-2|2||41|2||40|2||42 
Tracker 8|T8-3 (LW)|T8-3|3||45|3||44|3||46 
Tracker 9|T9-1 (LW)|T9-1|1||49|1||48|1||50 
Tracker 9|T9-2 (LW)|T9-2|2||53|2||52|2||54 
Tracker 9|T9-3 (LW)|T9-3|3||57|3||56|3||58 

Figure 6-26. Sample lookup configuration file 

 
6.12 Instrument Validation Test 
Use the Instrument Validation Check to verify each instrument’s serial number to confirm that it 
is correctly connected to the system.  

The Instrument Validation Check requires two people: an operator at the computer and an 
assistant at the instrument being checked. These two people should be in easy communication 
with each other. 

The data acquisition system will not run until all the instruments are verified using the 
Instrument Validation Check. When an instrument configuration is modified (for example, by 
adding an instrument or changing an existing instrument), the instrument will be marked as 
unverified and must be re-verified with this procedure. 
 
From RCC’s main window, first select the proper BORCAL type (SW or LW), then select 
Acquisition→System Test, as shown below.  
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Figure 6-27. Selecting a system test from RCC’s main window 

 
The Instrument Validation Check window appears and displays a graph and instrument list, as 
shown below. Units are in millivolts for radiometer thermopiles, the appropriate measurement 
units for meteorological instruments, and degrees Celsius for case and dome thermistors. The 
check boxes at the bottom of the window are enabled automatically based on the type of 
instrument selected.  

 
Figure 6-28. Instrument Validation Check window 
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The following sequence describes the operator and assistant actions to conduct the system test: 

• Assistant: Read the serial number from the tag on the installed instrument, and convey it 
to the operator. 

• Operator: Enable the instrument by selecting its serial number from the onscreen list. 

• Assistant: Shade the instrument dome or window for thermopile tests. For thermistors, 
chill the thermistors by spraying compressed air on the case and dome. Alternative 
thermistor test: The assistant should trace the signal cable and disconnect the appropriate 
cable so that the operator can verify that the data acquisition produces an infinite result or 
measurement error for the channel that was disconnected. 

• Operator: Verify that the onscreen graph reflects the appropriate change.  

The operator and assistant should also verify that the cable, junction box, tilt, ventilation, and 
location are all correct. (Only the shading and response are required for correct connections.) 
When an instrument’s response to the shading is verified (or a reasonable value from the 
meteorological instruments or case thermistors is measured), the operator should click on the 
Valid field. Serial numbers for instruments that have not been verified appear in the list in red; 
after the verification is performed, the serial number color changes to black. 

Instruments with case or dome thermistors appear in the list two or three times: once with their 
serial number and the second or third time with a “-Tc” (for case) or “-Td” (for dome) appended 
to the serial number. When the native serial number is selected, the graph displays the thermopile 
output. When the “-T” version is selected, the graph shows the thermistor output (in degrees 
Celsius). The Verify check box is active only when the thermopile data are selected; check box 
verification for the thermistor is accomplished using the thermistor designation.  

The graphing window allows the operator to scale each axis independently by choosing 
minimum and maximum values (Y axis) or the number of samples to display (X axis). The 
system samples the selected instrument at approximately 1-second intervals. The graph resets 
when another instrument is selected. 

  



 

59 

This report is available at no cost from the National Renewable Energy Laboratory (NREL) at www.nrel.gov/publications. 

7 BORCAL-SW Data Acquisition 
Data acquisition is accomplished by running multiple data acquisition sessions (referred to in this 
manual as a session). This section provides details for running a session. 

7.1 Starting a Session 
From RCC’s main window, select the SW BORCAL type, then select Acquisition→Run Session. 
The software performs an automatic check of the system’s integrity. If a configuration 
discrepancy is found, an alert appears in a pop-up window, and the operator should correct the 
problem. The system will not initiate data acquisition if a configuration discrepancy is found. 

 
Figure 7-1. Starting a BORCAL-SW session from RCC’s main window 

 
If the configuration passes the system integrity check, the Data Acquisition window appears, as 
shown below. 
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Figure 7-2. BORCAL-SW Data Acquisition window 

 
7.1.1 Operator Sign-In 
The operator must sign in by clicking on the input box and selecting the appropriate operator 
name(s) from the list. The name of a new operator may be entered in the system by clicking on 
New on the Operator Selection window. At least one operator must be selected before you can 
continue, and up to three operator names may be selected at one time. 

The RCC operator is a special user name that causes the system to run in a “silenced” mode. In 
silent mode: 

• Audible alarms are disabled. (Visual alarms are not affected.) 

• The computer clock is silently adjusted if the GPS is attached. (There are no out-of-
bounds warnings.) 

• Both the audible and visual prompts for the Operator Logs are disabled. (However, the 
log may be accessed as usual.) 

• An automatic backup will be performed at shutdown. 

The system will not run until at least one operator has signed in. 

7.1.2 Cavity Setup Time 
Enter the ACR setup time(s) in the appropriate field in the lower right portion of the window. 
This time is when the ACR was first set up on the current day. This information is stored with 
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the operator logs. RCC will retain the setup time from one session to another until the program is 
closed. 

7.1.3 Start Data Acquisition 
Click on Begin Session to initiate data acquisition. The following events occur: 

• Device initialization 

• System time check 

• ACR calibration begins and is monitored. 

• ASR instruments take data for approximately 1 minute. 

• The system begins scanning instruments by group. 

The last three events in the list above repeat according to the ACR calibration schedule specified 
in the system configuration. During this time, you can monitor incoming data. 

7.1.3.1 Device Initialization 
All devices attached to the system are initialized prior to data acquisition. During the 
initialization sequences, a status window is posted. If any of the initializations fail, a message is 
displayed on the status window.  

 
Figure 7-3. BORCAL-SW Device Initialization window 

 
If any device shows a Failed status, check all connections and the communications 
configuration. 

The GPS unit model 58533A may need several minutes to initialize. If it shows a Failed status 
and the GPS status indicator light is red, RCC will issue a device initialization command. It may 
take several minutes (less than 10) for the device to respond, during which time the Device 
Initialization window will show a Failed status for the GPS unit. When this occurs, wait several 
minutes until the GPS indicator light turns green before trying to restart data acquisition. If you 
attempt to restart data acquisition before the indicator light turns green, the GPS initialization 
process and wait period restarts. If the light fails to turn green, check all connections and 
configuration settings, power down, and restart the GPS unit. 
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7.1.3.2 System Time Check 
7.1.3.2.1 System Time Check  
Prior to data acquisition, the system attempts to determine the correct time. Depending on the 
configuration, the time will come from either the system operator or from an attached GPS unit.  

The manual time set function does not allow viewing or correcting the date (although this 
information is visible on the RCC’s main window). To avoid entering very large correction 
numbers (that would span days), the operator should use the Windows clock to correct the date if 
necessary. The GPS time-setting function will also check and set the date. 
 
7.1.3.2.2 Manual Time Check 
If no GPS unit is attached, the operator is prompted for a time check with a dialog box as shown 
below. 

 
Figure 7-4. Manual Time Set window 

The operator should compare the displayed time to a known reference time source and determine 
if any correction is required. The correction is not entered as conventional time but rather as an 
offset (in seconds). For example, if the system clock is leading the reference by 3 seconds, a time 
correction of –3 seconds should be entered. Click on Set to correct the time. It is not possible to 
set the clock to an accuracy of less than 1 second (for example, a .5-second correction).  

7.1.3.2.3 Automatic Time Set  
If a GPS unit is attached, the system polls the receiver for the correct time. If a time discrepancy 
is detected, the correction is made automatically without operator intervention (unless the 
correction exceeds the Clock Correction Threshold specified in the system configuration and the 
system is not in automatic mode).  

7.1.3.2.4 Correction Threshold  
If the correction from either the operator or the GPS unit is outside the limits of the Clock 
Correction Threshold (system setup), the operator will be asked to confirm the correction. This 
alerts the operator to a potential existing gross error in time and prevents an erroneous correction 
from being entered. 
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7.1.3.2.5 On-Demand Clock Setting 
The operator can set the clock on demand by accessing the time functions from the Set Time 
pulldown menu. The Automatic and Manual selections work as described above. If no GPS unit 
is configured, the selection for the Automatic time setting is disabled (gray). 

 
Figure 7-5. Setting the clock 

 
7.1.3.2.6 Clock-Setting Interval  
This is the interval for setting the clock (either automatically or manually) set in the system 
configuration Clock Reset Interval parameter. 

7.1.3.3 ACR Calibration  
The ACR self-calibration is initiated by giving the operator the opportunity to override the 
calibration with a previous calibration. Although the ACR calibration should generally be 
allowed to commence automatically, there are times when the automatic sequence should be 
overridden—for instance, when a calibration has just been performed and for some reason the 
session was stopped immediately and restarted). 

Prior to starting the automated calibration sequence, the system posts the following dialog box, 
which allows the operator several seconds to bypass the automatic calibration and select a 
previous calibration.  

 
Figure 7-6. Cavity Calibration Source window 

 
A red countdown bar indicates the amount of time left for the operator to make a selection. Click 
on Automatic Calibration to proceed with the automatic calibration. If the operator does not 
intervene, the automatic calibration will commence within approximately 10 seconds. Clicking 
on the red countdown bar can start or stop its progress. Click on Select Previous Calibration to 
choose from among historical calibrations. If the operator chooses to select a previous 
calibration, the following Calibration Selection window appears. 
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Figure 7-7. Previous Cavity Calibration Selection List window 

 
This list includes all ACR calibrations for the current BORCAL. Highlight the desired 
calibration (or calibrations, if more than one ACR is in use), then click on Select. If more than 
one ACR is in use, both cavities will receive the same options for calibration (either an automatic 
self-calibration or a past calibration). It is not possible to calibrate one and select a past 
calibration for the other. 

By selecting an entry from the list, you will be providing ACR calibration information that was 
not determined by an automatic calibration. If the selected entry is not representative of the 
current state of the ACR, it will cause incorrect reference irradiance readings. Do not use a 
previous calibration as an effort to save time by bypassing the electrical calibration. A previous 
calibration should be used only when you are sure that the selected entry represents the current 
state of the ACR and there is reason to bypass the calibration—for example, when a session was 
stopped (with a terminating calibration) and a new session started immediately.  
 
During the automatic ACR calibration, a status screen appears, as shown below. 
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Figure 7-8. Cavity Calibration window 

 
Fields for the ACR calibration are filled in by the system as the calibration progresses. When the 
calibration process is complete, the full information is displayed for about two seconds, and then 
the window is removed from the screen. All ACR calibration parameters are written to the 
session file. If the operator chooses to use a previous calibration, that information is written to 
the file with the actual date and time that the previous ACR calibration was performed. 
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7.2 Acquiring Data 
When the ACR calibration sequence completes, the active Data Acquisition window appears. 

 
Figure 7-9. Active BORCAL-SW Data Acquisition window 

 
This screen shows several sections: 

• Operator sign-in 

• Meteorological 

• Alarms 

• ASR 

• Scan groups 

• Cavity calibration schedule. 
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7.2.1 Operator Sign-In 
The fields in the Operator Sign-In section are active continuously and can be updated as 
operators change during the course of data acquisition. Up to three operators may be logged in 
and out at one time. To log an operator out, right-click on the name, and a pop-up window will 
appear to allow the user to log out. The system will not allow a log out if only one operator is 
logged in (at least one operator must be logged in at all times). To log in a new operator, double-
click on the next gray field, and select the operator’s name from the list presented.  

The name of a new operator can be added at this point by clicking on New on the Operator Table 
List window that appears when logging in an operator. 
 
7.2.2 Meteorological 
This field displays the meteorological observations and the estimated AOD. This is updated at 
the interval specified in the system configuration Meteorological Scan Rate. 

7.2.3 Alarms 
Alarms, indicated by a button illuminated in on the window and a periodic audible beep, are 
triggered by data acquisition discrepancies for any of the following: 

• Meteorological instruments 

• Reference instruments 

• Standard instruments 

• Test instruments. 

When an alarm is generated, the cause can be investigated by clicking on the red button. A 
window appears that lists all alarm instances and describes the condition that triggered the alarm.  

Based on the information provided, take the appropriate action to correct the condition. When the 
error is corrected, click on Clear to clear the alarm. Click on Reset on the Data Acquisition 
window to clear alarms for all instruments. Clearing an alarm removes all entries from the Alarm 
window and mutes the audible beep. 

All information about alarms described in this section is written to alarm files in the 
BORCAL\DATA_SW\[BORCAL_ID]\ALARMS directory. Formats are the same as those 
shown in the figure in each section, and the files are named according to the following 
convention: 

AAASSS.YYYY-DD 
 
Where 

• SSS is the session number 

• YYYY-DD is the BORCAL identification number 

• AAA is an alarm type designation according to this table. 
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Table 7-1. BORCAL-SW Alarm Type File Name Designations 
Designation Description 

TST Test instruments 

REF Reference instruments 

STD Standard control instruments 

MET Meteorological instruments 

 
The alarm windows are described further below. 

7.2.3.1 Reference Alarms 

 
Figure 7-10. BORCAL-SW Reference Alarms window 

 
The window above shows the time of the alarm, the two instruments and values involved, and 
the test that caused the alarm. 

Reference alarms can be triggered by several tests: 

• Multiple reference: If more than one ACR or more than one diffuse reference instruments 
are deployed, simultaneous readings from each instrument must be within the bounds 
specified in the system configuration. The failure is described with the threshold ratio. 

• Cavity stability: If the ACR stability score exceeds the threshold in the system 
configuration, the ACR will be listed under Instrument 1 (with no value), and the Cavity 
Stability notation will be listed under Instrument 2 with the actual ratio as the Instrument 
2 value. The failure is described with the threshold ratio. 
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7.2.3.2 Test Instrument Alarms 

 
Figure 7-11. BORCAL-SW Test Instrument Alarms window 

 
Test instrument alarms are generated when the ratio between the adjacent responsivity results for 
an instrument differs by a value greater than the threshold set in the system configuration. When 
this occurs, the time of the event is listed along with the serial number of the instrument, its scan 
group and index, and the two readings (current and previous) that triggered the alarm. The failure 
is described with the threshold ratio. 

7.2.3.3 Meteorological Instrument Alarms 
Meteorological instrument alarms are similar to the Test Instrument Alarms described above. 

7.2.3.4 Control Instrument Alarms 

 
Figure 7-12. BORCAL-SW Control Instrument Alarms window 
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Control instrument alarms are generated when the difference in measured irradiance of a control 
instrument and the reference irradiance is greater than the threshold specified in the system 
configuration. When this occurs, Instrument 1 will indicate either the global or direct reference 
and the value, and Instrument 2 will show the control instrument affected (listed as a standard 
control instrument, or STD, with its group, index, and serial number) and its irradiance 
measurement. The failure is described with the threshold ratio. 

Frequent control instrument alarms could indicate that the responsivity of the instrument has 
changed since its designated calibration.  

7.2.4 ASR 
The atmospheric stability is monitored via the ASR display on the Data Acquisition window. 
This sliding indicator shows the current ASR score (color-coded) and the relative position of the 
stability within that score.  

 
Figure 7-13. ASR score indicator 

 
The display is updated at the rate specified for the Stability Interval in the system configuration. 

7.2.5 Scan Groups 
Several options to view data are accessible from the Scan Group section. 

 
Figure 7-14. BORCAL-SW scan groups buttons 

 
Click on the Scan Groups title to display a window that shows a reference list of all groups and 
the types of instruments in each group, as shown below. The group number in this list 
corresponds to the numbers shown on the scan group buttons. 
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Figure 7-15. BORCAL-SW Instrument Types window 

 
7.2.5.1 Scan Buttons  
The scan buttons indicate when an instrument group is being scanned by changing from gray to 
blue. Click on Scan of any instrument group to graph data from that group. A graph appears that 
displays the following information: 

• Instrument responsivity (selectable) 

• Irradiance (selectable) 

• Instrument voltage (millivolts) (selectable) 

• ASR conditions 

• Alarm conditions. 

If the instrument group is configured for ENICR, additional graphs are available: 

• Corrected responsivity, irradiance, and voltage (toggle) 

• Effective Net Infrared Irradiance for the pyrgeometer and instruments with case 
thermistors (selectable) 

• Pyrgeometer and instrument case temperature (selectable) 

• Pyrgeometer and instrument dome temperature (selectable). 

Click on the Scan Groups title to view the list of instrument types in each scan group. A typical 
instrument group plot is shown below.  
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Figure 7-16. BORCAL-SW instrument group plot 

 
The areas of this window are described as follows: 

• The group number and instrument type are displayed in the window title bar. 

• The plot area shows the history of data acquisition for the selected group. Data from the 
entire day will be plotted (see scaling options below) unless the BORCAL configuration 
is modified. In this case, only data since the configuration change will be plotted. If alarm 
conditions were encountered, the data point is marked by an X on the plot in the same 
color as the trace. 

• The instrument key (by trace color) is shown at the right of the window along with the 
most recent data value for each measurement.  

• Select from among the parameters by using the Plot Type selector:  

o Responsivity: shows the current estimated instrument responsivity. (This may 
differ slightly from the final responsivities because of interpolation of the 
reference cavity M factor across the session.)  

o Irradiance: plots the reference instrument data (direct beam and diffuse), the 
calculated global reference irradiance, and the irradiance data from the control 
instruments if any are included in the scan group.  

o Voltage: plots the output voltage for each instrument. If the group is configured 
for ENICR, additional selections will be available. Click on the Corrected check 
box to toggle between the display for the corrected and uncorrected values for 
responsivity and voltage.  

o Effective net infrared: displays the effective net infrared irradiance as measured 
by the pyrgeometer and instrument case temperatures (if so configured).  
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o Case temperature and dome temperature: display the pyrgeometer and instrument 
case and dome temperatures, respectively. 

• Use the controls for Y-Axis Scaling, Start Time, and Samples to Display to scale and 
position the plot. 

• Pause or restart the plot by using the Plot Update control. 

• The ASR score for each data acquisition scan is displayed next to the color at the top of 
the plot.  

• If the instrument is configured for a tilt calibration, the Tilted box in the upper right 
corner is checked. 

• Click on the button in the upper right corner of the plot to toggle between the full view 
(as shown) or a condensed window that shows only the plot. This allows more plots to be 
viewed on the desktop at the same time. 

• Click on the serial number or colored graph key next to the serial number to display a 
responsivity history plot for any instrument in the scan group plot. This plot is similar to 
the plots that appear in the BORCAL reports (see figure below). Dismiss the plot by 
clicking on the X in the upper right corner. 

• Close the graph by using the standard window close button (X in upper right corner of 
window). 

 
Figure 7-17. BORCAL-SW History of Instrument pop-up window 

 
7.2.5.2 Meteorological Data  
Click on MET from among the Scan Group buttons to access a plot similar to the scan group test 
instrument plots. Controls are similar to those described for the scan group, but the Plot Type 
selector chooses parameters from among Temperature, Humidity, Pressure, and Aerosol Optical 
Depth. 
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7.2.5.3 Reference Instruments 
In addition to the irradiance plots described in the Scan Group section, the most recent 
measurements for reference instruments are available from the reference display. Access the 
display by clicking on REF from among the Scan Group buttons. This brings up the window 
shown below. 

 
Figure 7-18. BORCAL-SW Reference Values window 

 
This window shows the following information. (When more than one reference instrument of 
each type is in use, the individual instruments are listed under the appropriate instrument column.  

• Time: time of the most recent measurement by the reference instruments. 

• Direct: direct normal (ACR) reading. (When more than one reference instrument of each 
type is deployed, as shown with the diffuse in the example above, the individual 
instruments are listed under the appropriate instrument column. The average of the two 
instruments is shown in the Reference column.) 

• Diffuse/direct limit (percent): current calculated ratio limit (left) and actual ratio (right). 
The calculated limit is based on the Diffuse/Direct Maximum Limit as specified in the 
system configuration and the current zenith angle. See discussion of Max Diffuse/Direct 
in Section 6.7.3 on System Configuration. 

• Diffuse horizontal: reference diffuse horizontal measurement 

• Global horizontal: calculated global horizontal irradiance using the direct and diffuse 
horizontal reference measurements 

• Diffuse tilt: reference diffuse measurement on a tilt (if configured) 
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• Global horizontal: calculated global irradiance on a tilt using the direct and diffuse tilt 
reference measurements 

• Percent diffuse of global: ratio of diffuse divided by global. 

This information can be helpful when troubleshooting reference alarms. 

7.2.5.4 ASR Data  
Click on ASR from among the Scan Group buttons to monitor the readings from the ASR 
instruments. A sample plot is shown below. 

 
Figure 7-19. ASR Values window 

 
This plot shows the ASR slope and variability readings during 60-second interval. The data in 
each curve has been normalized to the mean of the respective data sets to allow for uniform 
plotting. The dotted lines show a least-squares regression line through the respective data sets. 
The plots display the percent deviation from the mean for each instrument. Plot scaling is 
automatic and may change abruptly during times of rapidly varying atmospheric stability.  

The window also shows the color-coded ASR score at the top. In all cases, the smaller the 
number, the more stable the solar signal. (The color will be white until an ASR score is 
determined at the start of a session.) The following values are listed at the bottom of the window: 

• Maximum variability: greatest variability among all instruments in the ASR group  

• Maximum slope: greatest slope (in W/m2/minute) among all instruments in the ASR 
group. 
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7.2.6 Cavity Calibration Schedule 
This section displays information on the current and scheduled ACR calibration. It includes the 
following:  

• Previous cavity calibration: shows several cavity parameters at the most recent self-
calibration 

• Scheduled calibration: shows the time of the next calibration and the calibration interval 

• Cavity setup time: shows the setup time(s) for the ACR(s) 

• Calibration now: initiates an ACR calibration manually when clicked. 

7.2.7 Session Log 
The operator can make notes at any point during data acquisition by accessing the Session Log. 
By clicking on Session Log, an editing window appears that includes a record of several current 
measurements and allows the operator to enter text. A typical log entry screen is shown below. 

 
Figure 7-20. Operator Session Log window 

 
If configured, the system will prompt the operator for a log entry at regular intervals (set in the 
system configuration). When the specified interval has passed, the Session Log button will blink 
yellow and make a sound to indicate that a log entry should be made. 
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Figure 7-21. BORCAL-SW Data Acquisition window showing the highlighted Session Log button 

 
The interval timer resets when the session log is completed and closed. 

Comments entered by the operator in the Session Log will appear in the Final Report (but not in 
the Customer Reports). Efforts should be made to use correct spelling and grammar and to limit 
topics and phraseology to those consistent with an official distributed document. 
 
7.2.8 Layout 
When an operator has configured a convenient positioning of all plots and displays on the screen, 
the layout can be saved by accessing the Layout pulldown menu.  

 
Figure 7-22. Selecting a layout for data acquisition 

 
Save the layout by choosing Save Layout and giving it a name in the subsequent dialog box. 
Retrieve a layout by choosing Get Layout and selecting the desired layout name from the 
subsequent dialog box. When a layout is retrieved, the configuration of windows and plots on the 
screen is restored to that at the time the layout was saved. If the number of windows has changed 
(for example, because of a differing number of instrument groups from one BORCAL to the 
next), both nonexistent and surplus windows will be ignored. In such cases, the configuration 
should be resaved after the desired layout is configured. 

7.2.9 Quit 
End the data acquisition session by clicking on End Session on the Data Acquisition window. 
Prior to ending the data acquisition, a confirmation message appears as shown below. 
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Figure 7-23. End Session Now? window 

 
Designate the session validity by checking the Valid Session box. End the session by clicking on 
Yes. To continue with uninterrupted data acquisition, click on No. 

By indicating an invalid session, no data are lost. The operator may later change the session 
status by using the session validity editor under the main Edit menu. 
 
If you choose to end the session, the system performs an ACR calibration (and includes the 
option to select a historical calibration, as described in Section 7.1.3.3on ACR Calibration 
above). When the ACR calibration is complete, the Data Acquisition window is removed from 
the screen. 
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8 BORCAL-LW Data Acquisition 
Data acquisition is accomplished by running multiple data acquisition sessions (referred to in this 
manual as a session). This section provides details for running a session. 

8.1 Starting a Session 
From RCC’s main window, select the LW BORCAL type, then select Acquisition→Run Session. 
The software performs an automatic check of the system integrity. If a configuration discrepancy 
is found, an alert appears in a pop-up window, and the operator should correct the problem. The 
system will not initiate data acquisition if a configuration discrepancy is found. 

 
Figure 8-1. Starting a BORCAL-LW session from RCC’s main window 

 
If the configuration passes the system integrity check, the Data Acquisition window appears, as 
shown below. 
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Figure 8-2. BORCAL-LW Data Acquisition window 

 
8.1.1 Start Data Acquisition 
Click on Begin Session to initiate data acquisition. The following events occur: 

• Device initialization 

• System time check 

• The system begins scanning instruments. 

8.1.1.1 Device Initialization  
All devices attached to the system are initialized prior to data acquisition. If any of the 
initializations fail, a message is displayed in an error window.  

 
Figure 8-3. Sample BORCAL-LW device initialization error message 

 
If necessary, check all connections and the communications configuration related to the device. 
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The GPS unit model 58533A may need several minutes to initialize. If it shows a Failed status 
and the GPS status indicator light is red, RCC will issue a device initialization command. It may 
take several minutes (less than 10) for the device to respond, during which time the Device 
Initialization window will show a Failed status for the GPS unit. When this occurs, wait several 
minutes until the GPS indicator light turns green before trying to restart data acquisition. If you 
attempt to restart data acquisition before the indicator light turns green, the GPS initialization 
process and wait period restarts. If the light fails to turn green, check all connections and 
configuration settings, power down, and restart the GPS unit. 
 
8.1.1.2 System Time Check 
8.1.1.2.1 System Time Check  
Prior to data acquisition, the system attempts to determine the correct time. Depending on the 
configuration, the time will come from either the system operator or from an attached GPS unit.  

The manual time set function does not allow viewing or correcting the date (although this 
information is visible on RCC’s main window). To avoid entering very large correction numbers 
(that would span days), the operator should use the Windows clock to correct the date if 
necessary. The GPS time-setting function will also check and set the date. 
 
8.1.1.2.2 Manual Time Check 
If no GPS unit is attached, the operator is prompted for a time check by the dialog box shown 
below. 

 
Figure 8-4. Manual Time Set window 

 
The operator should compare the displayed time to a known reference time source and determine 
if any correction is required. The correction is not entered as conventional time but rather as an 
offset (in seconds). For example, if the system clock is leading the reference by 3 seconds, a time 
correction of –3 seconds should be entered. Click on Set corrects the time. It is not possible to set 
the clock to an accuracy of less than 1 second (for example, a .5-second correction).  
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8.1.1.2.3 Automatic Time Set 
If a GPS unit is attached, the system polls the receiver for the correct time. If a time discrepancy 
is detected, the correction is made automatically without operator intervention (unless the 
correction exceeds the Clock Correction Threshold specified in the system configuration and the 
system is not in automatic mode).  

8.1.1.2.4 Correction Threshold  
If the correction from either the operator or the GPS unit is outside the limits of the Clock 
Correction Threshold (system setup), the operator will be asked to confirm the correction. This 
alerts the operator to a potential existing gross error in time and prevents an erroneous correction 
from being entered. 

8.1.1.2.5 On-Demand Clock Setting  
The operator can set the clock on demand by accessing the time functions from the Set Time 
pulldown menu. The Automatic and Manual selections work as described above. If no GPS unit 
is configured, the selection for Automatic time setting is disabled (gray). 

 
Figure 8-5. Setting the clock  

 
8.1.1.2.6 Clock-Setting Interval  
This is the interval for setting the clock (either automatically or manually) set in the system 
configuration Clock Reset Interval parameter. 
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8.2 Acquiring Data 
The Data Acquisition window is shown below. 

 
Figure 8-6. Active BORCAL-LW Data Acquisition window 

 
This screen shows the following sections: 

• Meteorological 

• Alarms 

• Scan data. 

8.2.1 Meteorological 
This section displays the meteorological observations and the estimated PWV. This is updated at 
the same interval as the test instruments. 

8.2.2 Alarms 
Alarms, indicated by a button illuminated in red on the window and a periodic audible beep, are 
triggered by data acquisition discrepancies for any of the following: 

• Meteorological instruments 

• Reference irradiance 

• Thermistor temperature (reference or test) 

• Thermopile signal (reference or test). 

When an alarm is generated, the cause can be investigated by clicking on the red alarm button. A 
window appears that lists all alarm instances and describes the condition that triggered the alarm.  
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Based on the information provided, take the appropriate action to correct the condition. When the 
error is corrected, click on Clear to clear the alarm. Click on Reset on the Data Acquisition 
window to clear the alarms for all instruments. Clearing an alarm removes all entries from the 
Alarm window and mutes the audible beep. 

All information about alarms described in this section is written to alarm files in the 
BORCAL\DATA_LW\[BORCAL_ID]\ALARMS directory. Formats are the same as those 
shown in the figure in each section, and the files are named according to the following 
convention: 

AAASSS.YYYY-DD 
 
Where 

• SSS is the session number 

• YYYY-DD is the BORCAL identification number 

• AAA is an alarm type designation according to the table below. 
Table 8-1. BORCAL-LW Alarm Type File Name Designations  

Designation Description 

_TP Thermopile signal 

REF Reference irradiance 

THM Thermistor temperature 

MET Meteorological instruments 

 
The alarm windows are described further below. 

8.2.2.1 Reference Alarms 

 
Figure 8-7. BORCAL-LW Reference Alarms window 

 
This window shows the time of the alarm, the two instruments and values involved, and the test 
that caused the alarm. 
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Reference alarms can be triggered by several tests: 

• Multiple reference: If more than one reference pyrgeometer is in use, simultaneous 
readings from each instrument must be within the bounds specified in the system 
configuration. If not, the time of the event is listed along with the serial number of the 
instrument and the two readings that triggered the alarm. The failure is described with the 
threshold ratio. 

• Reference stability: Reference irradiance is measured before and after measuring test 
instruments. If this delta exceeds the threshold in the system configuration, the time of 
the event is listed along with the serial number of the instrument and the difference 
between the two pre and post readings that triggered the alarm. The failure is described 
with the threshold ratio. 

8.2.2.2 Thermopile Alarms 

 
Figure 8-8. BORCAL-LW Thermopile Alarms window 

 
Thermopile alarms (both test and reference) are generated when the ratio between the adjacent 
responsivity results for an instrument differs by a value greater than the threshold set in the 
system configuration. When this occurs, the time of the event is listed along with the serial 
number of the instrument and the two readings (current and previous) that triggered the alarm. 
The failure is described with the threshold ratio. 
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8.2.2.3 Meteorological Instrument Alarms 

 
Figure 8-9. BORCAL-LW Meteorological Alarms window 

 
Meteorological instrument alarms are similar to the Test Instrument Alarms described above. 

8.2.2.4 Thermistor Temperature Alarms 

 
Figure 8-10. BORCAL-LW Thermistor Alarms window 

 
All instrument case and dome temperatures are compared to ambient air temperature. Thermistor 
temperature alarms (both test and reference) are generated when the difference in thermistor 
temperature and air temperature is greater than the threshold specified in the system 
configuration. When this occurs, Instrument 1 will indicate the serial number of the instrument 
and the value, and Instrument 2 will show the air temperature. The failure is described with the 
threshold ratio. 

8.2.3 Scan Data 
Two options to view data are accessible from the Scan Data section.  
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Figure 8-11. BORCAL-LW Scan Data buttons 

 
Click on TST to graph data from all instruments. A graph appears that displays the following 
information: 

• Reference irradiance (selectable) 

• Instrument voltage (millivolts) (selectable) 

• Reference and test instrument case temperature with air temperature (selectable) 

• Reference and test instrument dome temperature with air temperature (selectable) 

• Relative humidity (selectable) 

• Pressure (selectable). 

A typical instrument plot is shown below. (Case temperature is selected.)  

 
Figure 8-12. BORCAL-LW Scan Graph window 

 
Each area of the window is described below: 

• The plot shows the history of data acquisition for the selected group. Data from the entire 
session will be plotted (see scaling options below) unless the session is interrupted. In 
this case, only data during the current session will be plotted.  

• The instrument key (by trace color) is shown at the right of the window.  
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• Select from among the parameters by using the Plot Type selector.  

o Irradiance: plots the reference instrument data  

o Voltage: plots the output voltage for each instrument including the reference  

o Case temperature and dome temperature: display the case and dome temperatures, 
respectively, for all instruments. The air temperature is included for comparison.  

o Humidity and pressure: display the metrological data from those sensors. 

• Use the controls for Y-Axis Scaling, Start Time, and Samples to Display to scale and 
position the plot. 

• Pause or restart the plot using the Plot Update control. 

• Click on the button in the upper right corner of the plot allows the window size to be 
toggled between full view (as shown) or a condensed window showing only the plot. This 
allows more plots to be viewed on the desktop at the same time. 

• Right-click on the items in the legend to change attributes of each curve (such as 
visibility, color, line type). 

• Close the graph by using the standard window close button (X in upper right corner of 
window). 

In addition to the irradiance plots described in the Scan Group section, the most recent 
measurements for reference instruments are available from the reference display. Access the 
display by clicking on REF from among the Scan Group buttons. This brings up the display 
shown below. 

 
Figure 8-13. BORCAL-LW Reference Values window 

 
This shows the following information. (When more than one reference instrument of each type is 
in use, the individual instruments are listed under the appropriate instrument column.) 

• Time of the most recent measurement by the reference instruments 

• Average irradiance of all reference instruments followed by the maximum difference 
observed between any references. Both in W/m2. 
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• Irradiance of the first reference instrument followed by the difference between the pre 
and post scan of that reference. (This is then repeated for any additional references that 
are configured.) Both in W/m2. 

This information can be helpful when troubleshooting reference alarms. 

8.2.4 Quit 
End the data acquisition session by clicking on Quit on the Data Acquisition window. Prior to 
ending the data acquisition, a confirmation message appears, which is shown below. 

 
Figure 8-14. BORCAL-LW Quit Data Acquisition confirmation message 
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9 Data Collection Automatic Start and Shutdown 
RCC version 4.0 supports data collection automatic start-up and shutdown. Because there are 
two BORCAL types (LW and SW) and there is the nighttime requirement for LW, which is 
usually unattended, the preferred RCC data collection mode is automatic; however, manual start-
up (as discussed in previous sections) is still supported. 

The zenith angles at which the LW and SW events begin and finish are configured in the system 
configuration screen of each LW and SW event. These zenith angles are already configured and 
will be copied when the user creates a new event. These values should not be changed unless 
instructed to do so by the BORCAL technical manager or deputy. 

Data collection for the SW and LW events can be started (or stopped) manually; however, under 
all conditions (automatic or manual), the event will stop at the configured zenith angle (typically 
just before sunset for SW and just before sunrise for LW). In addition, if the user attempts to 
manually start a SW or LW event at the wrong zenith angle, the software may immediately 
terminate the data collection. For example, if you start a SW event between sunset and midnight, 
the software will automatically terminate it; and if you start a LW event between sunrise and 
solar noon, the software will automatically terminate it. Also, the software will not allow SW and 
LW to collect data simultaneously (automatic or manual). 

For automatic start-up, the user must enable this feature the first time RCC is launched (or after 
making configuration changes or data processing); it is not enabled by default. This is enabled by 
placing a check mark next to the box for Auto Start Longwave and/or Auto Start Shortwave on 
RCC’s main window. 

 
Figure 9-1. Enabling automatic start on RCC’s main window 

 
The position of the LW/SW mode switch (on the far left) does not matter; the software will 
automatically change it at the appropriate zenith angle. 

It is important to ensure that the automatic start is enabled if you expect the software to 
automatically start data collection; therefore, ensure that it is checked daily or after any of the 
following events take place: 

• RCC is restarted 
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• Computer is restarted

• A user makes any selections in the menu (such as configuration, shade/unshade, database
modifications, exporting, data processing, report generation)

• The software encounters an irrecoverable error during data acquisition (such as a problem
with the data collection hardware)

• The operator did not validate all instruments and sensors during the shade/unshade (also
known as a light/dark) test.

If the user manually stops data collection after it has started automatically, the software will 
restart data collection (if you are still in the valid zenith angle range). Therefore, if you must stop 
data collection, first uncheck the Auto Start Longwave and/or Auto Start Shortwave from the 
main window, then stop the data collection from the Data Acquisition window. 

Conditions under which an automatic start or manual start can occur: 

• Automatic SW launch will occur only from sunrise7 to solar noon

• Automatic LW launch will occur only from sunset7 to midnight

• Manual SW launch is permitted only from midnight to sunset7 (and no data collection is 
currently running)

• Manual LW launch is permitted only from solar noon to sunrise7 (and no data collection 
is currently running). 

For example, based on the conditions above, if SW data collection is not currently running and 
the user needs to launch it after solar noon, they must manually start it first, and then enable the 
Auto Start Shortwave check box after data acquisition has started. If the user were to simply 
enable the check box (without manually starting data acquisition first), the software would wait 
until the next day to automatically launch the SW data acquisition. 

7 The zenith angle for sunrise and sunset are defined in the SW and LW system configuration. 
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10  Database Editing Tools 
Use the tools described in this section to view, change, or add information to the data tables or 
system parameters.  

Some tables contain system-generated information that can be viewed but not edited. In general, 
you can edit only operator-generated information in tables. Event configuration edits must be 
accessed through the BORCAL configuration process.  
 
10.1 Overview 
10.1.1 Field Colors  
The color of a field indicates its status (see Table 10-1). Blue and yellow fields must contain 
information (i.e., they are mandatory fields). White fields contain optional information (i.e., 
information that is not necessary to complete system tasks). 

Table 10-1. Color-Coding as Related to Field Status  

 Mandatory Fields Optional Fields 

Related (may not be edited) Blue  

Nonrelated (editable) Yellow White 

 
Blue fields indicate that the field contents are obtained from values in other system tables 
(related tables); they may not be directly edited.  

Yellow fields indicate that the field contents do not relate to values in other system tables; you 
can directly enter or edit these fields. 

White fields indicate optional information; you can edit these fields. 

10.1.2 Valid Ranges  
Many fields have an error-checking feature to validate the range entries. If you enter a value 
outside of the valid range, the field acquires a red border when you click on Accept. In addition, 
a pop-up menu appears that indicates the acceptable ranges for the field; enter a value within this 
range, and click on Accept.  

10.2 Database Maintenance 
The RCC database holds information about instruments, customers, and the BORCAL 
configuration. In addition, the database contains certain information that is created by the system, 
such as data acquisition records and calibration results. As a general rule, those sections can be 
viewed, but they are not editable by the system operators. 
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All data tables have a field for comments in each record. These allow the operator to enter free-
form text to document any aspect of the BORCAL event or make specific instrument notes. The 
comments from most tables will appear in the Final Report and the Customer Report; hence, 
efforts should be made to use correct spelling and grammar (RCC does not have a spell-checker) 
and limit topics and phraseology to those consistent with an official distributed document. 
 
10.2.1 Editing Overview 
Select Edit→Data Base from the main window. 

 
Figure 10-1. Database maintenance menu selections 

 
From the pull-down menu, select the specific table. The Database Maintenance window for the 
selected table appears. (The available tables in the menu will change depending on what 
BORCAL type is selected [SW or LW]. Only tables that pertain to the BORCAL type will be 
shown.) As an example, the window for the Instrument Type table maintenance is shown below. 
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Figure 10-2. Example Table Maintenance window 

 
The Table Maintenance window shows the table name at the top under the title. The window lists 
all records in a given table, which are accessible by scrolling to locate a record. Click on the 
record entry to display its information. The window contains the following options: 

• Edit 

• New 

• Delete 

• Exit 

• Cancel (Edit and New modes only) 

• Done (Edit and New modes only). 

10.2.1.1 Edit, New, Done, and Cancel  
Select Edit to change one or more values in the displayed fields or New to add a record. When 
either Edit or New is selected, the window appearance changes to allow you to enter new fields 
in a record or edit the existing fields. The color coding of the fields is described below: 

• Yellow fields: type information (such as the instrument’s serial number) directly into the 
field. 

• Blue fields: click on the field to obtain a list of valid entries; select the appropriate item 
for the field from the list. 

• White fields: this is optional. 
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In addition, the Done and Cancel buttons on the window are enabled. Not all fields are editable 
(generally, those generated by the system are not), and in such cases the editing capabilities of 
the field will be locked and will not respond to editing. 

To exit either the Edit or New modes, do one of the following: 

• Select Done to save the information. If all values are acceptable (pass validity checks), 
the system saves the changes and the record appears highlighted on the onscreen list. 

• Select Cancel to exit the Edit mode without saving the information. 

10.2.1.2 Delete  
The Delete function allows you to remove a record from the data table. In cases when a record is 
related to another part of the database, removing a record will be blocked. For example, if you 
attempt to remove an instrument type record that is referred to by one or more records in the 
instrument inventory, the action will not be allowed. This is because all instruments must have 
an Instrument Type designation, and allowing the removal of an in-use instrument type would 
leave some instruments without a value in a mandatory field. 

10.2.2  Data Table Overview 
The following table lists and briefly describes all tables in the RCC database. 

Table 10-2. RCC Database Tables  

Table Name Description 

BORCAL Top-level information about each BORCAL-SW (date, report status, 
meteorological means) 

BORCAL_IR Top-level information about each BORCAL-LW (date, report status) 

CALDAT BORCAL-SW calibration results (responsivities, uncertainties, validity) 

CALDAT_IR BORCAL-LW calibration results (coefficients, uncertainties, validity) 

CAVCFG ACR configuration parameters (WRR numbers, uncertainty, electrical 
characteristics,  

CAV_INV Cavity instrument inventory (calibration parameters and calibration 
dates) 

CON_INV Cavity control unit inventory (operating parameters and calibration 
dates) 

CUSTOMER Customer names and contact information 

DIFCFG Diffuse reference instrument configuration (responsivities, calibration 
dates, shading disk geometry) 

DVM_INV Digital voltmeter inventory 

FACILITY Calibration facility name and geographic and environmental information 

GPSCFG SW GPS configuration parameters (communications parameters) 

GPSCFG_IR LW GPS configuration parameters (communications parameters) 
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Table Name Description 

GPS_INV GPS inventory 

INST_TYPE Instrument type definitions (manufacturer, model, output voltage, and 
RCC deployment type) 

LOGCFG SW data logger configuration parameters (calibration due dates, 
communications parameters) 

LOGCFG_IR LW data logger configuration parameters (calibration due dates, 
communications parameters) 

LOGGER_INV Data logger inventory (type and calibration dates) 

MET_INV Meteorological instrument inventory for temperature, humidity and 
pressure probes (offset and scale parameters) 

OPERATOR SW operator names 

OPERATOR_LOG SW operator log-in information (time and date for log in and log out) 

PYG_CFG Configuration parameters for each reference pyrgeometer included in 
the BORCAL-SW (configuration information, instrument identification 
number, calibration data) 

PYG_CFG_IR Configuration parameters for each reference pyrgeometer included in 
the BORCAL-LW (configuration information, instrument identification 
number, calibration data) 

PYG_INV Inventory of reference pyrgeometers (instrument type, calibration data) 

RAD_INV Radiometer inventory (instrument type, current customer, current valid 
BORCAL for responsivity) 

SESSION SW session information (start and end times, configuration pointers, 
software version stamp) 

SESSION_IR LW session information (start and end times, configuration pointers, 
software version stamp) 

SESS_CONFIG SW configuration parameters for each instrument (deployment, tilt, 
grouping, location, channel/cabling, thermistor parameters) 

SESS_CONFIG_IR LW configuration parameters for each instrument (deployment, tilt, 
grouping, location, channel/cabling, thermistor parameters) 

SYSTEM SW system configuration parameters (error thresholds, scan rates, tilt 
parameters) 

SYSTEM_IR LW system configuration parameters (error thresholds, scan rates, tilt 
parameters) 

 
Each data table is fully described in the following sections. Only fields indicated with a check 
mark (√) are editable. 
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10.2.3 BORCAL-SW Table  

 
Figure 10-3. BORCAL Table Maintenance window 

 



 

98 

This report is available at no cost from the National Renewable Energy Laboratory (NREL) at www.nrel.gov/publications. 

Table 10-3. BORCAL Table Fields 
Field Editable Description 

Select BORCAL  Click on the desired BORCAL, and the remaining fields will 
be filled in from the selected data record. 

BORCAL  BORCAL designation 

Facility  Calibration facility 

Start/End Date  First and last day of data acquisition (determined by all valid 
sessions) 

Comments √ Text comments entered by users (accessed by clicking on 
the check box). A check mark indicates a comment exists. 

Responsivity Generation 
Date/Time 

 Date and time that the responsivities for the BORCAL were 
generated 

Report Generation 
Date/Time 

 Date and time that the full report for the BORCAL was 
generated (It will always be later than the responsivity 
generation time.) 

Report Cover Date  Date entered by the user during report generation 

Temperature, Humidity, 
Pressure, Humidity 

 Mean values of the observations from all valid sessions 

√ Indicates editable field 
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10.2.4 BORCAL-LW Table 

 
Figure 10-4. BORCAL_IR Table Maintenance window 
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Table 10-4. BORCAL_IR Table Fields 

Field Editable Description 

Select BORCAL  Click on the desired BORCAL, and the remaining fields will 
be filled in from the selected data record. 

BORCAL  BORCAL designation 

Facility  Calibration facility 

Start/End Date  First and last day of data acquisition (determined by all valid 
sessions) 

Comments √ Text comments entered by users (accessed by clicking on 
the check box). A check mark indicates a comment exists. 

Responsivity Generation 
Date/Time 

 Date and time that the coefficients for the BORCAL were 
generated. 

Report Generation 
Date/Time 

 Date and time that the full report for the BORCAL was 
generated (It will always be later than the responsivity 
generation time.) 

Report Cover Date  Date entered by the user during report generation 

√ Indicates editable field 
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10.2.5 BORCAL-SW Calibration Data Table  

 
Figure 10-5. CALDAT Table Maintenance window 

 
The figure above shows the data layout for a pyranometer. The layouts for pyrheliometers and 
shaded pyranometers differ slightly. (Some fields or buttons are grayed out, and some labels 
have different text.)  
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Table 10-5. CALDAT Table Fields 

Field Editable Description 

Select Instrument  Click on the desired BORCAL/instrument, and the 
remaining fields will be filled in from the selected data 
record 

BORCAL  BORCAL designation 

Validity √ Calibration validity flag (valid, marginal, invalid) 

ASR Filter  ASR filter designation used when the calibration results 
were calculated 

Use  RCC calibration type: TOT (global), DIR (direct), or DIF 
(diffuse) 

Tilt  Calibration tilt 

Azimuth  Calibration azimuth 

Comments √ Text comments entered by users (accessed by clicking on 
the check box). A check mark indicates a comment exists. 

Corrected  Indicates if the instrument was configured for an ENICR 

Serial Number, 
Manufacturer, Model 

 Instrument serial number, manufacturer, and model 

Responsivity Function 
Coefficients (button 
access) 

 Displays a table of coefficients for the responsivity function 
(plottable—see Responsivity Function Plotting below) 

2-Degree Responsivities 
(button access) 

 Displays a table of the 2-degree responsivity data points 
(plottable—see Responsivity Function Plotting below) 

Latitude-Optimized 
Responsivities (button 
access) 

 Displays table of latitude-optimized responsivities 

Calibration Label Values  Responsivity at 45-degrees, uncorrected responsivity at 45-
degrees (only appears for uncorrected instruments), Rnet 
(the instrument’s response to net IR), and the Rnet 
calibration date 

Uncertainties  All uncertainty values associated with the spline fit, 
responsivity function, and the R at 45 degrees 

Valid Incident Angle 
Ranges 

 Minimum and maximum a.m. and p.m. zenith angles, 
applicable to the fit/function and the R at 45 degrees, as 
well as the range of all data collected 

√ Indicates editable field 
 
The instrument records will not appear in the database until the calibration results have been 
generated. If the calibration results for the instrument are not valid, missing values (‒9900) will 
appear in the fields, and the plots will be blank. 
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RCC will also plot the spline fit or responsivity function overlaid with the two-degree bin data 
points used to derive the function. To access the plot, click either the 2-Degree Responsivities or 
Responsivity Function Coefficients from the Instrument Calibration Data Table Maintenance 
window. This brings up the corresponding tabular data. At the bottom of the table display, click 
on Plot, which will display a plot of the responsivity function and the two-degree bin data points. 
A slider switch appears in the lower right corner to allow you to toggle between the spline fit and 
the responsivity function plots.  

 
Figure 10-6. Spline fit and responsivity function plot 
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10.2.6 BORCAL-LW Calibration Data Table  

 
Figure 10-7. CALDAT_IR Table Maintenance window 
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Table 10-6. CALDAT_IR Table Fields 

Field Editable Description 

Select Instrument  Click on the desired BORCAL/instrument, and the 
remaining fields will be filled in from the selected data 
record 

BORCAL  BORCAL designation 

Validity √ Calibration validity flag (valid, marginal, invalid) 

Comments √ Text comments entered by users (accessed by clicking on 
the check box). A check mark indicates a comment exists. 

Serial Number, 
Manufacturer, Model 

 Instrument serial number, manufacturer, and model 

Calibration Results  All calibration results (when K0 is not forced to zero) 
including: coefficients, mean of residuals, number of data 
points (N), uncertainties (Type A/B, combined, expanded), 
degrees of freedom, and coverage factor 

Calibration Results (K0 = 0)  All calibration results (when K0 is forced to zero) including: 
coefficients, mean of residuals, number of data points (N), 
uncertainties (Type A/B, combined, expanded), degrees of 
freedom, and coverage factor 

√ Indicates editable field 
 
The instrument records will not appear in the database until the calibration results have been 
generated. If the calibration results for the instrument are not valid, missing values (‒9900) will 
appear in fields. 
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10.2.7 Cavity Configuration 

 
Figure 10-8. CAVCFG Table Maintenance window  

 
Only the comments fields are editable in this table. All changes to the configuration are 
accomplished with the Configuration Editor, which is described in Section 6.7.5 on Cavity 
Configuration. 
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10.2.8 Cavity Inventory 

 
Figure 10-9. CAV_INV Table Maintenance window  
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Table 10-7. CAV_INV Table Fields 

Field Editable Description 

Select Instrument  Click on the desired instrument, and the remaining fields will 
be filled in from the selected data record. 

Serial Number, 
Manufacturer, Model 

√ Instrument serial number (see note in the box below), 
manufacturer, and model 

Unwindowed WRR √ WRR reduction factor (This is the WRR or intercomparison 
factor.) 

Windowed WRR √ If the cavity is supplied with a window, the WRR factor is 
determined with the window mounted. If a window is not 
supplied with the cavity, use 1.0 for the correction factor. 

Unwindowed Uncert √ Uncertainty of the unwindowed WRR factor 

Windowed Uncert √ Uncertainty of the windowed WRR factor 

Heater Resistance √ Resistance of the cavity heater 

Heater Lead Resistance √ Resistance of the heater leads 

Mfg Calibration Factor √ Multiplier supplied by the manufacturer for the aperture 
variance 

Default Sensitivity √ Cavity’s nominal sensitivity in mV/mW/cm2 

Cal Date √ Date of calibration or intercomparison 

Cal Due Date √ Date the calibration expires 

Comments √ Text comments entered by users (accessed by clicking on 
the check box). A check mark indicates a comment exists. 

√ Indicates editable field 
 
Changes made to this record are not reflected in the current cavity configuration. Changes made 
using the Session Configuration editor are reflected in both the cavity configuration table and the 
applicable fields in this table. 
 
When entering the serial number, you cannot use these characters: /, \, :, *, ?, ", <, >, or |. This is 
because the Windows operating system does not allow these characters in file names, and the 
system creates file names based in part on these fields. 
 
When changes are made to instrument parameters by editing the Cavity Inventory table using the 
Database Maintenance capabilities, these changes are not reflected in the current BORCAL 
configuration. You must delete the instrument from the configuration and reconfigure it to bring 
in the current values from the Cavity Inventory table—or (and this is highly recommended)—
change the parameters for the instrument by editing the current BORCAL configuration, which 
also updates the Cavity Inventory table. 
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10.2.9 Control Unit Inventory 

 
Figure 10-10. CON_INV Table Maintenance window  
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Table 10-8. CON_INV Table Fields 

Field Editable Description 

Select Instrument  Click on the desired instrument, and the remaining fields will 
be filled in from the selected data record. 

Serial Number, 
Manufacturer, Model 

√ Instrument serial number, manufacturer, and model 

DVM √ Digital voltmeter installed in the control unit 

Current Shunt √ Resistance of the current sensing resistor used in the 
calculation to determine the power dissipated by the cavity 
heater. The Eppley Laboratory normally supplies cavity 
radiometer systems with this resistance specified as a nominal 
value. However, some systems are supplied with a value 
determined by an accurate measurement. Regardless of the 
value specified by the manufacturer, the correct resistance 
value for the RCC system is the exact value used when the 
cavity WRR factor or windowed WRR factor was determined. 

Circuit Resist √ Overall resistance of the cavity heater circuit without the heater 
and heater lead resistances. 

Cal Date √ Date of calibration or intercomparison 

Cal Due Date √ Date the calibration expires 

Comments √ Text comments entered by users (accessed by clicking on 
the check box). A check mark indicates a comment exists. 

√ Indicates editable field 
 
Changes made to this record are not reflected in the current cavity configuration. Changes made 
using the Session Configuration editor are reflected in both the cavity configuration table and the 
applicable fields in this table. 
 
When changes are made to instrument parameters by editing the Control Unit Inventory table 
using the Database Maintenance capabilities, these changes are not reflected in the current 
BORCAL configuration. You must delete the instrument from the configuration and reconfigure 
it to bring in the current values from the Control Unit Inventory table—or (and this is highly 
recommended)—change the parameters for the instrument by editing the current BORCAL 
configuration, which also updates the Control Unit Inventory table. 
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10.2.10 Customer Data Table 

 
Figure 10-11. CUSTOMER Table Maintenance window  
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Table 10-9. CUSTOMER Table Fields 

Field Editable Description 

Select Name  Click on the desired customer, and the remaining fields will 
be filled in from the selected data record. 

Name √ Customer’s full name 

Company √ Company or institute represented by the customer 

Department √ Customer’s department within the company 

Address (1, 2, 3) √ First, second, and third lines (as needed) for the customer’s 
address 

City √ City of address 

State √ State of address 

Zip/postal Code √ Zip code or other postal routing code 

Country √ Country of the address 

Phone √ Customer’s telephone number 

Fax √ Customer’s fax number 

Email Address √ Customer’s email address 

ISO Customer Report √ Customer has selected ISO reports for all instruments 

Comments √ Text comments entered by users (accessed by clicking on 
the check box). A check mark indicates a comment exists. 

√ Indicates editable field 
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10.2.11 Diffuse Configuration Table 

 
Figure 10-12. DIFCFG Table Maintenance window  

 
Only the comments fields are editable in this table. All changes to the configuration are 
accomplished with the Configuration Editor, which is described in Section 6.7.6 on Diffuse 
Radiometer Configuration. 
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10.2.12 Voltmeter Inventory Table 

 
Figure 10-13. DVM_INV Table Maintenance window  

 
Table 10-10. DVM_INV Table Fields 

Field Editable Description 

Select Instrument  Click on the desired instrument, and the remaining fields will 
be filled in from the selected data record. 

Serial Number, 
Manufacturer, Model 

√ Instrument serial number, manufacturer, and model 

Cal Date √ Date of calibration or intercomparison 

Cal Due Date √ Date the calibration expires 

Comments √ Text comments entered by users (accessed by clicking on 
the check box). A check mark indicates a comment exists. 

√ Indicates editable field 
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10.2.13 Calibration Facility Table 

 
Figure 10-14. FACILITY Table Maintenance window  
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Table 10-11. FACILITY Table Fields 

Field Editable Description 

Select Facility  Click on the desired facility, and the remaining fields will be 
filled in from the selected data record. 

Facility Name √ Full name of the selected facility 

Facility Abbreviation √ Short name of the selected facility (See note in the box 
below.) 

Contact √ Contact person at the facility 

Latitude √ Facility latitude (decimal degrees, negative south of the 
equator) 

Longitude √ Facility longitude (decimal degrees, negative west of the 
prime meridian 

Elevation √ Elevation above sea level (meters) 

Average Pressure √ Long-term site average barometric pressure (mBar) 

Average Temperature √ Long-term site average temperature (°C) 

Time Zone √ Time zone of the site (offset in hours between Greenwich 
Meant Time and site, negative west of Greenwich) 

ISO SW Full Report √ SW Full Report will be in ISO format for this facility. 

ISO LW Full Report √ LW Full Report will be in ISO format for this facility. 

Comments √ Text comments entered by users (accessed by clicking on 
the check box). A check mark indicates a comment exists. 

√ Indicates editable field 
 
When entering the facility abbreviation, you cannot use these characters: /, \, :, *, ?, ", <, >, or |. 
This is because the Windows operating system does not allow these characters in file names, and 
the system creates file names based in part on these fields. 
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10.2.14 GPS Configuration Table (BORCAL-SW and BORCAL-LW) 

 
Figure 10-15. GPSCFG Table Maintenance window  

 
There is a GPS Configuration table for both BORCAL-SW and BORCAL-LW; the structures of 
both are identical. 

 
Only the comments fields are editable in this table. All changes to the configuration are 
accomplished with the Configuration Editor, which is described in Section 6.7.10 on Other 
Instrument Configuration for SW and Section 6.8.7 on Other Instrument Configuration for LW. 
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10.2.15 GPS Inventory Table 

 
Figure 10-16. GPS_INV Table Maintenance window  

 
Table 10-12. GPS_INV Table Fields 

Field Editable Description 

Select Instrument  Click on the desired instrument, and the remaining fields will 
be filled in from the selected data record. 

Serial Number, 
Manufacturer, Model 

√ Instrument serial number, manufacturer, and model 

Comments √ Text comments entered by users (accessed by clicking on 
the check box). A check mark indicates a comment exists. 

√ Indicates editable field 
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10.2.16 Instrument Type Table 

 
Figure 10-17. INST_TYPE Table Maintenance window  
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Table 10-13. INST_TYPE Table Fields 

Field Editable Description 

Select Instrument Type  Click on the desired instrument, and the remaining fields will 
be filled in from the selected data record. 

Manufacturer √ Instrument manufacturer (see note in the box below) 

Model √ Instrument model (see note in the box below) 

Description √ Brief description of the instrument 

Max Millivolts √ Maximum output voltage in millivolts. This is used for data 
logger scaling. It should be set so that the output voltage 
will never exceed this value (which will cause data 
acquisition errors), and it should not be set too high and 
force the logger to measure at a scale that is too high 
(causing an increase in measurement uncertainty).  

kOhms (Case Thermistor) √ Maximum resistance of the case thermistor (kΩ) 

kOhms (Dome Thermistor) √ Maximum resistance of the dome thermistor (kΩ) 

Use √ Deployment type (see following table) 

Est. Thermal Offset Error √ (No longer used) Estimate of the thermal offset error without 
the ENICR (W/m2) 

Kr: Case Coefficient  Case coefficient (Kelvin per microvolt) for pyrgeometer 

IR Correctable √ Indicates whether the instrument type is configurable for an 
ENICR (For example, silicon instruments are presumed to 
have no IR offset and are thus not correctable.) 

Generic Rnet √ A generic (default) Rnet for this instrument type to be used 
in the absence of a measured Rneta  

Comments √ Text comments entered by users (accessed by clicking on 
the check box). A check mark indicates a comment exists. 

√ Indicates editable field 
a Changes to this value will not update the corresponding value for instruments in the Radiometer Inventory table. 
 
When entering the manufacturer and model, you cannot use these characters: /, \, :, *, ?, ", <, >, 
or |. This is because the Windows operating system does not allow these characters in file names, 
and the system creates file names based in part on these fields. 
 
Deployment types (for the Use field) are listed below. 
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Table 10-14. Deployment Types  

Use Code Description 

TOT Total (global) pyranometer 

DIR Direct normal (beam) pyrheliometer 

PYG Pyrgeometer 

SHD Test pyranometer mounted under a shading disk (different from diffuse reference 
instruments) 

MCO Manual ACR control unit 

ACO Automatic ACR control unit 

ACM Combo automatic ACR control unit and digital voltmeter 

CAV ACR 

LGR Data logger (combo multimeter and relay system) 

RLY Data logger (Relay only) 

TEM Thermometer 

HUM Hygrometer 

BAR Barometer 

DVM Digital multimeter for cavity or data logger relays 

GPS GPS receiver 
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10.2.17 Logger Configuration Table (BORCAL-SW and BORCAL-LW) 

 
Figure 10-18. LOGCFG Table Maintenance window  

 
There is a Logger Configuration table for both BORCAL-SW and BORCAL-LW, the structure 
of both are identical. 

Only the comments fields are editable in this table. All changes to the configuration are 
accomplished with the Configuration Editor, which is described in Section 6.7.8 on Data Logger 
Configuration for SW and Section 6.8.6 on Data Logger Configuration for LW. 
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10.2.18 Data Logger Inventory Table 

 
Figure 10-19. LOGGER_INV Table Maintenance window  

 
Table 10-15. LOGGER_INV Table Fields 

Field Editable Description 

Select Instrument  Click on the desired instrument, and the remaining fields will 
be filled in from the selected data record. 

Serial Number, 
Manufacturer, Model 

√ Instrument serial number, manufacturer, and model. (See 
note in the box below.) 

Cal Date √ Date of calibration 

Cal Due Date √ Date the calibration expires 

Comments √ Text comments entered by users (accessed by clicking on 
the check box). A check mark indicates a comment exists. 

√ Indicates editable field 
 
When entering the serial number, manufacturer, or model, you cannot use these characters: /, \, :, 
*, ?, ", <, >, or |. This is because the Windows operating system does not allow these characters 
in file names, and the system creates file names based in part on these fields. 
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10.2.19 Met Instrument Inventory Table 

 
Figure 10-20. MET_INV Table Maintenance window  

 
Table 10-16. MET_INV Table Fields 

Field Editable Description 

Select Instrument  Click on the desired instrument, and the remaining fields will 
be filled in from the selected data record. 

Serial Number, 
Manufacturer, Model 

√ Instrument serial number, manufacturer, and model (See 
note in the box below.) 

Offset √ Additive offset to convert to measurement units 

Scale √ Multiplicative factor to convert to measurement units 

Comments √ Text comments entered by users (accessed by clicking on 
the check box). A check mark indicates a comment exists. 

√ Indicates editable field 
 
When entering the serial number, manufacturer, or model, you cannot use these characters: /, \, :, 
*, ?, ", <, >, or |. This is because the Windows operating system does not allow these characters 
in file names, and the system creates file names based in part on these fields. 
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When changes are made to instrument parameters by editing the Meteorological Inventory table 
using the Database Maintenance capabilities, these changes are not reflected in the current 
BORCAL configuration. You must delete the instrument from the configuration and reconfigure 
it to bring in the current values from the Meteorological Inventory table—or (and this is highly 
recommended)—change the parameters for the instrument by editing the BORCAL current 
configuration, which also updates the Meteorological Inventory table. 

10.2.20 Operator Table 

 
Figure 10-21. OPERATORS Table Maintenance window 

 
Table 10-17. OPERATORS Table Fields 

Field Editable Description 

Select Name  Click on the desired name, and the remaining fields will be 
filled in from the selected data record. 

Name √ Operator’s name, first and last (used for operator selection 
lists and also in the reports) 

Comments √ Text comments entered by users (accessed by clicking on 
the check box). A check mark indicates a comment exists. 

√ Indicates editable field 
 
A special RCC operator may be present in the name list. This operator is part of the RCC 
automatic mode configuration and should not be deleted or changed. 
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10.2.21 Operator Log Table 

 
 

Figure 10-22. OPERATOR_LOG Table Maintenance window  

 
Table 10-18. OPERATOR_LOG Table Fields 

Field Editable Description 

Select Log Entry  Log entries are listed by name in this field, but they are 
further identified by the login and logout times shown in the 
window. Select the desired log entry, and the remaining 
fields will be filled in. 

Name  Operator’s name 

BORCAL  BORCAL event identification 

Session  Session when the login occurred 

Login Date/Time  Date and time the operator logged in 

Logout Date/Time  Date and time the operator logged out 

Comments √ Text comments entered by users (accessed by clicking on 
the check box). A check mark indicates a comment exists. 

√ Indicates editable field 
 
  



 

127 

This report is available at no cost from the National Renewable Energy Laboratory (NREL) at www.nrel.gov/publications. 

10.2.22 Reference Pyrgeometer Configuration Table (BORCAL-SW and 
BORCAL-LW) 

 
Figure 10-23. PYGCFG Table Maintenance window8 

 
There is a Reference Pyrgeometer Configuration table for both BORCAL-SW and BORCAL-
LW; the structures of both are identical. 

Only the comments fields are editable in this table. All changes to the configuration are 
accomplished with the Configuration Editor, which is described in Section 6.7.7 on Pyrgeometer 
Configuration for SW and Section 6.8.5 on Reference Pyrgeometer Configuration for LW.  
 

                                                 
8 This table is similar to the Reference Pyrgeometer Inventory Table, and it is used to document the instrument 
parameters used in each BORCAL event. 
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10.2.23 Reference Pyrgeometer Inventory Table 

 

Figure 10-24. PGC_INV Table Maintenance window  

Table 10-19. PYG_INV Table Fields 

Field Editable Description 

Select Instrument  Click on the desired instrument, and the remaining fields will 
be filled in from the selected data record. 

Serial Number, 
Manufacturer, Model 

√ Instrument serial number (see note in the box below), 
manufacturer, and model 

Cal Due Date √ Date the pyrgeometer was calibrated and when it is due for 
recalibration 

Calibration Coefficients √ Calibration coefficients from the blackbody calibration 

Uncertainty (%) √ Uncertainty of the calibration 

Comments √ Text comments entered by users (accessed by clicking on 
the check box). A check mark indicates a comment exists. 

√ Indicates editable field 
 
When entering the serial number, you cannot use these characters: /, \, :, *, ?, ", <, >, or |. This is 
because the Windows operating system does not allow these characters in file names, and the 
system creates file names based in part on these fields. 
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When changes are made to instrument parameters by editing the Pyrgeometer Inventory table 
using the Database Maintenance capabilities, these changes are not reflected in the current 
BORCAL configuration. You must delete the instrument from the configuration and reconfigure 
it to bring in the current values from the Pyrgeometer Inventory table—or (and this is highly 
recommended)—change the parameters for the instrument by editing the current BORCAL 
configuration, which also updates the Pyrgeometer Inventory table. 

10.2.24 Radiometer Inventory Table 

 
Figure 10-25. RAD_INV Table Maintenance window  
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Table 10-20. RAD_INV Table Fields 

Field Editable Description 

Select Instrument  Click on the desired instrument, and the remaining fields will 
be filled in from the selected data record. 

Serial Number, 
Manufacturer, Model 

√ Instrument serial number (see note in the box below), 
manufacturer, and model. 

Factory RS √ Instrument’s responsivity when new as supplied by the 
manufacturer (W/m2/microvolt) 

Temp Sensor Type  Dropdown menu to select the temperature sensor type 
installed in the instrument. Available options are 10K 
Thermistor (2-wire), PT100 (4-wire), and NONE. 

Current BORCAL √ Most recent valid BORCAL in which this instrument was 
included. This field is updated by the system during the 
Responsivity Generation procedure,a but the designated 
BORCAL may be overridden by editing this field. This field 
is used primarily by the system to obtain responsivity values 
for instruments designated as control or ASR. 

AIM Exportable √ Calibration results from this instrument may be exported to 
the AIM database. 

Current Customer √ Name of the instrument’s current customer 

Calib. Due Interval 
(months) 

 Interval at which an instrument will be due for the next 
calibration (used to compute due dates on reports and 
calibration stickers) 

Rnet  Rnet as determined from blackbody characterization 
(defaults to generic from instrument type) 

Uncert (%) √ Uncertainty of the Rnet (When using a generic Rnet, the 
default 20% should be used.) 

Rnet Date √ Date the Rnet was determined (When using a generic Rnet, 
the default 01/01/1970 should be used.) 

Correcting Pyrgeometer √ Instrument identification number of the correcting 
pyrgeometer 

Comments √ Text comments entered by users (accessed by clicking on 
the check box). A check mark indicates a comment exists. 

√ Indicates editable field 
a This field is not automatically updated for control instruments, which are assumed to have stable responsivity 
characteristics. This prevents a bad calibration from causing system operations problems in subsequent BORCALs. 
If a control instrument’s responsivity is determined to have changed significantly, this field can be manually updated 
as required. 
 
When changes are made to instrument parameters by editing the Radiometer Inventory table 
using the Database Maintenance capabilities, these changes are not reflected in the current 
BORCAL configuration. You must delete the instrument from the configuration and reconfigure 
it to bring in the current values from the Radiometer Inventory table—or (and this is highly 
recommended)—change the parameters for the instrument by editing the current BORCAL 
configuration, which also updates the Radiometer Inventory table. 
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When entering the serial number, you cannot use these characters: /, \, :, *, ?, ", <, >, or |. This is 
because the Windows operating system does not allow these characters in file names, and the 
system creates file names based in part on these fields. 
 
10.2.25 Session Configuration Table (BORCAL-SW Only) 

 
Figure 10-26. SESS_CONFIG Table Maintenance window  

 
Only the comments fields are editable in this table. All changes to the configuration are 
accomplished with the Configuration Editor, which is described in Section 6.7 on Configuring a 
new BORCAL-SW. 
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10.2.26 Session Configuration Table (BORCAL-LW Only) 

 
Figure 10-27. SESS_CONFIG_IR Table Maintenance window  

 
Only the comments fields are editable in this table. All changes to the configuration are 
accomplished with the Configuration Editor, which is described in Section 6.8 on Configuring a 
new BORCAL-LW. 
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10.2.27 Session Table (BORCAL-SW Only) 

 
Figure 10-28. SESSION Table Maintenance window  

 
Only the comments and validity fields are editable in this table. All other fields are maintained 
by the system. 
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10.2.28 Session Table (BORCAL-LW Only) 

 
Figure 10-29. SESSION_IR Table Maintenance window  

 
Only the comments and validity fields are editable in this table. All other fields are maintained 
by the system. 
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10.2.29 System Configuration Table (BORCAL-SW Only) 

 
Figure 10-30. SYSTEM Table Maintenance window  

 
Only the comments fields are editable in this table. All changes to the configuration are 
accomplished with the Configuration Editor, which is described in Section 6.7.3 on System 
Configuration. 
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10.2.30 System Configuration Table (BORCAL-LW Only) 

 
Figure 10-31. SYSTEM_IR Table Maintenance window  

 
Only the comments fields are editable in this table. All changes to the configuration are 
accomplished with the Configuration Editor, which is described in Section 6.8.3 on System 
Configuration. 
 
10.2.31 Broad Scope Edits 
Sometimes changing information in one field can affect other tables or data files. In these 
circumstances, the system will make the necessary global changes to maintain the data’s 
integrity. For example, when changing an instrument’s serial number, all references to the 
original serial number within the system will be changed including those within data tables and 
data files. In such cases, the system may ask for bounding information to limit the scope of the 
change—for example, to within the selected BORCALs.  

Use caution when making edits that cause irrecoverable changes. For example, if two 
instruments were erroneously entered with their serial numbers swapped—A labeled as B, and B 
labeled as A—and you renamed A as B, both instruments would then be named B, and there 
would be no way to distinguish between them to properly rename B as A. In this type of 
situation, A should be first renamed to X, then B renamed to A, and finally X renamed to B. 

Edits that require a change beyond the scope of a single field in the database force a backup of 
the affected files. These backups are stored under the BACKUPS folder in individual folders 
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named with the date and time of the edit operation. Although there is no facility for restoring the 
backups, the backups are copies of the original files prior to the edit, and hence the backup files 
can be copied back to their original location as a last resort to reverse unwanted changes. 

When restoring backup files, all files in the backup directory must be restored to ensure data 
integrity. This will restore the system to the state at the time of the backup and will cause the loss 
of any data or changes created since that time. 
 
10.3  Editing Session Validity  
The operator generally designates session validity at the time of data acquisition. However, it is 
often desirable to revise decisions about a session after comparing it to other sessions at the end 
of a BORCAL. Although session validity can be edited directly in the Session Table 
Maintenance window, a special editing utility is provided that allows you to make changes more 
easily.  

To edit session validity, set the BORCAL type (LW or SW), then select Edit→Session Validity 
from RCC’s main window. 

 
Figure 10-32. Selecting a Session Validity from RCC’s main window 
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This brings up the Session Validity window, as shown below. 

 
Figure 10-33. Session Validity window 

 
The sessions are labeled by number and time, and a check mark indicates a valid session. 
Validate or invalidate sessions by clicking in the leftmost column. After making all changes, 
click on Apply. 

10.4 Data Inclusion/Exclusion (BORCAL-SW Only) 
Editing access to individual data points can be accomplished by using the Data 
Inclusion/Exclusion tool. This tool allows you to select subsets of data to be designated as 
unconditionally excluded from the data set during the responsivity calculations. Similarly, 
subsets of data can be designated as unconditionally included in the data set, overriding flagging 
(but not overriding outlier filtering). Specific flags or classes of flags can be unconditionally 
ignored when designating data to be included. This allows the operator to include data that were 
improperly flagged as bad under conditions known to be good. This tool allows either excluding 
all specified data regardless of flags or including data by ignoring specific flags. Data for 
exclusion or inclusion can be specified for any instrument by specific time to a resolution of 30 
seconds. 

From RCC’s main window, set the BORCAL type to SW, and then select Edit→Data 
Inclusion/Exclusion. 
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Figure 10-34. Selecting a Data Inclusion/Exclusion from RCC’s main window 

 
This brings up the Instrument Inclusion/Exclusion editing window. 

 
Figure 10-35. Instrument Inclusion/Exclusion window 

 
In this window, hourly segments of data for all instruments are available for editing. At the top 
right of the window, select the desired day by clicking on Prev Day or Next Day.  

The range of available days is determined by the first and last days of data acquisition, and it 
may include intervening days for which no data were taken. 
 
10.4.1 Flag Designation 
At the right of this window is a section with several colored check boxes corresponding to flags 
applied to the data during data acquisition. This section contains radio buttons for Ignore Flag(s), 
Exclude All Data, and Remove All Filters, as shown in the figure below.  
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Figure 10-36. Available options for data inclusion and exclusion 

 
Each option is described below: 

• Ignore flag(s): presents several colored check boxes that correspond to specific data 
acquisition flags or classes of flags. Selecting this option activates these boxes and allows 
the operator to choose any combination of flags that should be ignored for the designated 
instrument and time. If this option is selected, at least one box must be checked. 

• Exclude all data: unconditionally excludes all data for the designated instrument and time 

• Remove all filters: removes previously selected exclusions or Ignore Flag settings for the 
designated instrument and time. 

Prior to marking any time segments (described below), click on the check boxes for flags that 
should be ignored. (If the time segments are defined first, the selection will be lost when clicking 
on the flag boxes.) 

10.4.2 Designating Individual Hours 
You can click or drag in the matrix to indicate which instruments and for which times an 
inclusion or exclusion is desired. Click on Apply to mark the data; excluded designations will be 
marked in red, and flagged designations will be marked in green.  

10.4.3 Designating Individual Data Points 
Access to individual data points to 30-second resolution is available by double-clicking on an 
hour in the matrix. This brings up the Minute Selection editing window, as shown below. 
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Figure 10-37. Minute Selection window for data inclusion/exclusion 

 
This window allows you to designate a data subset by clicking on or dragging in the matrix by 
using the minutes label on the left and the seconds label on the top to locate the desired time. If 
you mark a box in the :00 column, any data point that falls within the range of :00 to :29 seconds 
for that minute will be affected. If you mark a box in the :30 column, any data point that falls 
within the range of :30 to :59 seconds for that minute will be affected. Prior to making a time 
selection, configure the Flag, Exclude, or Remove section on the right. After designating the 
time, click on Apply. Excluded designations will be marked in red and flagged designations will 
be marked in green on the time matrix. The grid on the right displays each flag designation by 
color, as shown in the figure below. 
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Figure 10-38. Minute Selection window with exclusions applied 

 
Click on Done to carry the designation back to the Instrument Inclusion/Exclusion window. 
Click on Cancel to return without retaining the designations. Any portion of an hour designated 
by a minute selection will be indicated in the Instrument Inclusion/Exclusion window by a 
marked hour. Hours with mixed flag and exclusion designations will be indicated by a yellow 
marker. 

10.4.4 Global Changes 
Broad-brush designations can be made that affect any number of instruments for any continuous 
span of time within the BORCAL. To make global changes, mark instruments by clicking in the 
leftmost column in the Instrument Inclusion/Exclusion Window next to any instruments for 
which the changes apply. (This places a check mark in the column to the left of the instrument’s 
serial number.) Alternatively, you can click on Chk All or Chk None to mark or unmark all 
instruments. After marking all desired instruments, click on Global Change, which brings up the 
Checked Instrument Data In/Exclusion window. 
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Figure 10-39. Checked Instrument Data Inclusion/Exclusion window 

 
This window allows you to select the date and time range of the inclusion/exclusion designation. 
For the starting time, the seconds can be 0 or30; for the ending time, the seconds are can be 29 or 
59. As described above, use the buttons and colored flag check boxes to select whether to include 
or exclude the designated data. When the configuration is complete, click on Done, and the 
designation will be updated on the Instrument Inclusion/Exclusion window. Click on Cancel to 
discard the changes. 

10.4.5 Saving the Changes 
When all designations are complete, exit the Instrument Inclusion/Exclusion window by clicking 
on Save, Save and Exit, or Cancel at the top left of the window. All saved changes will be 
available for viewing or revision the next time the Data Inclusion/Exclusion editor is opened. 
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10.5 Editing the Operator Log (BORCAL-SW Only) 
Changes can be made to the Operator Logs by selecting Edit→Operator Log from RCC’s main 
window when in SW mode. This brings up the Operator Log selection window, as shown below. 

 
Figure 10-40. Selecting previous operator logs for editing 

 
Select the desired BORCAL on the left, then select the desired session on the right. Click on 
Select (or double-click on the session number), which brings up the Operator Session Log 
window. 
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Figure 10-41. Editing previous operator logs 

 
Choose the desired entry by clicking on the corresponding Observation Time in the left column. 
You can use conventional text editing commands to make changes to the comments text. No 
other fields are editable. When edits are complete, click on Done or Cancel. 
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11 Data Imports and Exports 
RCC imports test instrument net IR responsivity (Rnet) values as determined by a blackbody 
calibration. 

RCC provides several export functions for calibration data, including: 

• Raw or filtered reference and test instrument data 

• Meteorological data 

• Instrument responsivities and other characterizations. 

11.1 Test Instrument Rnet Imports (BORCAL-SW Only) 
When instruments are to be configured for an ENICR, to speed the data entry of instrument Rnet 
values and minimize error, RCC can import the Rnet responsivity values produced by a 
blackbody characterization. (This process should be completed prior to the BORCAL-SW 
configuration so that the information is available as each instrument is configured.)  

To access this import function, set the BORCAL type to SW, then select 
File→Import→Instrument RSnet, as shown below. 

 
Figure 11-1. Selecting an Rnet import from RCC’s main window 

 
This brings up a browser that allows you to select the desired file containing the blackbody K1 
values, which are used to compute the Rnet values. The import file must be of the comma-
separated format with data columns in the order shown below: 

• Calibration Date (MM/DD/YYYY) 

• Model and Serial Number in Blackbody format 

• Blackbody K1 Value (W/m2/μV) 

• Uncertainty (U95 %) 

• Correcting Pyrgeometera (Serial Number, Make, Model) in RCC Format 
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a The correcting pyrgeometer field is an optional field that is not provided by the blackbody characterization. The 
user can enter this information using text editor or Excel.  
 
When the import file is selected and the information is analyzed by RCC, the summary table 
shown below is created. 

 
Figure 11-2. Rnet Import Preview window 

 
This table shows the status of the import process as it attempts to match incoming instrument 
identification numbers with instruments known to RCC. If the instrument is not in the RCC 
Instrument Inventory table, the field for Found Instrument ID is blank and the field for Import 
Status displays a Fail message. If the instrument is found, the values for each field are displayed 
in the line for the instrument indicating the values to be imported to the Instrument Inventory 
table. If all information is correct, click on Import to Database, and the values will be written to 
each instrument’s record in the Instrument Inventory table. To compute the Rnet value from K1, 
RCC uses the RS@45 value computed during the last valid BORCAL. If this is a new instrument 
that has never been calibrated using RCC, then it will use the factory RS value entered in the 
instrument inventory table. If the factory RS is unavailable, then a Fail message will be 
displayed for that instrument. (All of the imported values can be entered or modified manually in 
the Instrument Inventory table or during the BORCAL configuration.) 
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11.2 Test Instrument and Meteorological Exports 
From RCC’s main window, select File→Export→Test Instrument or 
File→Export→Meteorological Instrument.9 

 
Figure 11-3. Selecting a test instrument export from RCC’s main window 

 
This brings up the Test Instrument Export or the Meteorological Export window. The two are 
very similar, but the Meteorological Export window does not have all options. (Exceptions are 
noted in the descriptions.) 

                                                 
9 RCC does not support exporting BORCAL-LW at this time. 
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Figure 11-4. Test Instrument Export window 

 
The Test Instrument Export window has the following configuration sections: 

• Field selection 

• Session selection 

• Instrument selection (not available for meteorological exports) 

• Format designation 

• Filtering options (not available for meteorological exports) 

• Output options (not available for meteorological exports). 

11.2.1 Field Selection  
11.2.1.1 Test Instrument Field Selection  
This section allows you to configure the structure of the output record by choosing from among 
15 fields: 

• Date: calendar date of the measurement 

• Time (standard): local standard time of the measurement 

• Time (solar): solar time of the measurement 

• Zenith: solar zenith angle at the time of the measurement 
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• Incident: angle of solar incidence between the sun and plane of the instrument 

• Azimuth: solar azimuth angle 

• Voltage: instrument output voltage 

• Voltage (corrected): ENICR instrument output voltage  

• Responsivity: calculated responsivity for the observation in µV/W/m2 

• Responsivity (corrected): ENICR calculated responsivity for the observation in µV/W/m2 

•  Multiplier: calculated multiplicative calibration factor for the observation (reciprocal of 
the responsivity multiplied by 1,000) in mV/mW/cm2 

• Multiplier (corrected): ENICR calculated multiplicative calibration factor for the 
observation (reciprocal of the responsivity multiplied by 1,000) in mV/mW/cm2 

• Reference direct: reference direct beam measurement  in W/m2 

• Reference diffuse: reference diffuse measurement in W/m2 

• Reference global: calculated global reference in W/m2 

• Effective Net IR: Effective Net Infrared Irradiance based on Pyrgeometer Incoming IR 
(Win) and Instrument’s Wout (if instrument has a case thermistor, otherwise 
Pyrgeometer’s Wout) in W/m2 

• Effective Net IR (Pyrgeometer Wout): - – Effective Net Infrared Irradiance based on 
Pyrgeometer Incoming IR (Win) and Pyrgeometer’s Wout  in W/m2 

• Pyrgeometer thermopile voltage: pyrgeometer’s thermopile voltage 

• Pyrgeometer case temperature (°C) 

• Pyrgeometer dome temperature (°C) 

• Instrument case temperature (°C) 

• Instrument dome temperature (°C) 

• ASR score: ASR score during the measurement 

• Session: data acquisition session number 

• Instrument serial number: serial number of the instrument 

• Pyrgeometer serial number: serial number of the correcting pyrgeometer 

• Instrument Rnet: instrument’s Effective Net Infrared response (determined by blackbody 
system) 

• Pyrgeometer coefficients: K0, K1, K2, K3, and Kr coefficients (each as a separate field). 

Only the specified fields will be output, and the record will be formed from left to right on a 
single line using the specified delimiter (described below). 
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11.2.1.2  Meteorological Instrument Field Selection 
This section allows you to configure the structure of the output record by choosing from among 
eight fields: 

• Date: calendar date of the measurement 

• Time (standard): local standard time of the measurement 

• Time (solar): solar time of the measurement 

• Reference direct: reference direct normal (beam) used for AOD estimation  

• Temperature: temperature (°C) 

• Relative humidity: relative humidity (%) 

• Bar pressure: barometric pressure (mbarr) 

• Broadband AOD: estimated broadband AOD (unitless).  

The number on the left side of the field indicates the order that the field will appear in the output 
record. Each field is configured by clicking on the down arrow on the right side of the field and 
selecting the desired measurement or parameter from the pop-up list.  

 
Figure 11-5. Selecting fields for test instrument export 

 



 

152 

This report is available at no cost from the National Renewable Energy Laboratory (NREL) at www.nrel.gov/publications. 

Any parameter can be placed in any field position. Although the first four fields are 
preconfigured with Date, Standard Time, Incident Angle, and Azimuth Angle, these defaults can 
be overridden by selecting other parameters for those fields. 

Fields designated with (none) will not be included in the output record even if such fields are 
designated between other parameter designations. 

If the box for Flag is checked, a flag field will be output following the parameter value. Not all 
parameters have flags, and if a flag field is specified for such cases, no flag field will be output. 

If the box for Include Field Header is checked, the file will contain a header that defines all 
fields. 

11.2.2 Session Selection 
You can select the sessions from which the data are read by selecting from among the options in 
the Sessions list.  

 
Figure 11-6. Selecting sessions for test instrument export 

 
Select a session by clicking in the leftmost column. A check mark indicates a selected session. 
Clicking on Check All selects all sessions. Selecting Check All Valid selects all valid sessions by 
drawing from the same source as that used for instrument characterizations. (See Section 11.2.5 
on Filtering Options.) 
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11.2.3 Instrument Selection 
You can select the instruments to be included in the output file by selecting from among the 
options in the Instruments list (not available for meteorological exports). 

 
Figure 11-7. Selecting instruments for test instrument export 

 
Select an instrument by clicking in the leftmost column. A check mark indicates a selected 
instrument. Clicking on Check All will select all instruments. If an instrument name in the list 
appears gray, it means that no data are available for the selected session, and the output file will 
not contain any data records. 

11.2.4 Format Designation 
Several options are available for the output file format. These are shown in the upper right corner 
of the window. 

 
Figure 11-8. Selecting output format for test instrument export 
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Options are accessible by clicking on the down arrow on the right side of each field. All options 
are described below. 

• Date format 

o mm/dd/yyyy: month-day-year (slash delimited) 

o dd/mm/yyyy: day-month-year (slash delimited) 

o yyyy/mm/dd: year-month-day (slash delimited) 

o yyyymmdd: year-month-day (no delimiter) 

o mmm/dd/yyyy: month abbreviation-day-year (slash delimited) 

o dd-mmm-yyyy: day-month abbreviation-year (dash delimited). 

• Time format 

o hh:mm:ss: hour-minute-second (colon delimited) 

o hhmmss: hour-minute-second (no delimiter) 

o hh.dddd: decimal hour. 

• Text qualifier (character used to indicate text fields) 

o “: double quote 

o ‘: single quote 

o {none}: no qualifier. 

• Delimiter (character used to separate data fields in the output record) 

o Comma 

o Space 

o Tab 

o Semicolon 

o User defined: If this option is selected, a single character can be entered in the box 
for User Delimiter on the window. This box is dimmed until the option for User 
Defined is selected. 

11.2.5 Filtering Options 
This option allows you to filter data by using either the ASR score or the data flag (not available 
for meteorological exports).  

• Choose the desired ASR designation (blue, green, brown, or red) by clicking on the down 
arrow on the right side of the field and selecting it from the list.  

• The Flag option will filter data according to the data flags. Regardless of the output 
instruments selected, any measurement with an associated abnormal flag will not be 
output. For example, a test instrument measurement that has associated flagged reference 
instrument data will be excluded. 
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Although the data filter that is configurable here is similar to that used for characterizing the 
instrument responsivity, additional steps occur during the responsivity calculations that are not 
duplicated here. Thus, it is not possible to ensure that the exported data set is the same as that 
used for the responsivity calculations. However, the exact data set used for the responsivity 
calculations for each instrument is located in the data folder for the BORCAL within the 
CALDAT folder. Although that data set is not configurable for output fields, it is possible to 
examine those files with a text editor to determine the exact measurements used for the 
responsivity calculations.  

The configuration in the Inclusion/Exclusion section also affects the exported data. However, the 
processes for data exclusion and ignoring a flag are optimized for internal program responsivity 
calculations and may sometimes produce unexpected behavior when exporting data. For 
example, some calculated fields may appear as missing in the export file if necessary fields are 
not available. 
 
11.2.6 Output Options 
You can select naming options for the file output by using the box for Output Options (not 
available for meteorological exports; data are always put in a single file). 

 
Figure 11-9. Output options for naming the file for test instrument export 

 
Use the slider to select from the following two options: 

• Export data into one file: all records are placed in a single file. It is necessary to select 
Instrument Serial Number as an output field to identify the source of the data record. 
When this selection is made, the button at the bottom changes to File Name, allowing you 
to specify the output file name and directory. The file output will grouped by the 
instrument—i.e., all records for an instrument will be in one group followed by the group 
of records for the next instrument, etc. 

• Export data into separate files: data from each instrument will be placed in a separate file. 
Files will be named according to the instrument’s serial number and type. The button for 
Directory allows you to choose the directory for the output file from a conventional 
browsing window. 

11.3 AIM Database and Calibration Sticker Data 
RCC provides two special-purpose formats for exporting calibration data: the AIM database 
format and a file formatted for the LabelRIGHT calibration sticker generation program. These 
output formats are fixed and cannot be modified. Only instruments configured as AIM 
Exportable in the Radiometer Inventory table will be transferred to the AIM database. 
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Access these exports from File→Export→AIM/Calibration Stickers on RCC’s main window (for 
both BORCAL-SW and BORCAL-LW). 

 
Figure 11-10. AIM Database/Calibration Sticker Export window 

 
In this window, the following options are available: 

• Select the desired BORCAL. A window opens with the currently selected BORCAL, but 
another BORCAL can be selected from the pulldown list at the top of the window, and 
the instrument list will be updated. 

• Select the instruments to include in the export (or click on Check All to select all 
instruments). Instruments with gray lettering have been marked as invalid and cannot be 
selected for export. 

• Set the validity filter. This defaults to Marginal, which will include all instruments in the 
export that have not been marked as invalid. If the valid option is chosen, instruments 
with a marginal or invalid designation will be excluded from the export.  

• Select either or both of the output formats for export. 

• Set the file name and output directory. If both formats are selected, they will both have 
the same file name, but they will have different file name extensions. (AIM exports will 
have a .aim.csv extension, and the label format will have a .lbl.txt extension. The default 
directory is the Export folder located within the current BORCAL data folder. 
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For BORCAL-SW, The AIM export also creates special files (one per instrument per export 
type) for use in posting data to the National Renewable Energy Laboratory’s AIM database 
website. These files are sent to a folder created by RCC on the I: drive. This is intended to be a 
mapped network drive wherein the web-accessible files for AIM are stored. The folder is named: 

 I:\<Site>\<Borcal_id>\<Instrument Id>.<Export Code>.txt 
 
Where Site is the site-abbreviated name, Borcal_id is the BORCAL identification number, 
Instrument ID is the instrument’s serial number and type, and Export Code corresponds to the 
type of export, as shown in the table below. 

Table 11-1. BORCAL-SW Export Codes for File Names 

Export Type Export Code 

Two-degree bins 2deg 

Two-degree bins (avg.) 2avg 

Responsivity coefficients coef 

Latitude optimized lato 

 
Click Export to start the export. Click Cancel to exit the window without exporting data. 

If the I: drive is not accessible during an export for the AIM database, a warning message will be 
issued. Although these special files will not be generated, the .aim.csv and or .lbl.txt files will be 
generated in the specified directory. 

11.4 Exporting Responsivity Bin and Coefficients (BORCAL-SW Only) 
Responsivity characterizations for a radiometer can be exported to a formatted text file for 
import to other applications. These are: 

• Two-degree responsivities 

• Two-degree responsivities (interpolated/extrapolated and averaged) 

• Latitude-optimized responsivities 

• Responsivity function coefficients. 

Access these exports from File→Export→Bins/Coefficients on RCC’s main window (BORCAL-
SW only).  
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Figure 11-11. Responsivity Bins/Coefficient Export window 

 
In this window, the following options are available: 

• Select the desired BORCAL. The window opens with the currently selected BORCAL, 
but another BORCAL can be selected from the pulldown list at the top of the window, 
and the instrument list will be updated. 

• Select the instruments to include in the export (or click on Check All to select all 
instruments). Instruments with gray lettering have been marked as invalid and cannot be 
selected for export. 

• Select one or multiple export types. 

• Use the button for Directory to choose the directory from a conventional browsing 
window for the output file. The default directory is the Export folder located within the 
current BORCAL data folder. 



 

159 

This report is available at no cost from the National Renewable Energy Laboratory (NREL) at www.nrel.gov/publications. 

The export files (one per instrument per export type) will all reside in the same folder. The files 
will be named: 

 <Instrument Id>.<Export Code>.txt 
 
Where Instrument ID is the instrument’s serial number and type, and Export Code corresponds to 
the type of export, as shown in the table below. 

Table 11-2. BORCAL-SW Export Codes for File Names 

Export Type Export Code 

Two-degree bins 2deg 

Two-degree bins (avg.) 2avg 

Responsivity coefficients coef 

Latitude optimized lato 

 
Below are sample file names from a PSP pyranometer for the four export types: 

• 29277F3 Eppley PSP.2deg.txt 

• 29277F3 Eppley PSP.2avg.txt 

• 29277F3 Eppley PSP.coef.txt 

• 29277F3 Eppley PSP.lato.txt. 

The file formats are self-documenting in the file header or otherwise explained in the file with 
plain text. Values are expressed in exponential notation, and missing values are flagged with a 
value of -9.90000000e+03.  
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12 Report Generation 
RCC provides the capability to generate several reports for examining output or archiving.  

• Responsivities or coefficients generation (prior to generating reports) 

• Reports 

o Instrument results 

o Full reports 

o Customer reports 

o Calibration certificates 

• Operator log (BORCAL-SW only). 

12.1 Responsivities or Coefficients  
12.1.1 Responsivity Generation (BORCAL-SW Only) 
This function does not generate a report per se, but rather it is fundamental and necessary to the 
data used in other reports. As such, this function must be run before any of the other results 
reports can be generated. As part of the responsivity generation, the system will update the 
Calibration Data table with responsivities (see warning below). Calibration data will have an 
accompanying flag in the data table, which is set according to the rules listed in Table 12-1. 

Table 12-1. Flags for BORCAL-SW Responsivity Generation 

Condition Flag 

The data set does not include at least some measurements in the 
zenith angles that range from 0–30 and 75–90 degrees. 

Marginal 

No data exists (after filtering) Invalid 

 
The instrument calibration record will receive a valid flag unless the conditions shown in Table 
12-1 are met. The operator can override this flag if other conditions are known to exist. 
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Select Generate→Responsivities from RCC’s main window (in SW mode) to access the 
Generate Responsivities window, as shown below. 

 
Figure 12-1. BORCAL-SW Generate Responsivities window 

 
In this window, you can configure the responsivity generation by using the following options: 

• BORCAL: The window opens with the currently selected BORCAL, but this can be 
changed by accessing a BORCAL list by clicking on the down arrow on the right side of 
the BORCAL field at the top of the window. The instrument list will be updated if 
another BORCAL is selected. 

• Instrument selection: The default is all instruments, but you may deselect any instrument 
by clicking in the leftmost column to remove the check mark.  

• ASR filter; This invokes filtering to remove data with ASR scores more severe than that 
selected. For example, selecting Green will remove Brown and Red, but retain both 
Green and Blue because Blue is a less severe designation than Green. 
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Click on Generate to generate the responsivities. Click on Cancel to exit without generating the 
responsivities. 

Warning: When invoking this action, you will destroy any previously generated results for the 
BORCAL. When running the responsivity generation, the system removes any existing 
responsivities for all instruments in the selected BORCAL, and the deleted records cannot be 
reconstructed. Even when an instrument is not selected, data for that instrument will be removed 
from the database and replaced with a record indicating an invalid result. Additionally, if 
comments have previously been added to responsivity records for any instrument, those will be 
removed and replaced with a blank comment field for the newly generated responsivities. 
 
12.1.2 Coefficients Generation (BORCAL-LW Only) 
This function does not generate a report per se, but rather it is fundamental and necessary to the 
data used in other reports. As such, this function must be run before any of the other results 
reports can be generated. As part of the coefficient generation, the system will update the 
Calibration Data table with coefficients (see warning below). Calibration data will have an 
accompanying flag in the data table, set according to the rule listed in Table 12-2. 

Table 12-2. Flags for BORCAL-LW Responsivity Generation 

Condition Flag 

No data exists (after filtering) Invalid 

 
The instrument calibration record will receive a valid flag unless the condition shown in Table 
12-2 is met. The operator can override this flag if other conditions are known to exist. 

Select Generate→Responsivities from RCC’s main window (in LW mode) to access the 
Generate Responsivities window. 

 
Figure 12-2. BORCAL-LW Generate Responsivities window 

In this window, you can configure the coefficient generation by using the following options: 

• BORCAL: The window opens with the currently selected BORCAL, but this can be 
changed by accessing a BORCAL list by clicking on the down arrow on the right side of 
the BORCAL field at the top of the window. The instrument list will be updated if 
another BORCAL is selected. 
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• Multiple reference filter: This invokes filtering to remove data when the difference 
between multiple references exceeds the limit for the color codes as defined in the system 
configuration 

• Preliminary results: This will cause the software to generate the preliminary residual plots 
using previous BORCAL coefficients (or manufacture single responsivity); see Section 
18.2.4 on File Format for more information. No information will be added to the 
calibration database. 

Click on Generate to generate the coefficients. Click on Cancel to exit without generating the 
responsivities. 

Warning: When invoking this action, you will destroy any previously generated results for the 
BORCAL. When running the coefficient generation, the system removes any existing coefficients 
for all instruments in the selected BORCAL, and the deleted records cannot be reconstructed. 
Even when selecting preliminary results, calibration results for that BORCAL will be removed 
from the database. Additionally, if comments have previously been added to coefficient records 
for any instrument, those will be removed and replaced with a blank comments field for the 
newly generated coefficients. 
 
12.2 Reports 
After responsivities have been generated, several methods are available for viewing the results.  

If any changes are made to the BORCAL configuration (for instance, adding or deleting an 
instrument) or additional data are acquired, you must regenerate the responsivities or coefficients 
(as described above). To ensure that the report reflects the current state of the system, report 
generation is blocked until responsivities are generated or regenerated. 
 
12.2.1 Instrument Results 
Two options are available for viewing results for individual instruments by selecting one of the 
following from RCC’s main window:  

• Generate→Report→Instrument Results→by BORCAL  

• Generate→Report→Instrument Results→by Instrument. 
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Figure 12-3. Selecting instrument results from RCC’s main window 

 
12.2.1.1 By BORCAL  
This option allows you to choose from all instruments within a specified BORCAL. See the 
sample window below. 

 
Figure 12-4. Instrument Results by BORCAL window 

 
In this window, click on the desired instrument, and then click on Generate. 
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12.2.1.2 By Instrument  
This option allows you to specify an instrument and then choose from among the results for that 
instrument from all the BORCALs that included it. When using this option, you will first see the 
window shown below. 

 
Figure 12-5. Results by Instrument window 

 
Double-click on the desired instrument. When the instrument is selected, you are presented with 
a list of all BORCALs in which that instrument was included. 
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Figure 12-6. BORCAL Results by Instrument window 

 
Select the desired BORCAL, and then click on Generate. 

12.2.1.3 Instrument Results  
When the instrument results have been generated from either of the above two steps, you are 
presented with previews of the data pages from the standard report for the instrument. Use the 
buttons at the top and bottom of the window to navigate to other pages in the instrument’s report.  

12.2.1.4 BORCAL-SW Only 
On the second page (titled Calibration Results), the plots are color coded to show subsets of data. 
The left plot (responsivity compared to zenith angle) shows the morning and afternoon data in 
different colors. The right plot (responsivity compared to local standard time) shows the data 
from each day in a different color.  

The plot on the right side interactively allows you to select a single data point and obtain date 
and responsivity information. Using the mouse, click near a point of interest, and the cursor will 
snap to the nearest point. You can then read the date, time, and responsivity values for that point 
from the display. For example, in the following plot, the user clicked on a data point near noon 
(the red crosshairs), and the date, time, and responsivity are displayed below the plot. 
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Figure 12-7. Viewing date and time for individual BORCAL-SW responsivities 

 
Due to plot resolution restrictions, the times displayed in the Time field are approximate and 
sometimes inaccurate by up to 3 minutes. However, the responsivity and approximate time 
information together is valuable to help pinpoint a measurement in an exported data file wherein 
the times are exact.  
 
Select other points by using the mouse to click in a different location. Or, by using the keyboard 
up and down arrow keys, you can move the cursor one point at a time across the plot. The arrow 
keys move the cursor along data from a single day (a single color); if you want to examine data 
from a different day, you must use the mouse to click near another data point. 
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12.2.2 Full Reports 
The full report contains all reportable information about a BORCAL including individual 
instrument results, ancillary data, system notes, and operator logs. To generate the full report, 
select Generate→Report→Full Report from RCC’s main window. This brings up the Full 
Report Generation window, as shown below. 

 
Figure 12-8. Full Report Generation window10 

  

                                                 
10 The Longwave Full Report screen includes one additional entry for Longwave Operators. 
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This window allows you to customize the title and other portions of the report. Each configurable 
field is described below: 

• Report main title: first line of the title on the calibration certificates 

• Report subtitle: second line of the title on the calibration certificates 

• Second subtitle: third line of the title on the calibration certificates 

• Manager name: manager or deputy signing under the certificate 

• Technical manager’s contact information: contact information for the technical manager 

• Calibration procedures: document name of the current calibration procedure 

• Report date: date that appears on the front of the report. This defaults to the current date, 
but it may be overwritten if desired. 

• Calibration facility URL: text of the URL that appears on the last line of the ancillary 
data page of the calibration certificate as the last part of the following sentence: For other 
information about the calibration facility, visit: ----- 

• LW operators (BORCAL-LW full report only): names of operators that conducted the 
BORCAL-LW (It does not require an operator login.)  

• Additional notes or comments: text that appears after the boilerplate introductory text on 
the third page of the report (under the introduction). 

When this window appears, all fields except for those for Additional Notes and Comments 
(which are left blank) default to the values used in the previous BORCAL. 

Generate the report by clicking on Generate. This action brings up the print dialog box, which 
allows you to direct the output to a particular printer or other output device, such as an RCC 
certified PDF writer. Unless otherwise required for special purposes, print the report using the 
default values for the printer. 

12.2.3 Customer Reports 
The system will generate reports for individual customers with a subset of data that applies only 
to the selected customer. These customer reports do not include the session audit report, operator 
logs, or instrument notes that apply to other customer’s instruments.  

To help ensure that the customer reports are synchronized with the full report, the customer 
reports cannot be generated until after the full report has been generated. 
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To generate a customer report, select Generate→Report→Customer Report from RCC’s main 
window. This brings up a customer selection list, as shown below. 

 
Figure 12-9. Customer Report window 

 
From this list, select the desired BORCAL (at the top) and customer(s) by clicking in the left 
column. Selected customers are indicated by a check mark. Alternatively, you can click on 
Check All to select all customers. Click on Generate, and a separate report will be generated for 
each customer selected. 

The information in this report configuration (such as report date and certificate titles) is drawn 
from the full report configuration. 
 
As with the full report, you will be presented with a printer dialog box to select the desired 
printer or other output device. 
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12.2.4 Calibration Certificates 
Generate calibration certificates for each instrument in a BORCAL by selecting 
Generate→Report→Calibration Certificates from RCC’s main window. This brings up the 
Instrument Certificates window, shown below. 

 
Figure 12-10. Instrument Certificates window  

 
Select the BORCAL in the top field, and then select desired instruments by clicking in the left 
column beside the instrument name. Selected instruments are indicated by a check mark. 
Alternatively, click Check All to select all instruments. Instruments appearing with gray lettering 
do not have valid results (i.e., they are invalid) and cannot be selected. 

Click on Generate to generate a certificate for all selected instruments. As with the report 
generation functions, you will be presented with a printer dialog box to select the desired printer 
or other output device. 

12.3 Operator Log (BORCAL-SW Only) 
You can view and print the BORCAL operator logs by selecting Generate→Report→Operator 
Log from RCC’s main window (in SW mode). This brings up a window that contains all operator 
log entries for the current BORCAL (use File→Open BORCAL from RCC’s main window if 
another BORCAL is desired). A sample window is shown below.  
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Figure 12-11. Viewing operator logs  

 
Use the scroll bar at the right to navigate through the report. Click on Print in the upper right 
corner to print the report. Close the window by using the conventional Windows close button (X) 
in the upper right corner. 
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13 Viewing Time and Geometry Displays 
Whenever the system is running, the date, time, and solar geometry displays are updated on 
RCC’s main window. These displays can be removed from view or enlarged (excluding the date) 
for the operator’s convenience.  

13.1 Removing or Restoring Displays 
From RCC’s main window, select View→Date/Time or View→Solar Geometry.  

 
Figure 13-1. Changing the visibility of the date/time and solar geometry  

The status of the view is indicated by the check mark next to the menu options. If either option is 
selected, the designated information will toggle between displayed and hidden. 

13.2 Enlarging Displays 
You can create portable, resizable displays for the fields for Time, Zenith, Azimuth, or Tilt 
Incident by double-clicking on the corresponding display on RCC’s main window. This action 
creates a larger window in the middle of the screen that contains the same time or geometry 
information. As shown below, these windows can be resized and moved anywhere on the 
desktop. 

 
Figure 13-2. Enlarged Time and Solar Geometry windows  

Enlarging multiple controls without moving the enlarged versions will cause the windows to 
stack in the middle of the screen, each one hiding the previous window. Under such 
circumstances, you must move the windows to view all of them. 
 
These displays are included in the layout configuration during data acquisition and will appear 
on the screen as they were when the Save Layout command is issued. 
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14 Data Logger Channel Check 
Annual checks of the data logger system must be performed before the calibration season. This 
tests not only the data logger but all cabling used by the system for all instrumentation (with the 
exception of the cavity). Prior to starting the channel check in the software, a technician should 
check that all connections for each instrument are isolated or “open.” This means connecting an 
ohm meter to each instrument connector on the outdoor platform to verify that the high and low 
pins are open, high to shield are open, and low to shield are open. If there are additional pins for 
thermistor channels, then all those combinations should be checked as well.  

After the isolation test is completed, the software-based channel check requires two people: an 
operator at the computer and an assistant at the instrument channel being checked. These two 
people should be in easy communication with each other. 

The channel check consists of placing a short on the high and low pins of each sensor and 
measuring the offset voltage using the lowest data logger range. In addition for channels that 
support resistance, the short is placed on those channels, and the resistance offset is measured.11  

For facilities that have two independent data loggers for BORCAL-SW and BORCAL-LW, the 
data loggers must be checked separately; therefore, it is important to select the BORCAL type 
from the main menu prior to running test.12  

                                                 
11 For new installations (or as required by the BORCAL technical manager), additional source tests may be 
performed by placing a voltage source (such as 5 mV) on each channel and a resistor (such as 10 kΩ or 100 Ω) on 
channels supporting resistance. The source tests are not required to be conducted on an annual basis. 
12 The Channel Check function supports only the RAPDAQ data logger. Obsolete data acquisition systems 
supported by RCC must be checked by using a separate software package. 
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14.1 Performing a Channel Check 
From RCC’s main window, first select the proper BORCAL type (SW or LW), then select 
Acquisition→Channel Check, as shown below.13 

 
Figure 14-1. Selecting a channel check from RCC’s main window  

 
The System Test window appears and requires the user to configure the data logger. The channel 
check is independent of the BORCAL configuration (and for new facilities, it is run before any 
BORCAL event is configured); therefore, the user must configure each time the Channel Check 
is launched. 

                                                 
13 For facilities that share the same data logger for both BORCAL-SW and BORCAL-LW, the BORCAL type 
switch position does not matter. 
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Figure 14-2. BORCAL Channel Verification window  

 
First select the number of RAPDAQ systems that are attached to the system. If the facility has a 
dedicated RAPDAQ system for BORCAL-LW and BORCAL-SW, then they are tested 
separately; therefore, enter ONLY the RAPDAQ for the particular dedicated system being tested. 
Then enter the GPIB addresses for each device and the associated GPIB board numbers. 
Typically for SW RAPDAQ systems, the default addresses are correct. For BORCAL-LW 
dedicated systems, the user will need to change the default GPIB addresses appropriately. 

After the RAPDAQ has been configured, click on Init. If there are any errors, double check the 
data logger configuration. After initialization is successful, click on Start Graph. 

The following sequence describes the operator and assistant actions to conduct the system test: 
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• Assistant: Place a shorting plug on the first position or location that is associated with the 
RAPDAQ being tested. (The shorting plug should short the pins associated with the both 
the voltage and resistance measurements if the position supports voltage and resistance 
using the same connector [facility dependent]. Also, if the facility supports four-wire 
resistance, a special shorting fixture may be required to properly short all four pins.) 

• Operator: Based on the hardware infrastructure at the facility, the operator will look up 
the voltage channel number associated with the position. Enter that channel number into 
the Channel box, and view the real-time data on the upper plot (labeled Current 
Channel), or view the current reading listed as Current Reading. (The scaling of the 
upper plot may be maxed out if the channel was over-ranged, which can be caused by 
reading a previous channel that was open or because the assistant did not have a short 
plug properly connected. To reset the range (and plot), the operator must click on Reset 
Graph. After 5–10 good data points appear on the upper plot, click on Plot Channel to 
accept the data and plot the resulting average, minimum, and maximum to the appropriate 
lower plot labeled Results by Channel. If bad data has been plotted, simply acquire new 
data, and click on Plot Channel again to replace it.)  

Depending on the facility infrastructure, a second test may be required on the same position that 
is being shorted by the assistant. There are two typical possibilities (facility dependent): (1) that 
position has a resistance channel assigned to it (a different channel) (Case A), or (2) that position 
also supports resistance on the same channel (Case B). 

For Case A, the operator will change the value in the field for Current Channel to the resistance 
channel associated with the same position, and the upper plot will plot the resistance in ohms. 
When sufficient data is obtained, plot the channel using the method described above. 

For Case B, the operator will change the Test Type switch from Voltage to Resistance (the 
channel remains the same). When sufficient data is obtained, plot the channel using the method 
described above.  

After all tests are complete for the first position, the operator will tell the assistant to move the 
shorting plug to the next position, and the operator will repeat the measurements for this 
position. This process continues for all positions. 

When all positions have been checked, the operator will save the data to disk by clicking on 
Save. The data should be stored in the appropriate subfolder with file name located in the 
SystemCheck folder contained in the main BORCAL folder. 

If the operator wants to, they can save data at any time, restart the software at a later time, and 
reload previous data by clicking on Read and selecting the previous file that was saved to disk. 
The results from the channel check (the saved data file) should be given to the BORCAL 
technical manager so that data logger offsets (for all measurement types) can be computed. This 
information is required for the BORCAL system configuration and is considered in the 
uncertainty of the calibrations.14  

                                                 
14 In a future release of RCC, the data logger offsets may be computed automatically. 
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14.2 Configuring the Channel Check 
For new facilities (or new data acquisition systems), the function(s) of each channel must be 
assigned in a text file located in the BORCAL\CONFIG folder. 

The operator must initially configure the file with information specific to the calibration site 
according to the instructions below. The files are named:  

• logger_define.SW.txt 

• logger_define.LW.txt 

There are two files: one for the SW data acquisition and one for the LW data acquisition. If the 
facility shares the same data acquisition for BORCAL-SW and BORCAL-LW, then simply 
create one file first AND copy and paste/rename it as the other file so that the file contents are 
identical. 

The first line defines the names of the two tests available at the facility. For example, for Case B 
described above, the first line might read: 

• Channel Voltage Resistance 

For Case A, the first line might read (however, the source test type may never be used): 

• Channel Source Short 

On each line thereafter, you will list the following information for each channel in one line 
(separated by tabs): 

• Channel number 

• Measurement type for the first test (VDC, RES, or RES4) 

• Measurement range for the first test (in V for VDC and in kilo-ohms for RES or RES4). 
For voltage, pick the lowest range supported by the data logger. For resistance, pick the 
lowest range that will not over-range the data logger. 

• Measurement type for the second test (VDC, RES, or RES4) 

• Measurement range for the second test (in V for VDC and in kilo-ohms for RES or 
RES4). For voltage, pick the lowest range supported by the data logger. For resistance, 
pick the lowest range that will not over-range the data logger. 



 

179 

This report is available at no cost from the National Renewable Energy Laboratory (NREL) at www.nrel.gov/publications. 

The figure below shows a sample lookup configuration file for a facility that has infrastructure 
that supports two measurement types (voltage and resistance) for each channel (Case B). 

 
Channel Voltage Resistance 
0 VDC 0.001 RES 0.01 
1 VDC 0.001 RES 0.01 
2 VDC 0.001 RES4 0.001 
3 VDC 0.001 RES4 0.001 
4 VDC 0.001 RES 0.01 
5 VDC 0.001 RES 0.01 
6 VDC 0.001 RES4 0.001 
7 VDC 0.001 RES4 0.001 
8 VDC 0.001 RES 0.01 
9 VDC 0.001 RES 0.01 
10 VDC 0.001 RES4 0.001 
11 VDC 0.001 RES4 0.001 
12 VDC 0.001 RES 0.01 
13 VDC 0.001 RES 0.01 
14 VDC 0.001 RES4 0.001 
15 VDC 0.001 RES4 0.001 
16 VDC 0.001 RES 0.01 
17 VDC 0.001 RES 0.01 
18 VDC 0.001 RES4 0.001 
19 VDC 0.001 RES4 0.001 
20 VDC 0.001 RES 0.01 
21 VDC 0.001 RES 0.01 
22 VDC 0.001 RES4 0.001 
23 VDC 0.001 RES4 0.001 
24 VDC 0.001 RES 0.01 
25 VDC 0.001 RES 0.01 
26 VDC 0.001 RES4 0.001 
27 VDC 0.001 RES4 0.001 
 

Figure 14-3. Example channel check configuration file (Case B)  
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The figure below shows a sample lookup configuration file for a facility that has infrastructure 
that supports only one measurement type on each channel (voltage or resistance). In this case, the 
user can assign an optional second test using a different range for a source test (Case A). 

 
Channel Source Short 
0 VDC 0.01 VDC 0.001 
1 VDC 0.01 VDC 0.001 
2 VDC 0.01 VDC 0.001 
3 VDC 0.01 VDC 0.001 
4 VDC 0.01 VDC 0.001 
5 VDC 0.01 VDC 0.001 
6 VDC 0.01 VDC 0.001 
7 VDC 0.01 VDC 0.001 
8 VDC 0.01 VDC 0.001 
9 VDC 0.01 VDC 0.001 
10 VDC 0.01 VDC 0.001 
11 VDC 0.01 VDC 0.001 
12 VDC 0.01 VDC 0.001 
13 VDC 0.01 VDC 0.001 
14 VDC 0.01 VDC 0.001 
15 VDC 0.01 VDC 0.001 
16 VDC 0.01 VDC 0.001 
17 VDC 0.01 VDC 0.001 
18 VDC 0.01 VDC 0.001 
19 VDC 0.01 VDC 0.001 
20 VDC 0.01 VDC 0.001 
21 VDC 0.01 VDC 0.001 
22 VDC 0.01 VDC 0.001 
23 VDC 0.01 VDC 0.001 
24 VDC 0.01 VDC 0.001 
25 VDC 0.01 VDC 0.001 
26 VDC 0.01 VDC 0.001 
27 VDC 0.01 VDC 0.001 
28 VDC 0.01 VDC 0.001 
29 VDC 0.01 VDC 0.001 
30 VDC 0.01 VDC 0.001 
31 VDC 0.01 VDC 0.001 
32 VDC 0.01 VDC 0.001 
33 VDC 0.01 VDC 0.001 
34 VDC 0.01 VDC 0.001 
35 VDC 0.01 VDC 0.001 
36 VDC 0.01 VDC 0.001 
37 VDC 0.01 VDC 0.001 
38 VDC 0.01 VDC 0.001 
39 VDC 0.01 VDC 0.001 
40 VDC 0.01 VDC 0.001 
41 VDC 0.01 VDC 0.001 
42 RES 10 RES 0.01 
43 RES 10 RES 0.01 
44 RES 10 RES 0.01 
45 VDC 0.01 VDC 0.001 
46 VDC 0.01 VDC 0.001 
47 VDC 0.01 VDC 0.001 
48 VDC 0.01 VDC 0.001 
49 VDC 0.01 VDC 0.001 
50 VDC 0.01 VDC 0.001 
51 VDC 0.01 VDC 0.001 
52 VDC 0.01 VDC 0.001 
53 VDC 0.01 VDC 0.001 
54 RES 10 RES 0.01 
55 RES 10 RES 0.01 
56 RES 10 RES 0.01 
57 VDC 0.01 VDC 0.001 
58 VDC 0.01 VDC 0.001 
 

Figure 14-4. Example channel check configuration file (Case A) 
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15 RCC Help 
Two items exist under the Help menu: 

• RCC help: loads this document for viewing (if the system has Microsoft Word or other 
compatible word processor installed) 

• About RCC: a splash screen showing the program attribution and the RCC version 
number. 
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16 Error Messages 
Most sections of RCC protect against incorrect inputs by posting warning messages that guide 
the user to correct usage. However, some circumstances are either unanticipated or so rare that 
they do not warrant extensive error correction. In these cases, an error message is posted 
notifying the user that an error has occurred that could affect program operation. These messages 
fall into one of three categories: 

• Fatal error: The program has encountered an irrecoverable error condition. The error is 
briefly described, and the user is cautioned to halt the program because it is likely that it 
is no longer operating reliably. These errors can occur if the database is corrupt, and the 
program cannot correct the problem without analysis from an experienced user. 

• Warning: The program has encountered a potential error condition. The error is briefly 
described, and the user is urged to continue with caution because it is possible that the 
program is no longer operating reliably. The user should watch for any unusual behavior. 
These conditions can arise when data are incomplete but not corrupt or when other 
unexpected events occur, such as an errant clock setting. 

• Advisory: The program has encountered a possible error condition. The condition is 
briefly described, and the user is asked to ensure that the condition is consistent with the 
program’s use. Such an error could occur when information is unreliable, but it is likely 
to capture the attention of the operator at the time it occurs. 

When these errors occur and a cause or solution is not immediately obvious, the exact error 
message along with the circumstances should be sent to the National Renewable Energy 
Laboratory for analysis. 
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17 BORCAL-SW Data File Formats  
17.1 Test Instrument 
Test instrument files hold the raw data and metadata for test instrument measurements during 
data acquisition. These files also include ACR self-calibration measurements. 

17.1.1 File Naming 
Files reside in the folder for BORCAL\DATA_SW\<borcal_id>\DATAFILES, and they are 
named according to the following convention: 

Ggggsss.borcal_id 
 
Where  

• G is a literal 

• ggg is the group designator 

• sss is the session number 

• borcal_id is the BORCAL identification number. 

17.1.2 File Format 
Table 17-1. BORCAL-SW G-File Metadata Header 

Line Record Description 

1 Group Scan group number 

2 Session BORCAL and session 

3 Location Calibration facility 

4 Lat/Lon/Tzone/Elev/Temp/Press Latitude, longitude (decimal degrees), time zone 
(decimal hours from Greenwich, negative west of 
Greenwich), elevation (meters), site average 
temperature (°C), site average pressure (mBar) 

5 DeltaT/Refract Delta T and refraction for solar position 

6 Session Start Session start time as YYYYMMDD HH:MM:SS 

7 Session End Session end time as YYYYMMDD HH:MM:SS 

8 Record Count Count of data records 

9 Scan Interval Period between scans (seconds) 

10 Cal Type Calibration type (TOT = global; DIR = direct, DIF 
= shaded diffuse) 

11 Units Measurement units (V) 

12 Tilt Zenith Tilt calibration specification for instrument tilt 
(decimal degrees from zenith) 
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Line Record Description 

14 Tilt Azimuth Tilt calibration specification for instrument azimuth 
orientation (decimal degrees from north) 

14 Logger Count Number of data loggers 

15 Logger Unc 1 Uncertainty of voltage reading (% of reading) 

16 Logger Unc 2 Uncertainty of voltage reading, offset (V) 

17 Logger Unc 3 Uncertainty of voltage range (V) 

18 Logger Unc 4 Uncertainty of 2-wire resistance reading (% of 
reading) 

19 Logger Unc 5 Uncertainty of 2-wire resistance reading, offset 
(Ω) 

20 Logger Unc 6 Uncertainty of 2-wire resistance range (Ω) 

21 Logger Unc 7 Uncertainty of 4-wire resistance reading (% of 
reading) 

22 Logger Unc 8 Uncertainty of 4-wire resistance reading, offset 
(Ω) 

23 Logger Unc 9 Uncertainty of 4-wire resistance range (Ω) 

The next line is repeated for each data logger in the logger count. 

24** Lx Data Logger Data logger instrument identification number* 

25** Zenith Unc Uncertainty of zenith angle calculation 

26** Cavity Count Number of cavity radiometers 

The next 29 lines (labeled Cx) are repeated for each cavity in the cavity count, with x replaced by 
the cavity number (1 through count) 

27** Cx CAV Cavity instrument identification number* 

28** Cx CON Cavity control unit identification number* 

29** Cx RI1 Cavity shunt resistance value (Ω) 

30** Cx CIR Cavity circuit resistance (Ω) 

31** Cx HTL Cavity heater lead resistance (Ω) 

32** Cx HTR Cavity heater resistance (Ω) 

33** Cx MCF Cavity manufacturer’s calibration factor 

34** Cx WIN Window flag (0 = unwindowed; 1 = windowed) 

35** Cx WRR Cavity WRR reduction factor 

36** Cx UNC Uncertainty of the cavity WRR factor (%) 

37** Cx OFF Not used 

38** Cx DSN Cavity default sensitivity (mV/mW/cm2) 
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Line Record Description 

39** Cx NSN Cavity calculated (most recent) sensitivity 
(mV/mW/cm2) 

40** Cx TPZ (beg) Self-calibration TP zero (session start) (V) 

41** Cx TPZ (end) Self-calibration TP zero (session end) (V) 

42** Cx TPS (beg) Self-calibration TP solar (session start) (V) 

43** Cx TPS (end) Self-calibration TP solar (session end) (V) 

44** Cx TPE1 (beg) Self-calibration thermopile voltage (initial) due to 
electrical power (session start) (V) 

45** Cx TPE1 (end) Self-calibration thermopile voltage (initial) due to 
electrical power (session end) (V) 

46** Cx V1 (beg) Self-calibration heater voltage (session start) (V) 

47** Cx V1 (end) Self-calibration heater voltage (session end) (V) 

48** Cx VI1 (beg) Self-calibration voltage across shunt resistor 
(session start) (V) 

49** Cx VI1 (end) Self-calibration voltage across shunt resistor 
(session end) (V) 

50** Cx TPE2 (beg) Self-calibration thermopile voltage (final) due to 
electrical power (session start) (V) 

51** Cx TPE2 (end) Self-calibration thermopile voltage (final) due to 
electrical power (session end) (V) 

52** Cx MFAC (beg) Self-calibration M factor, W/m2/mV (session start) 

53** Cx MFAC (end) Self-calibration M factor W/m2/mV (session end) 

54** Cx TEMP (beg) Self-calibration temperature (session start) (°C) 

55 Cx TEMP (end) Self-calibration temperature (session end) (°C) 

56** DIF Count Number of diffuse reference radiometers 

The following six lines (labeled Dx) are repeated for each diffuse reference instrument in the DIF 
count, with x replaced by the diffuse reference number (1 through count). 

57** Dx ID Diffuse instrument identification number* 

58** Dx RS Diffuse instrument responsivity 

59** Dx UP Diffuse instrument uncertainty (% of reading) 

60** Dx UO Diffuse instrument uncertainty (offset, W/m2) 

61** Dx CASE Flag to include case thermistor reading (1 = yes; 
0 = no) 

62** Dx DOME Flag to include dome thermistor reading (1 = yes; 
0 = no) 

63** PYG Count Number of pyrgeometers (should always be 0 or 
1) 
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Line Record Description 

The following nine lines (labeled Px) are repeated for each Pyrgeometer in the PYG count, with x 
replaced by the pyrgeometer number (1 through count). 

64** Px ID Pyrgeometer instrument identification number* 

65** Px K0 Pyrgeometer K0 calibration coefficient 

66** Px K1 Pyrgeometer K1 calibration coefficient 

67** Px K2 Pyrgeometer K2 calibration coefficient 

68** Px K3 Pyrgeometer K3 calibration coefficient 

69** Px KR Pyrgeometer Kr calibration coefficient (receiver) 

70** Px UNC Uncertainty of the pyrgeometer calibration (%) 

71** Px CASE Flag to include case thermistor reading (1 = yes; 
0 = no) 

72** Px DOME Flag to include dome thermistor reading (1 = yes; 
0 = no) 

73** TST Count Count of test radiometers 

The following six lines (labeled Tx) are repeated for each instrument in the TST count, with x 
replaced by the instrument number (1 through count). 

74** Tx ID Test instrument identification number* 

75** Tx RSNET Instrument Rnet 

76** Tx RSNDATE Date Rnet was determined 

77** Tx UCRSNET Uncertainty of the instrument Rnet 

78** Tx CASE Flag to include case thermistor reading (1 = yes; 
0 = no) 

79** Tx DOME Flag to include dome thermistor reading (1 = yes; 
0 = no) 

The remaining lines in the file are data records. They are described in the following table. 
a All instrument identification numbers are a composite of serial number, manufacturer, and model. 
b Line number will vary according to the number of data logger, reference cavity, diffuse, and pyrgeometer 
instruments configured. The line numbers shown are valid when one of each instrument is configured. 
 

Table 17-2. BORCAL-SW G-File Data Records 

Position Field Description 

1 Date Date of data acquisition (YYYYMMNN) 

2 Time Time of data acquisition (HH:MM:SS), local standard time 

3 Zenith Solar incident (zenith) angle (decimal degrees). Takes into 
account instrument tilt 

4 Azimuth Solar azimuth angle (decimal degrees). Does not take into 
account instrument tilt 
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Position Field Description 

5 ASR ASR score (0 = blue; 1 = green; 2 = brown; 3 = red 

The following three fields are repeated for each cavity radiometer configured. 

6 Cavity Cavity number designated as Cx 

7 Thermopile Cavity thermopile reading (V) 

8 Flag Cavity data flag 

The following three fields are repeated for each reference diffuse instrument configured. 

9* Diffuse Diffuse number designated as Dx 

10* Thermopile Diffuse thermopile reading (V) 

11* Flag Diffuse data flag 

The following seven fields are repeated for each pyrgeometer instrument configured. 

12* Pyrgeometer Pyrgeometer number designated as Px 

13* Thermopile Pyrgeometer thermopile reading (V) 

14* Flag Pyrgeometer thermopile data flag 

15* Case Case thermistor reading (Ω) 

16* Flag Pyrgeometer case data flag 

17* Dome Dome thermistor reading (Ω) 

18* Flag Pyrgeometer dome data flag 

The following seven fields are repeated for each test instrument included in the scan group. (The 
case and dome thermistor data and flag fields are included only if the corresponding CASE or 
DOME flags are set (1) in the instrument’s definition in the header.) 

19* Test instrument Test instrument number as designated as Tx in metadata header 

20* Thermopile Test instrument thermopile reading (V) 

21* Flag Test instrument data flag (see Table 17-13: BORCAL-SW Data 
Flag Definitions below) 

22* Case Case thermistor reading 

23* Flag Case thermistor data flag 

24* Dome Dome thermistor reading 

25* Flag Dome thermistor data flag 
* Field number will vary according to the number of reference cavity, diffuse, and pyrgeometer instruments 
configured as well as the case and dome configuration of the test instruments. The numbers shown are valid for 
when one ACR, diffuse, and pyrgeometer are configured and the test instrument has both dome and case flags set in 
the instrument definition. 
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17.2 Meteorological 
Meteorological instrument files hold the raw data and metadata for metrological instrument 
measurements during data acquisition.  

17.2.1 File Naming 
Files reside in the folder for BORCAL\DATA_SW\<borcal_id>\DATAFILES, and they are 
named according to the following convention: 

METsss.borcal_id 
 
Where  

• sss is the session number 

• borcal_id is the BORCAL identification number. 

17.2.2 File Format 
Table 17-3. BORCAL-SW MET-File Metadata Header 

Line Record Description 

1 Met Header Meteorological data file designator 

2 Session BORCAL and session 

3 Location Calibration facility 

4 Lat/Lon/Tzone Latitude, longitude (decimal degrees), time zone (decimal hours from 
Greenwich, negative west of Greenwich) 

6 Session Start Session start time as YYYYMMDD HH:MM:SS 

7 Session End Session end time as YYYYMMDD HH:MM:SS 

8 Record Count Count of data records 

9 Scan Interval Period between scans (seconds) 

10 MET Count Count of meteorological instruments (always 3) 

11 DIR Cavity identification(s)* of direct normal measurements 

12 M1 Description of temperature sensor (instrument identification number, 
scale slope, and offset) 

13 M2 Description of humidity sensor (instrument identification number, 
scale slope and offset) 

14 M3 Description of barometric pressure sensor (instrument identification 
number, scale slope, and offset) 

The remaining lines in the file are data records. They are described in the following table. 
* All instrument identification numbers are a composite of serial number, manufacturer, and model. 
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Table 17-4. BORCAL-SW MET-File Data Records 

Position Field Description 

1 Date Date of data acquisition (YYYYMMNN) 

2 Time Time of data acquisition (HH:MM:SS), local standard time 

3 DIR Direct normal measurement label 

4 Direct Normal Direct normal measurement (W/m2) 

5 Flag Cavity data flag (see Table 17-13: BORCAL-SW Data Flag 
Definitions below) 

6 M1 Temperature measurement label 

7 Temperature Temperature reading (°C) 

8 Flag Temperature data flag (see Table 17-13: BORCAL-SW Data Flag 
Definitions below) 

9 M2 Humidity measurement label 

10 Temperature Humidity reading (%) 

11 Flag Humidity data flag (see Table 17-13: BORCAL-SW Data Flag 
Definitions below) 

12 M3 Barometric pressure measurement label 

13 Pressure Barometric pressure reading (mbarr) 

14 Flag Barometric pressure data flag (see Table 17-13: BORCAL-SW 
Data Flag Definitions below) 

15 AOD AOD measurement label 

16 Optical Depth Estimated broadband AOD (unitless) 

17 Flag Estimated broadband aerosol optical data flag (see Table 17-13: 
BORCAL-SW Data Flag Definitions below) 

 
17.3 ASR 
ASR files hold the raw data and metadata for the ASR measurements during data acquisition.  

17.3.1 File Naming 
Files reside in the folder for BORCAL\DATA_SW\<borcal_id>\DATAFILES, and they are 
named according to the following convention: 

ASRsss.borcal_id 
 
Where  

• sss is the session number 

• borcal_id is the BORCAL identification number. 
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17.3.2 File Format 
Table 17-5. BORCAL-SW ASR-File Metadata Header 

Line Record Description 

1 ASR Header ASR data file designator 

2 Session BORCAL and session 

3 Location Calibration facility 

4 Lat/Lon/Tzone Latitude, longitude (decimal degrees), time zone (decimal hours from 
Greenwich, negative west of Greenwich) 

6 Session Start Session start time as YYYYMMDD HH:MM:SS 

7 Session End Session end time as YYYYMMDD HH:MM:SS 

8 Record Count Count of data records 

9 Scan Interval Period between scans (seconds) 

10 ASR Count Count of ASR instruments  

11* ASRx Identification number of ASR radiometer(s) 

12* Label “temporary cavity stability file” 

The remaining lines in the file are data records. They are described in the following table. 
* Field number will vary according to the number of instruments configured. The numbers shown are valid for when 
one ASR instrument is configured. (There should always be more.)  
 

Table 17-6. BORCAL-SW ASR-File Data Records 

Position Field Description 

1 Date Date of data acquisition (YYYYMMNN) 

2 Time Time of data acquisition (HH:MM:SS), local standard time 

3 Zenith Solar incident (zenith) angle (decimal degrees). Takes into 
account instrument tilt 

4 Azimuth Solar azimuth angle (decimal degrees). Does not take into 
account instrument tilt 

5 ASR ASR score (0 = blue; 1 = green; 2 = brown; 3 = red 4 = 
uninitialized  

6* Ax ASRx measurement label 

7* Measurement Instrument reading for ASRx (W/m2) 

8* Flag Measurement flag for ASRx (see Table 17-13: BORCAL-SW Data 
Flag Definitions below) 

* Field number will vary according to the number of instruments configured. The numbers shown are valid for when 
one ASR instrument is configured. (There should always be more.)  
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17.4 Thermistor 
Thermistor files hold the raw data and metadata for the instrument case thermistor measurements 
during data acquisition (when such instruments are configured).15  

17.4.1 File Naming 
Files reside in the folder for BORCAL\DATA_SW\<borcal_id>\DATAFILES, and they are 
named according to the following convention: 

THMsss.borcal_id 
 
Where  

• sss is the session number 

• borcal_id is the BORCAL identification number. 

17.4.2 File Format 
Table 17-7. BORCAL-SW THM-File Metadata Header 

Line Record Description 

1 Thermistor 
Header 

Thermistor data file designator 

2 Session BORCAL and session 

3 Location Calibration facility 

4 Lat/Lon/Tzone Latitude, longitude (decimal degrees), time zone (decimal hours from 
Greenwich, negative west of Greenwich) 

5 Session Start Session start time as YYYYMMDD HH:MM:SS 

6 Session End Session end time as YYYYMMDD HH:MM:SS 

7 Record Count Count of data records 

8 Scan Interval Period between scans (seconds) 

9 THM Count Count of thermistor configured instruments  

10 IDs Identification number of each configured instrument and designated 
label for data records 

The remaining lines in the file are data records. They are described in the following table. 

 

                                                 
15 As of Version 2.00, thermistor files are not created by the system. Instead, the thermistor data are logged with the 
instrument fields in the group files. (See the test instrument group file format above.) The information below is 
retained for historical documentation. 
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Table 17-8. BORCAL-SW THM-File Data Records 

Table  Field Description 

1 Date Date of data acquisition (YYYYMMNN) 

2 Time Time of data acquisition (HH:MM:SS), local standard time 

The following three fields are repeated for all instruments designated in metadata line 10. 

5 Tx Instrument designator label 

6 Value Thermistor reading (Ω) 

8 Flag Measurement flag for instrument (see Table 17-13: BORCAL-SW 
Data Flag Definitions below) 

 
17.5 CALDAT for BORCAL-SW 
CALDAT files hold the graphing data and uncertainty documentation for each test instrument. 

17.5.1 File Naming 
Files reside in the folder for BORCAL\DATA_SW\<borcal_id>\DATAFILES \Caldat, and they 
are named according to the following convention: 

• Instrument_id.DAT (graphing data) 

• Instrument_id.TXT (uncertainty data) 

• REF_HORZ.TXT (reference data) 

• MET.TXT (meteorological data). 

Where Instrument_id is the RCC instrument identification number. 

17.5.2 File Format: Instrument_id.DAT 
These files have no metadata or header information. Each line of the file holds a data record, as 
defined in the following table. 

Table 17-9. BORCAL-SW Instrument_id.DAT Data Records 

Position Field Description 

1 Date Date of data acquisition (YYYYMMNN) 

2 Time Time of data acquisition (decimal hours, local standard time) 

3 Zenith Solar incident (zenith) angle (decimal degrees). Takes into 
account instrument tilt 

4 Azimuth Solar azimuth angle (decimal degrees). Does not take into 
account instrument tilt 

5 Value Instrument responsivity, µV/W/m2 (Rnet = 0) 

6 Value Instrument ENICR (If missing or instrument is uncorrected, value 
is –9900.0) 
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17.5.3 File Format: Instrument_id.TXT 
Each line of the file holds a data record, as defined in the following table. A header line describes 
each field. A record exists for each bin with a valid uncertainty. 

Table 17-10. BORCAL-SW Instrument_id.TXT Data Records 

Column Field Description 

1 Bin a.m. and p.m. 2-degree and 45-degree (always at end) bin 
numbers 

2 Volt Percent contribution of voltage measurement to total uncertainty 
for the bin 

3 Dir Percent contribution of Dir measurement to total uncertainty for 
the bin 

4 Rnet Percent contribution of Rnet calibration to total uncertainty for the 
bin 

5 Wnet Percent contribution of Wnet measurement to total uncertainty for 
the bin 

6 
 

Zen Percent contribution of Zenith calculation to total uncertainty for 
the bin 

7 Dif Percent contribution of Diffuse measurement to total uncertainty 
for the bin 

 
17.5.4 File Format: REF_HORZ.TXT 
These files have no metadata or header information. Each line of the file holds a data record, as 
defined in the following table. 

Table 17-11. BORCAL-SW REF_HORZ.TXT Data Records 

Position Field Description 

1 Date Date of data acquisition (YYYYMMNN) 

2 Time Time of data acquisition (decimal hours, local standard time) 

3 Zenith Solar incident (zenith) angle (decimal degrees). Takes into 
account instrument tilt 

4 Azimuth Solar azimuth angle (decimal degrees). Does not take into 
account instrument tilt 

5 Ref. Global Reference global horizontal irradiance (W/m2) 

6 Ref. Direct Reference direct normal irradiance (W/m2) 

7 Ref. Diffuse  Reference diffuse horizontal irradiance (W/m2) 
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17.5.5 File Format: MET.TXT 
These files have no metadata or header information. Each line of the file holds a data record, as 
defined in the following table. 

Table 17-12. BORCAL-SW MET.TXT Data Records 

Position Field Description 

1 Date Date of data acquisition (YYYYMMNN) 

2 Time Time of data acquisition (decimal hours, local standard time) 

5 Temp Air temperature (°C) 

6 RH Relative humidity (%) 

7 Pressure  Station pressure (mbar) 

8 AOD Estimated broadband aerosol optical depth 

 
17.6 Data Flag Definitions (BORCAL-SW Only) 
The values that appear in the data flag field indicate an error condition status during data 
acquisition. The values and their descriptions are listed in the table below. 

Table 17-13. BORCAL-SW Data Flag Definitions 

Flag Description 

0 No errors detected 

1 Delta between adjacent readings exceeded the threshold 

2 Ratio between reference and control instruments exceeded threshold 

3 (Reserved) 

4 Ratio between multiple reference instruments exceeded threshold 

5 (Reserved) 

6 (Reserved) 

7 (Reserved) 

8 Data acquisition error  

9 Data missing 

 
In some cases when more than one error condition may have been detected, only one flag will be 
reported. The precedence for reporting from among multiple flags is not defined. 
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18 BORCAL-LW Data File Formats 
18.1 Test Instrument 
Test instrument files hold the raw data and metadata for test instrument measurements during 
data acquisition.  

18.1.1 File Naming 
Files reside in the folder for BORCAL\DATA_LW\<borcal_id>\DATAFILES, and they are 
named according to the following convention: 

PYGsss.borcal_id 
 
Where  

• PYG is a literal 

• sss is the session number 

• borcal_id is the BORCAL identification number. 

18.1.2 File Format 
Table 18-1. BORCAL-LW PYG-file Metadata Header 

Line Record Description 

1 Pyrgeometer Header Pyrgeometer data file designator 

2 Session BORCAL and session 

3 Location Calibration facility 

4 Lat/Lon/Tzone/Elev/Temp/Press Latitude, longitude (decimal degrees), time zone 
(decimal hours from Greenwich, negative west of 
Greenwich), elevation (meters), site average 
temperature (°C), site average pressure (mBar) 

5 DeltaT/Refract Delta T and refraction for solar position 

6 Session Start Session start time as YYYYMMDD HH:MM:SS 

7 Session End Session end time as YYYYMMDD HH:MM:SS 

8 Record Count Count of data records 

9 Scan Interval Period between scans (seconds) 

10 Cal Type Calibration Type (PYG = pyrgeometer) 

11 Units Measurement units (V and °C) 

12 MET Count Count of meteorological instruments (count is 1, 
2, or 3), type is temperature (required), relative 
humidity, or pressure 

The following  line is repeated for each meteorological instrument in the MET count, with x 
replaced by the instrument number (1 through count) 
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Line Record Description 

13** Mx  Description of meteorological sensor (instrument 
identification number, scale slope, and offset) 

14** PYG Count Number of reference pyrgeometers  

The following 15 lines (labeled Px) are repeated for each Pyrgeometer in the PYG count, with x 
replaced by the pyrgeometer number (1 through count) 

15** Px ID Pyrgeometer instrument identification number* 

16** Px K0 Pyrgeometer K0 calibration coefficient 

17** Px K1 Pyrgeometer K1 calibration coefficient 

18** Px K2 Pyrgeometer K2 calibration coefficient 

19** Px K3 Pyrgeometer K3 calibration coefficient 

20** Px KR Pyrgeometer Kr calibration coefficient (receiver) 

21** Px UNC Uncertainty of the pyrgeometer calibration (%) 

22** Px CASE Flag to include case thermistor reading (1 = yes; 
0 = no) 

23** Px DOME Flag to include dome thermistor reading (1 = yes; 
0 = no) 

24** Px URDVDC Uncertainty of voltage reading (% of reading) 

25** Px UOFVDC Uncertainty of voltage reading, offset (V) 

26** Px URGVDC Uncertainty of voltage range (V) 

27** Px URDRES Uncertainty of resistance reading (% of reading) 

28** Px UOFRES Uncertainty of resistance reading, offset (Ω) 

29** Px URGRES Uncertainty of resistance range (Ω) 

30** TST Count Count of test radiometers 

The following 10 lines (labeled Tx) are repeated for each instrument in TST Count, with x 
replaced by the instrument number (1 through count) 

31** Tx ID Test instrument identification number* 

32** Tx KR Pyrgeometer Kr calibration coefficient 

33** Tx CASE Flag to include case thermistor reading (1 = yes; 
0 = no) 

34** Tx DOME Flag to include dome thermistor reading (1 = yes; 
0 = no) 

35** Tx URDVDC Uncertainty of voltage reading (% of reading) 

36** Tx UOFVDC Uncertainty of voltage reading, offset (V) 

37** Tx URGVDC Uncertainty of voltage range (V) 

38** Tx URDRES Uncertainty of resistance reading (% of reading) 
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Line Record Description 

39** Tx UOFRES Uncertainty of resistance reading, offset (Ω) 

40** Tx URGRES Uncertainty of resistance range (Ω) 

The remaining lines in the file are data records. They are described in the following table. 
* All instrument identification numbers are a composite of serial number, manufacturer, and model. 
** Line number will vary according to the number of reference pyrgeometer instruments configured. The line 
numbers shown are valid when one of each instrument is configured. 
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Table 18-2. BORCAL-LW PYG-file Data Records 

Position Field Description 

1 Date Date of data acquisition (YYYYMMNN) 

2 Time Time of data acquisition (HH:MM:SS.SSS), local standard time 
with decimal seconds 

3 Zenith Solar incident (zenith) angle (decimal degrees). Takes into 
account instrument tilt 

4 Azimuth Solar azimuth angle (decimal degrees). Does not take into 
account instrument tilt 

The following two fields are repeated for each meteorological instrument configured.  

5* Met Sensor Meteorological sensor number designated as Mx 

6* Met Reading Temperature, relative humidity, or pressure reading (°C, %, or 
mbarr) 

The following four fields are repeated for each pyrgeometer instrument configured. (The case and 
dome thermistor data fields are included only if the corresponding CASE or DOME flags are set 
(1) in the instrument’s definition in the header.) 

7* Pyrgeometer Pyrgeometer number designated as Px 

8* Thermopile Pyrgeometer thermopile reading (V) 

9* Case Case temperature reading (°C) 

10* Dome Dome temperature reading (°C) 

The following four fields are repeated for each test instrument configured. (The case and dome 
thermistor data fields are included only if the corresponding CASE or DOME flags are set (1) in 
the instrument’s definition in the header.) 

11* Test instrument Test instrument number as designated as Tx in metadata header 

12* Thermopile Test instrument thermopile reading (V) 

13* Case Case temperature reading (°C) 

14* Dome Dome temperature reading (°C) 
* Field number will vary according to the number of meteorological sensors, reference pyrgeometers and test 
instruments configured as well as the case and dome configuration of instruments. The numbers shown are valid 
when one meteorological sensor and one reference pyrgeometer (with both case and dome) are configured and the 
test instrument has both dome and case flags set in the instrument definition. 
 
18.2 CALDAT (for BORCAL-LW) 
CALDAT files hold the graphing data, residual data, and preliminary residual plots and for each 
test instrument. 
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18.2.1 File Naming 
Files reside in the folder for BORCAL\DATA_LW\<borcal_id>\DATAFILES \Caldat, and they 
are named according to the following convention: 

• Instrument_id.DAT (graphing data) 

• Instrument_id K0_non0.TXT (K0 set to non-zero residual data) 

• Instrument_id K0_zer0.TXT (K0 set to zero residual data) 

• Instrument id K0_zer0.PNG (K0 set to zero preliminary residual plot) 

• REF_HORZ.TXT (reference data) 

• MET.TXT (meteorological data). 

Where Instrument_id is the RCC instrument identification number. 

18.2.2 File Format: Instrument_id.DAT 
These files have no metadata or header information. Each line of the file holds a data record, as 
defined in the following table. 

Table 18-3. BORCAL-LW Instrument_id.DAT Data Records 

Position Field Description 

1 Date Date of data acquisition (YYYYMMNN) 

2 Time Time of data acquisition (decimal hours, local standard time) 

3 Zenith Solar incident (zenith) angle (decimal degrees). Takes into 
account instrument tilt 

4 Azimuth Solar azimuth angle (decimal degrees). Does not take into 
account instrument tilt 

5 Wref Reference Incoming LW irradiance (W/m2) 

6 Vtp Test instrument thermopile voltage (uV) 

7 Wr Test instrument Wr = Sigma*ReceiverTemp4 

8 Wd-Wr Test instrument Wd-Wr = Sigma*DomeTemp4 – Wr 

 
18.2.3 File Format: Instrument_id K0_zer0.TXT and Instrument_id K0_non0.TXT 
These files have no metadata or header information. Each line of the file holds a data record, as 
defined in the following table. One file is for the K0 set to non-zero, and one is for the K0 set to 
zero. 
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Table 18-4. BORCAL-LW Instrument_id K0_xxx0.txt Data Records 

Column Field Description 

1 Vtp Test instrument thermopile voltage (uV) 

2 Residual Irradiance residual, reference – test (W/m2). Test irradiance is 
calculated using previous BORCAL coefficients or manufacture’s 
single responsivity.  

 
18.2.4 File Format: Instrument_id K0_zer0.PNG 
These are preliminary residual plots that are automatically generated by the system at the end of 
a BORCAL-LW session (just before sunrise, depending on zenith angle that is in the system 
configuration). This file can also be generated manually by selecting the “Preliminary” option 
when generating BORCAL-LW responsivities. These files are used by the BORCAL manager to 
make a judgment about whether the BORCAL-LW is complete. All data is included for the 
preliminary plots (except when references disagree).16  

These files are simply plots of the data contained in the Instrument.id K0_zer0.TXT file. 
Irradiances for the test are calculated using the previous calibration coefficients (or 
manufacture’s single responsivity if there are no previous BORCAL results), as shown below. 

 
Figure 18-1. Sample BORCAL-LW residual plot 

 
A completed BORCAL would be a complete scatter plot of points that goes from near zero to 
near the maximum output of the thermopile with no large gaps between. 

                                                 
16 When final responsivities are generated, these files are also generated; however, data is filtered using the same 
approach as final coefficient generation. 
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18.2.5 File Format: REF_HORZ.TXT 
These files have no metadata or header information. Each line of the file holds a data record, as 
defined in the following table. 

Table 18-5. BORCAL-LW REF_HORZ.TXT Data Records 

Position Field Description 

1 Date Date of data acquisition (YYYYMMNN) 

2 Time Time of data acquisition (decimal hours, local standard time) 

3 Zenith Solar incident (zenith) angle (decimal degrees). Takes into 
account instrument tilt 

4 Azimuth Solar azimuth angle (decimal degrees). Does not take into 
account instrument tilt 

5 Irradiance Reference Incoming LW Irradiance (W/m2) 

 
18.2.6 File Format: MET.TXT 
These files have no metadata or header information. Each line of the file holds a data record, as 
defined in the following table. 

Table 18-6. BORCAL-LW MET.TXT Data Records 

Position Field Description 

1 Date Date of data acquisition (YYYYMMNN) 

2 Time Time of data acquisition (decimal hours, local standard time) 

3 Temp Air temperature (°C) 

4 RH Relative humidity (%) 

5 Pressure  Station pressure (mbarr) 

6 PWV Estimated precipitable water vapor (mm) 
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19 Directory Structure 
BORCAL Root 
 Backups   Backup files from database editing 
 Config    Location lookup files; site & ISO logo files; system 
………………………………………check define 
 Data_SW   Data files specific to each SW BORCAL 
  [BORCAL-ID] One directory for each BORCAL event 
   Alarms  Alarm files 
   Data Files Scan group, Met, ASR, Thermistor files 
    Caldat CALDAT files 
   Export  User exports 
   Logs  Operator logs 
       Nightdata Data files created by nighttime mode (obsolete) 
       PDF  Default location for printing document to PDF 
 Data_LW   Data files specific to each LW BORCAL 
  [BORCAL-ID] One directory for each BORCAL event 
   Alarms  Alarm files 
   Data Files PYG data files 
    Caldat CALDAT files 
   Export  User exports 
   Logs  Operator logs (not used) 
       Nightdata Data files created by nighttime mode (not used) 
       PDF  Default location for printing documents to PDF 
 
 DB    Access database 
 Layout    User configurable layout files (SW only) 
 PGM    RCC program files 
 SystemCheck   Location for saving annual FCO data 

UTILS    RCC utility programs (optional site dependent 
………………………………………batch files for backups, DAQ power on, 
………………………………………preliminary plot transfer, etc.) 

IMPORT   Location for optional Rnet import files (SW only) 
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